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1. Introduction to MCUXpresso IDE

1.1

1.1.1
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MCUXpresso IDE is a low-cost microcontroller (MCU) development platform ecosystem
from NXP, which provides an end-to-end solution enabling engineers to develop embedded
applications from initial evaluation to final production.

The MCUXpresso platform ecosystem includes:

« The MCUXpresso IDE, a software development environment for creating applications for
NXP’s ARM Cortex-M based MCUs including “LPC” and “Kinetis” ranges.

¢ MCUXpresso SDKs, each offering a package of device support and example software
extending the capability and park knowledge of MCUXpresso IDE.

*« MCUXpresso Config Tools, an integrated suite of configuration tools comprising of SDK
Builder, Pins Tool and Clock Tool.

¢ The range of LPCXpresso development boards, each of which includes a built-in “LPC-Link”,
“LPC-Link2", or CMSIS-DAP debug probe. These boards are developed in collaboration with
Embedded Artists.

¢ The range of Tower and Freedom Development boards, most of which include an Open SDA
debug circuit supporting a range of firmware options.

¢ The standalone “LPC-Link2” debug probe.

This guide is intended as an introduction to using MCUXpresso IDE. It assumes that you have
some knowledge of MCUs and software development for embedded systems.

Note: MCUXpresso IDE is built on top of much of the technology contained within the
LPCXpresso IDE. This means that for users familiar with LPCXpresso IDE, the new MCUXpresso
IDE will look relatively familiar.

MCUXpresso IDE Overview of Features

The MCUXpresso IDE is a fully featured software development environment for NXP’s ARM-
based MCUs, and includes all the tools necessary to develop high-quality embedded software
applications in a timely and cost effective fashion.

MCUXpresso IDE is based on the Eclipse IDE and includes the industry standard ARM GNU
toolchain. It brings developers an easy-to-use and unlimited code size development environment
for NXP MCUs based on Cortex-M cores (LPC and Kinetis). This new IDE combines the best of
the widely popular LPCXpresso and Kinetis Design Studio IDEs, providing a common platform
for all NXP Cortex-M microcontrollers. With full-featured free (code size unlimited) and affordable
professional editions, MCUXpresso IDE provides an intuitive and powerful interface with profiling,
power measurement on supported boards, GNU tool integration and library, multicore capable
debugger, trace functionality and more. MCUXpresso IDE debug connections support Freedom,
Tower®, LPCXpresso and your custom development boards with industry- leading open-source
and commercial debug probes including LPC-Link2, P&E and SEGGER.

The fully featured debugger supports both SWD and JTAG debugging, and features direct
download to on-chip flash.

For the latest details on new features and functionality, please visit:

http://www.nxp.com/mcuxpresso/ide

Summary of Features

Complete C/C++ integrated development environment
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Latest Eclipse-based IDE with many ease-of-use enhancements
» Eclipse Neon (v4.6) and CDT (v9.1)
e The IDE installs with Eclipse Plugins offering
e Git, FreeRTOS and support for P&E Micro debug probes
¢ The IDE can be further enhanced with many other Eclipse plugins
* Command-line tools included for integration into build, test, and manufacturing systems

Industry standard GNU toolchain (v5 update 3) including:

¢ C and C++ compilers, assembler, and linker
e Converters for SREC, HEX, and binary

Advanced project wizards

* Simple creation of preconfigured applications for specific MCUs
« Extendable with MCUXpresso SDKs
¢ Device-specific support for NXP’'s ARM-based MCUs (including LPC and Kinetis)

¢ Automatic generation of linker scripts for correct placement of code and data into flash and
RAM

» Extended support for flexible placement of heap and stack
« Automatic generation of MCU-specific startup and device initialization code
* No assembler required with Cortex-M MCUs

Advanced multicore support

 Provision for creating linked projects for each core in multicore MCUs

« Debugging of multicore projects within a single IDE instance, with the ability to link various
debug views to specific cores

Fully featured native debugger supporting JTAG and SWD connection via LinkServer

¢ Built-in optimized flash programming for internal and SPI flash
¢ High-level and instruction-level debug

« Views of CPU registers and on-chip peripherals

e Support for multiple devices on the JTAG scan-chain

Full install and integration of 3rd party debug solutions from:

* P&E Micro
« SEGGER J-Link

Library support

¢ Redlib: a small-footprint embedded C library
« RedLib-nf: a smaller footpring library offering reduced fprintf support
« Newlib: a complete C and C++ library
¢ NewlibNano: a new small-footprint C and C++ library, based on Newlib
¢ LPCOpen MCU software libraries
« Cortex Microcontroller Software Interface Standard (CMSIS) libraries and source code
« Extendable support per device via MCUXpresso SDKs

LinkServer Trace functionality

« Instruction trace via Embedded Trace Buffer (ETB) on certain Cortex-M3/M4 based MCUs or
via Micro Trace Buffer (MTB) on Cortex-MO0+ based MCUs
» Providing a snapshot of application execution with linkage back to source, disassembly and
profile
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1.1.2

1.1.3
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¢ SWO Trace on Cortex-M3/M4 based MCUs when debugging via LPC-Link2, providing
functionality including:

 Profile tracing

« Interrupt tracing
« Datawatch tracing
 Printf over ITM

LinkServer Power Measurement

¢ On LPCXpresso boards, sample power usage at adjustable rates of up to 200 ksps; average
power usage display option

« Explore detailed plots of collected data in the IDE

« Export data for analysis with other tools

Supported Debug Probes

MCUXpresso IDE installs with built in support for 3 debug solutions:

« Native LinkServer (including CMSIS-DAP) as also used in LPCXpresso IDE

« this supports a variety of debug probes including OpenSDA programmed with CMSIS-DAP
firmware, LPC-Link2 etc.

« https://lcommunity.nxp.com/message/630896
« P&E Micro

« this supports a variety of debug probes including OpenSDA programmed with P&E
compatible firmware and MultiLink and Cyclone probes

* http://www.pemicro.com/
* SEGGER J-Link

« this supports a variety of debug probes including OpenSDA programmed with J-Link
compatible firmware and J-Link debug probes

* https://lwww.segger.com/
This support includes the installation of all necessary drivers and supporting software.
Please see Debug Solutions Overview Chapter [10] for more details.

Note: Kinetis Freedom and Tower boards typically provide an onboard OpenSDA debug circuit.
This can be programmed with a range of debug firmware including:

* mBed CMSIS-DAP — supported by LinkServer connections

e DAP-Link — supported by LinkServer connections (DAP-Link is preferred to mBed CMSIS-DAP
when available)

e J-Link — supported by SEGGER J-Link connections
e P&E — supported by P&E connections

The default firmware can be changed if required, for details of the procedure and range of
supported firmware options please information visit: http://www.nxp.com/opensda

Development Boards
NXP Development board come in 3 families:
LPCXpresso Boards for LPC

The range of LPCXpresso boards that work seamlessly with the MCUXpresso IDE. These boards
provide practical and easy-to-use development hardware to use as a starting point for your LPC
Cortex-M MCU based projects.
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Figure 1.2. LPCXpresso V3 Board (LPCXpresso54102)

For more information, visit: http://www.nxp.com/lpcxpresso-boards
Freedom and Tower Boards for Kinetis

Similarly, for Kinetis MCUs there are many development boards available including the popular
Freedom and Tower ranges of boards.
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Figure 1.3. Tower (TWR-KV58F220M)

For more information, visit: http://www.nxp.com/pages/:TOWER_HOME

Figure 1.4, Freedom (FRDM-K64F)

For more information, visit: http://www.nxp.com/pages/:FREDEVPLA
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2. IDE Overview

The following chapter provides a high level overview of the features offered by the IDE itself.

2.1 Documentation and Help

The MCUXpresso IDE is based on the Eclipse IDE framework, and many of the core features
are described well in generic Eclipse documentation and in the help files to be found on the
MCUXpresso IDE’s Help -> Help Contents menu. That also provides access to the MCUXpresso
IDE User Guide (this document), as well as the documentation for the compiler, linker, and other
underlying tools.

MCUXpresso IDE documentation comprises a suite of documents including:

MCUXpresso IDE Installation Guide

MCUXpresso IDE User Guide

MCUXpresso IDE LinkServer SWO Trace Guide
MCUXpresso IDE LinkServer Instruction Trace Guide
MCUXpresso IDE LinkServer Power Measurement Guide
MCUXpresso IDE FreeRTOS Debug Guide

To obtain assistance on using MCUXpresso IDE, visit: http://www.nxp.com/mcuxpresso/ide

Related web links can be found at Help -> Additional resources as shown below:

Search | © |MCUXpresso IDE

(?) Help Contents

MCUXpresso IDE User Guide
& Search

Show Contextual Help

Show Active Keybindings... 3L
Tips and Tricks...

4/ Report Bug or Enhancement...

Cheat Sheets...

i Install New Software...
B Installation Details

%y Check for Updates
mF Additional resources > 2 Show welcome page

7 Display license type B MCUXpresso IDE website
B8 Product Information [ MCUXpresso IDE support forum
[ MCUXpresso SDK Resources
= Suppor‘t. [ MCUXpresso SDK Builder and Config Tools
e o | = LPCOpen Resources
» Code Bundles for LPCBOO Family devices
» OpenSDA Firmware Updates
# LPCScrypt - LPCXpresso Firmware

EA SEGGER J-Link website
[&] PEMicro website
MBED Serial Port Driver website

2.2 Workspaces

When you first launch MCUXpresso IDE, you will be asked to select a Workspace, as shown
in Figure 2.1.

MCUXpresso IDE User Guide -
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[ NN ] Eclipse Launcher

Select a directory as workspace

MCUXpresso IDE uses the workspace directory to store its preferences and development artifacts.

Workspace: | /Users/nxp/Documents/MCUXpressolDE_10.0.0/workspace [~ Browse...

Use this as the default and do not ask again

} Recent Workspaces

Cancel [ OK

Figure 2.1. Workspace selection

A Workspace is simply a directory used to store projects. MCUXpresso IDE can only access a
single Workspace at a time, although it is possible to run multiple instances in parallel — with
each instance accessing a different Workspace.

If you tick the Use this as the default and do not ask again option, then MCUXpresso IDE
will always start up with the chosen Workspace opened; otherwise, you will always be prompted
to choose a Workspace.

You may change the Workspace that MCUXpresso IDE is using, via the File -> Switch
Workspace option.

2.3 Perspectives and Views

The overall layout of the main MCUXpresso IDE window is known as a Perspective. Within
each Perspective are many sub-windows, called Views. A View displays a set of data in the IDE
environment. For example, this data might be source code, hex dumps, disassembly, or memory
contents. Views can be opened, moved, docked, and closed, and the layout of the currently
displayed Views can be saved and restored.

Typically, the MCUXpresso IDE operates using the single Develop Perspective, under which
both code development and debug sessions operate as shown in Figure 2.3. This single
perspective simplifies the Eclipse environment, but at the cost of slightly reducing the amount
of information displayed on screen.

Alternatively, the MCUXpresso IDE can operate in a “dual Perspective” mode such that the
C/C++ Perspective is used for developing and navigating around your code and the Debug
Perspective is used when debugging your application.

You can manually switch between Perspectives using the Perspective icons in the top right of
the MCUXpresso IDE window, as shown in Figure 2.2.

i

Figure 2.2. Perspective selection

All Views in a Perspective can also be rearranged to match your specific requirements by
dragging and dropping. If a View is accidentally closed, it can be restored by selecting it from the

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2017 NXP Semiconductors. All rights reserved.
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Window -> Show View dialog. The default layout for a perspective can be restored at any time
via Window -> Perspective -> Reset Perspective.

2.4 Major Components of the Develop Perspective

._ 0] # workspace - Develop - framkB4{_gpio_led_output/source/gpio_led_output.c - MCUXpresso IDE
jmiks K- E@iw > 22 e @R BRSSP LA O G @IE P -5, - Do -
5P =2 P A & = B 4xDebug v T=08
= <3:=> - ¥ B frdmk64f_gpio_led_output Debug [C/C++ (NXP Semiconductors) MCU Application]
[ Q:Irdmksfif?adcmipol\ing ¥ i frdmkB4f_gpio_led_output.axf [MKB4FN1MOx0c12 (cortex-maj]
v 5 frdmk84f_gpio_led_output ¥ # Thread #1 1 (Stopped) (Suspended : Breakpoint)
lg;;? Binaries = main() at gpio_led_output.c:74 Oxd42
» 5l Includes 5] arm-none-eabi-gdb (7.12.0.20161204)
» ECMSIS
» (2 board
» (Edrivers [£] gpio_led_output.c 53 = [l
v B source 32 #include "board.h"
» [ gpio_led_output.c 32 #include "fsl_debug_console.h"
» (Estartup 34 #include "fsl_gpio.h"
» 2 utilities >

36 #include "clock_config.h"

» (=-Debug 37 #include "pin_mux.h"

» (>doc 38e
|Z/ frdmke4f_gpio_led_output De 38  * Definitions
|=l frdmke4df_gpio_led_output Re

b ¥ lpc_board_lpexp
» (¥ lpc_chip_5411x
» EFLPCS4

41 #define BOARD_LED_GPIO BOARD_LED_RED_GPIO
42 #define BOARD_LED_GPIO_PIN BOARD_LED_RED_GPIO_PIN

440 koo

45 ¥ Prototypes

/

472 /%1

48  * @brief delay a while.
*/

58 void delay(void);
51
528
53 * Varigbles
54 ,

VAR @G 0V % = [m] 55
56

MCUXpresso IDE (Pro Ed 57 * Code
IDE 58 /

~ Start here
B New project... () Installed SDKs &% | [T] Properties = Console (%! Problems [ Memory @ Instruction Trace [] SWO Trace Config B3 Power MeasurementTo = O
B import SDK example(s)... @& =

* Import project(s) '3 Installed SDKs

&, Build 'frdmk64f 4

To install an SDK, simply drag and drop an SDK (zip file/folder) into the ‘Ingialled SDKs' view.

Version  Location

=X SDK_2.x_LPCXpresso54608 2.2.0 [® <Default Location: * 2.x LPCXpresso54608 [l ' [=0EIGH
1 8DK_2.x_FRDM-KB4F 2.2.0 5 - » 3 Devices
%5 Terminate, B 4+ SDK_2.x_LPCXpresso54114 2.2.0 5 .x_LPCXpresso54114 ¥ mj Compilers
i Edit 'framkd H418DK_2.x_TWR-KL28BZ72M  2.2.0 x_TWR-KL28Z72M » & Toolchains
41 8DK_2.x_FRDM-K82F 2.2.0 5

E O AR AL TR A EATARALE A A A

iFHDM—KSEF » (# Toolchain Settings
[P

N raim asraranals . RS,

FU NXP MKBAFN1MOxxx12 (frdmk64f... outout)

Figure 2.3. Develop Perspective (whilst debugging)

1. Project Explorer / Peripherals / Registers Views
e The Project Explorer gives you a view of all the projects in your current Workspace.
« When debugging, the Peripherals view allows you to display the registers within
Peripherals.
* When debugging, the Registers view allows you to display the registers within the CPU
of your MCU.
« Not visible here is the Symbol Viewer; this view displays symbolic information from a
referenced .axf file.
2. Editor
¢ Centrally located is the Editor, which allows modification and saving of source code. When
debugging, this is where you can see the code you are executing and can step from line to
line. By pressing the ' i->' icon at the top of the Debug view, you can switch to stepping by
assembly instruction. Clicking in the left margin will set and delete breakpoints.
3. Console / Installed SDKs / Problems / Trace Views / Power Measurement
* On the lower right are the Console, Installed SDK and Problems Views etc. The Console
View displays status information on compiling and debugging, as well as semihosted
program output.
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The Installed SDK view enabled the management of installed SDKs. New SDKs can be

added using drag and drop. Other SDK management features are also provided from this

view including unzip, explore and delete.

The Problems View (available by changing tabs) shows all compiler errors and warnings

and will allow easy navigation to the error location in the Editor View.

Sitting in parallel with the Console View are the various Views that make up the Trace

functionality of MCUXpresso IDE. For more information on Trace functionality, please see

the MCUXpresso IDE SWO Trace Guide and/or the MCUXpresso IDE Instruction Trace

Guide.

e The SWO trace Views allow you to gather and display runtime information using the SWO/
SWV technology that is part of Cortex-M3/M4 based parts.

« On some MCUSs, you can also view instruction trace data downloaded from the MCU’s
Embedded Trace Buffer (ETB) or Micro Trace Buffer (MTB).

Sitting in parallel with the Console View is the Power Measurement View, a dedicated trace

View capable of displaying real-time target power usage. For more information please see

the MCUXpresso IDE Power Measurement Guide.

. Quickstart / Variables / Breakpoints / Outline Views

On the lower left of the window, the Quickstart Panel View has fast links to commonly used
features. From here you can find various wizards including New Project, Import from SDK
and Import from File System plus options such as Build, Debug, and Import.

Sitting in parallel to the Quickstart Panel, the Global Variables View allows you to see and
edit the values of Global variables. Variables can be monitored while the target is running
using the LinkServer Live Variables feature.

Sitting in parallel to the Quickstart Panel, the Variables View allows you to see and edit
the values of local variables.

Sitting in parallel to the Quickstart Panel, the Breakpoints View allows you to see and
modify currently set breakpoints.

Sitting in parallel to the Quickstart Panel, the Outline View allows you to quickly find
components of the source file with input focus within the editor.

. Debug View

The Debug View appears when you are debugging your application. This shows you the
stack trace. In the “stopped” state, you can click on any function and inspect its local
variables in the Variables tab (which is located parallel to the Quickstart Panel View).

All information provided in this document is subject to legal disclaimers © 2017 NXP Semiconductors. All rights reserved.
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3. Debug Solutions Overview

MCUXpresso IDE User Guide -

MCUXpresso IDE installs with built-in support for 3 debug solutions; comprising the Native
LinkServer (including CMSIS-DAP) [13] as used in LPCXpresso IDE. Plus support for both
P&E Micro [20] and SEGGER J-Link. [21]

This support includes the installation of all necessary drivers and supporting software.

The rest of this chapter discusses these different Debug solutions. For general information on
debugging please see the chapter Debugging a Project [59]

Note: Within MCUXpresso IDE, the debug solution used has no impact on project setting or build
configuration. Debug operations for basic debug are also identical.

To perform a debug operation:

1. select a project within the MCUXpresso IDE Project View
2. click Debug from within the MCUXpresso IDE QuickStart View

¢ A probe discovery operation is automatically performed to display the available debug
connections, including LinkServer, P&E and J-Link compatible probes.

3. select the required debug probe and click OK

« A project launch configuration is automatically created containing debug chain specific
configurations

» Launch configurations [11] are stored within a project and are different for each of the
supported debug solutions

From this point onwards, the low level debug operations are controlled by one of the above debug
solutions.

However, from the users point of view, most common debug operations within the IDE will appear
the same (or broadly similar), for example:

< Automatic inheritance of part knowledge

« Automatic downloading of generated image to target flash memory

¢ Setting breakpoints and watchpoints

e Stepping (single, step in step out etc.)

« Viewing and editing local variables, registers, peripherals, memory

¢ Viewing disassembly

e Semihosted 10

It is important to note that advanced operations such as the handling of launch configuration
features will be very different for each debug solution.

Furthermore, advanced debug features and capabilities may vary between solutions and even
similar features may appear quite different within the IDE.

MCUXpresso IDE documentation will only describe the advanced features provided by native
LinkServer debug connection. These include:
¢ Flash programming
» please see the chapter Introduction to LinkServer Flash Drivers [64]
* Instruction Trace
« please see LinkServer Instruction Trace Guide
¢ Live Global Variable display

All information provided in this document is subject to legal disclaimers © 2017 NXP Semiconductors. All rights reserved.
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3.1

 described later in this chapter
* Power Measurement
* please see LinkServer Power Measurement Guide
¢ FreeRTOS Debug
* please see FreeRTOS Debug Guide
e SWO Trace (Profiling, Interrupts, Data Watch) - LPC-Link2 Only
* please see LinkServer SWO Trace Guide

P&E Micro and SEGGER debug solutions also provide a number of advanced features, details
can be found at their respective web sites.

A note about Launch Configuration files

The debug properties of a project in MCUXpresso IDE are held locally within each project in
Jaunch files (known as launch configuration files).

Launch configuration files are different for each debug solution (LinkServer, SEGGER, P&E) and
contain the properties of the debug connection (SWD/JTAG, and various other configurations
etc.) and can also include a debug probe identifier for automatic debug probe matching.

If a project has not yet been debugged, for example a newly imported or created project, then
the project will not have a launch configuration associated with it.

When the user first tries to debug a project, MCUXpresso IDE will perform a Debug Probe
Discovery operation and present the user with a list of debug probes found. Note: The Debug
Solutions searched can be filtered from this dialogue as highlighted, removing options that are
not required will speed up this process.

[ JoN ) Probes discovered
Connect to target: MK64FN1MOxxx12

1 probe found. Select the probe to use:

Available attached probes

Mame Serial number/ID Type Manufactur IDE Debug Mode

| ILPC LINK2 CMSIS-DAP V518 WFUATEW —[LinkSarva NXP SemiNon-Stop |

Supported Probes {tick/untick to enable/disable)

MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes
P&E Micro probes

SEGGER J-Link probes

Probe search options

Search again i
|

| Remember my selection (for this Launch configuration)

| =
) 1
@ Cancel [ Ok

Figure 3.1. Debug Probe Discovery

MCUXpresso IDE User Guide -

Once the debug probe is selected and the user clicks ‘OK’, the IDE will automatically create a
default launch configuration file for that debug probe (as shown below).
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[5 Proje 2 |2, Perip I} Regis £ Symb = B
5% <

¥ (=5 MKGB4FN1MOxxx12_Project

hﬁ?Binaries

» it Includes

» (2 CMSIS

» (2 source

b 2 startup

» = Debug

[Ce=NrYd

(;s MKB4FN1MOxxx12_Project Debug.launch)

|= MKB4FN1MOxxx12_Project Release.launch

Figure 3.2. Launch Configuration Files

MCUXpresso IDE User Guide -

Note: a launch configuration will be created for each project build configuration.

For most debug operations, these files will not require any attention and can essentially be
ignored. However, if changes are required, these files should not be edited manually, rather their

properties should be explored within the IDE.

One way to do this is as follows:

Select the Project (with a launch configuration file) within the ‘Project Explorer’ pane, then Right

click on the Project and select: Launch Configurations -> Edit Current

To view the configuration items, be sure to select the Debugger tab as shown below:

All information provided in this document is subject to legal disclaimers © 2017 NXP Semiconductors. All rights reserved.
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Create, manage, and run configurations

5 X | B3 Name:  MK84FN1MOxxx12_Project Debug
[2) Main [E- Source |[] Commor{ %3 Debugger
7.0"0"'*’ (NXP Semiconduct?rs) MCU Application | Stop on startup at: main Force hardware breakpoint
B MKB4FN1MOxxx12_Project Debug
.MKGdFN1MDXXX127PrOieGl Release Debugger Options
o
[E]1C/C++ Attach to Application Main
[C1C/C++ Postmortem Debugger
[£]C/C++ Remote Application Debug options for NXP MK64FN1M0xxx12 (cortex-m4d)
[£]1GDB Hardware Debugging
[E]GDB PEMicro Interface Debugging Debug Connection SWD |
EAGDB Segger Interface Debugging
# Launch Group Configuration Cption ~ Value
at- Additional options
| Attach only False
af: Connect Script kinetisconnect.scp
ali: Debug Level 2
:z| Debugger memory cache Disable
isconnect behavior cont
oad image True
= Maximum wire speed
“| Memory Access Checking off
ali: Pre launch command
::| Reset Handling
st: Aeset Script
#*| Run/Continue image cont
emihosting support On
| Vector catch false
st Wirespeed (Hz)
Miscellanecus
Emulator selection  LinkServer i
Edit scripts...
Debug options template
Debua Confiauratien (") v Show all

Filter matched 11 of 11 items

Figure 3.3. Launch Configuration

Some debug solutions support advanced operations (such as recovering of badly programmed
parts) from this view.

Note: Once a launch configuration file has been created, it will be used for the projects future
debug operations. If you wish to use the project with a different debug probe, then simply delete
the existing launch configuration and allow a new one to be automatically used on the next debug
operation.

Note: When exporting project to share with others, launch configurations should usually be
deleted before export (along with other IDE generated folders such as build configuration folders
(Debug/Release if present)).

For further information please see the section Launch Configurations [114]

3.2 LinkServer Debug Connections

MCUXpresso IDE'’s native debug connection (known as LinkServer) supports debug operation
through the following debug probes:

¢ LPC-Link2 with CMSIS-DAP firmware
e LPCXpresso V2/V3 Boards incorporating LPC-Link2 with CMSIS-DAP firmware

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2017 NXP Semiconductors. All rights reserved.
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CMSIS-DAP firmware installed onto onboard debug probe hardware (as shipped by default
on LPCXpresso MAX and CD boards)
« For more information on LPCXpresso boards see: http://www.nxp.com/lpcxpressoboards
CMSIS-DAP firmware installed onto onboard OpenSDA debug probe hardware (as shipped
by default on certain Kinetis FRDM and TWR boards)
e Known as DAP-Link and mBed CMSIS-DAP: http://www.nxp.com/opensda
« Additional driver may be required:

* https://developer.mbed.org/handbook/Windows-serial-configuration
Other CMSIS-DAP probes such as Keil uLINK with CMSIS-DAP formware: http:/
www?2.keil.com/mdk5/ulink

Legacy RedProbe+ and LPC-Link
RDB1768 development board built-in debug connector (RDB-Link)
RDB4078 development board built-in debug connector

Note: MCUXpresso IDE will automatically try to softload the latest CMSIS-DAP firmware onto
LPC-Link2 or LPCXpresso V2/V3 boards. For this to occur, the DFU link on these boards must
be set correctly. Please refer to the boards documentation for details.

3.3 LinkServer Debug Operation

When the user first tries to debug a project, MCUXpresso IDE will perform a Debug Probe
Discovery operation and present the user with a list of debug probes found.

Note: To perform a debug operation within MCUXpresso IDE, select the project to debug within
the ‘Project Explorer’ view and the click Debug from the QuickStart View.

For LinkServer compatible debug probes, you can select from Non-Stop (the default) or All-Stop
IDE debug mode.

Figure 3.4. Debug Probe Discovery Non-Stop

Probes discovered

| Connect to target: MK64FN1MOxxx12

1 probe found. Select the probe to use:

| Available attached probes

MName Serial number/ID Type Manufactyf IDE Debug Mode

| B8 LPC-LINK2 CMSIS-DAP V5.18 IWFUA1EW LinkServe NXP Sefhi Non-Sto, v
D
All-Stop

Supported Probes (tickfuntick to enable/disable)
| MCUXpresso IDE LinkServer {inc. CMSIS-DAP) probes
I P&E Micro probes

SEGGER J-Link probes

Probe search opticns

Search again

Remember my selection (for this Launch configuration)

oy
@ Cancel OK

Note: If ‘Remember My Selection’ is left ticked, then the probe details will be stored within the
launch configuration file, and this probe will be automatically selected on subsequent debug
operations for this project.

MCUXpresso IDE User Guide -
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Non-Stop uses GDB’s “non-stop mode” and allows data to be read from the target while an
application is running. Currently this mechanism is used to support the Live Variables feature
within the New Global Variables view.

3.4 LinkServer Global and Live Global Variables

MCUXpresso IDE provides a new Global Variables view for displaying the values of global
variables! This replaces the use of the “Expressions” view for displaying such variables, as used
in LPCXpresso IDE (and KDS). This view defaults to be located within the QuickStart panel.

This view can be populated from a selection of a projects global variables. Simply click the “Add
global” button to launch a dialogue:

Quickstar )= Global Va 22 Variables Breakpo Outline = O
& % t et <
Variaple Type *Add global \rariahles’1LIE

Figure 3.5. LinkServer Add Global Variables

This will then display a list of the global variables available in the image being debugged. Select
the ones of interest via their checkboxes and click OK :

[ JeN ] Select symbols.

Name ~ Address Size
__Ciob 0x20000094 180
__end_of_heap 0x2000014c 4
__heaps 0x20000148 4
__num_Ciob_streams 0x00006828 4
__Vectors 0x00000000 408
array 0x2000004¢c 16
ermo 0x20000150 4
Flash_Config 0x00000400 16
g_accel_address 0x00005adB 4
g_MasterHandle 0x2000001¢ 40
g_pfnVectors 0x00000000 408
g_xAngle 0x20000044 2
g_xData 0x20000048 2
g_xtalOFreq 0x2000005¢ 4
g_xtal32Freq 0x20000080 4
g_yAngle 0x20000046 2

Select All Deselect All
@ Cancel | (S

Figure 3.6. LinkServer Global Variable Selector

Note: to simplify the selection of a variable, this dialogue supports the option to filter (highlighted)
and sorts on each column.

Once selected, the chosen variables will be remembered for that occurrence of the dialogue.

For “All-Stop” debug connections, the Global Variables view will be updated whenever the target
is paused.

For “Non-Stop” debug connections, variables can be selected to be updated while the target is
running. These are known as " Live Variables".
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For variables to be “Live”:

« the target must be running
 the enable/disable (run) button clicked.

Once done, the display will update at the frequency selected (selectable from 500 ms to 10 s).

Figure 3.7. LinkServer Global Variable Display

) Quickstar 0J= Global Va 32 (x=Variables % Breakpoi 5= Outline = O
i@xmon : #B O v

Variable Type Value
¥ =array uint32_t [4] 0x2000004c <array>

- array[0] uint32_t 9
(9= array[1] uint32_t 15
)= array[2] uint32_t 1073741717
= array[3] uint32_t 858993245

(9-g_xAngle int16_t 23

(J=g_yAngle int16_t 47

MCUXpresso IDE User Guide -

Live Variables like normal Globals can also be edited in place. Simply click on the variable value
and edit the contents. During the edit operation, the display will not update. This mechanism
provides a powerful way of interacting with a running target without impacting on any other aspect
of system performance.

MCUXpresso IDE defaults to the selection of “Non-Stop” mode when a probe discovery operation
is performed.

Note: If you wish to have some global variables ‘Live’ and others not, then this can be achieved
by spawning a second Globals display via the ‘New View' button and populating this without
enabling the ‘run’ feature for that view.

The usefulness of Live Variables reduces as the number monitored increases, and ultimately

there will be a limit as to how many variables can be updated at the selected frequency. However,
complex list of variables can be monitored if required. For example:
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) Quickstart Pa )= Global Variabl i3 (= Variables ® Breakpoints = Outline = O

Variable
&)= _random_j
)= _random_k
©)=b
&=f
)=-d
»p
=i
o)
€=k
Y ®unia
©J=uni_a[0]
J=uni_a[1]
@)=uni_a[2]
©)=uni_a[3]
©J=uni_a[4]
v ®bi_a
¥ (= bi_a[0)
=bi_a[0][0]
©=bi_a[0][1]
©=bi_a[0][2]
¥ (= bi_a[1]
©9-bi_a[1][0]
©=bi_a[1][1]
©)=bi_a[1][2]
> (= bi_a[?]
» (25_example
vi®s5 exi
> @ name
(SR

& Q1000 2 HE I~
Type Value
<data variable, no debug info> 25
<data variable, no debug info> 2
_Bool true
float 62.9931755
double -0.88162727834732613
wvoid * 0x20000130 <bi_a>
volatile int 5
int 3
int 3
double [5] 0x20000108 <uni_a>
double 0.64644408768343009
double 0.52534067328267975
double o
double o
double -0.68493826395426475
float [3][3] 0x20000130 <bi_a>
float [3] 0x20000130 <bi_a>
float 77.4734956
float 92.8390503
float 46.7962074
float [3] 0x2000013¢ <bi_a+12>
float 63.3472824
float 95.4246292
float 30.6657524
float [3] 0x20000148 <bi_a+24>
char [15] 0x20000154 <s_example>
struct Struct_example {o}
char [5] 0x20000168 <s_ex1>
int 3

Figure 3.8. LinkServer Global Variable Display 1

MCUXpresso IDE defaults to the selection of “Non-Stop” mode when a probe discovery operation
is performed. This can be disabled from an MCUXpresso IDE Preference via:

Preferences -> Debug Options (Misc)

» General

b CiC++

» Help

F Install/Update
¥MCUXpresso IDE

o L
Default Tool settings
General
J-Link Options
LinkServer Options
LPC-Link Options
LPC-Link2 SWO Trace
MCU settings
Paths and Directories
Quickstart Panel
| SDK Options
| User Interface Enablement
| Utilities
b Mylyn
| » Run/Debug
» Team

®

Figure 3.9. LinkServer Non Stop Preference

Preferences

Debug Options (Miscellaneous) f=11 - -

com.crt.debugecommon v10.0.0.201702141816
Debugger executable arm-none-eabi-gdb
Debugger timeout 10
SWV Packet Timeout 0
Extended debug trace (DEBUG_TRACE)

Stream all stub messages to Console

Show stub warnings as notes

Show debug log when written to
Display asynchronous error messages

Disable Auto-select device on multicore target

Always show JTAG selection dialog

Show progress messages in log

Restore Defaults Apply

Cancel | (TS

For a given project, the Non-Stop mode option is stored within the project’s launch configuration.
For projects that already have launch configurations, these will need to be deleted before

proceeding.

MCUXpresso IDE User Guide -
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3.5 LinkServer Troubleshooting

3.5.1 Debug Log

On occasion, it can be useful to explore the operations of a debug session in more detail. The
steps are logged into a file known as the Debug log. This log will be displayed when a Debug
operation begins, but by default, will be replaced by another view when execution starts. The
debug log is a standard log within the IDE’s Console view. To display this log, select the Console
and then click to view the various options (as below):

T
=
fo

E il B~
1 RedlinkServer
El 2 CDT Global Build Console

E 3 CDT Build Console [frdmk64f_demo_apps_bubble]
+ 4 FreeRTOS Task Aware Debugger Console version 1.0.2 (201702241004)
5 Irdmk64f demo apps bubble Debug [C/C++ (NXP Semiconductors) MCU Application] gdb traces
[\NXP Semiconductors) MCU Application] arm-none-eabi-gdb (7.12.0.20161204)

The debug log displays a large amount of information which can be useful in tracking down
issues.

In the example debug log below, you can see that an initial Script file has been run.
Connect scripts are required for debugging certain parts and are automatically added to launch
configuration files by the IDE if required.

Further down in this log you will see the selection of flash driver (FTFE_4K), the identification of
the part being debugged K64, and also the speed of flash programming (81.97 KB/sec).

MCUXpr esso RedlinkMulti Driver v10.0 (Feb 16 2017 18:37:08 - crt_enu_cmredlink
bui I d 175)

Reconnected to existing redlink server (PID -1)

Connecting to core O (probe handle 1, PID -1) gave ' K

============= SCRI PT: ki netisconnect.scp =============

Ki neti s Connect Scri pt

Dpl D = 2BA01477

Assert NRESET

Reset pin state: 00

Power up Debug

MDM AP APl D:  0x001C0000

MDM AP Syst em Reset/ Hol d Reset/ Debug Request

MDM AP Control : 0x0000001C

MDM AP St atus (Fl ash Ready) : 0x00000032

Part is not secured

MDM AP Control : 0x00000014

Rel ease NRESET

Reset pin state: 01

MDM AP Control (Debug Request): 0x00000004

MDM AP St at us: 0x0001003A

MDM AP Core Hal ted
============= END SCRI PT
Probe Firnware: LPC-LINK2 CVSI S-DAP V5. 181 (NXP Semi conduct or s)

Serial Nunber: |WUALEW

VID:PID: 1FC9: 0090

USB Pat h: USB_1f c9_0090_14131100_f f 00

Probe(0): Connected&Reset. Dpl D: 2BA01477. Cpul D. 410FC240. I|nfo: <None>
Debug protocol: SWD. RTCK: Disabl ed. Vector catch: Disabled.
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3.5.2

3.5.3

MCUXpresso IDE User Guide -

Inspected v.2 On chip Kinetis Flash nenory nodul e FTFE_4K. cf x

I mage ' Kinetis Sem Generic Jan 13 2017 16: 14: 07'

Openi ng flash driver FTFE 4K cf x

flash variant 'K 64 FTFE Generic 4K detected (1MB = 256*4K at 0xO0)
Cl osing flash driver FTFE 4K cfx

NXP:  MK64FN1MDxxx12

( 65) Chip Setup Conplete

Connected: was_reset=true. was_stopped=true

MCUXpr essoPro Full License - Unlinmted

Awai ting tel net connection on port 3330 ...

GDB nonst op node enabl ed

Opening flash driver FTFE 4K cfx (already resident)

Witing 10744 bytes to address 0x00000000 in Fl ash

Erased/ Wote page 0-2 with 10744 bytes in 128nsec

Cl osing flash driver FTFE 4K cfx

Fl ash Wite Done

Fl ash Program Sunmary: 10744 bytes in 0.13 seconds (81.97 KB/ sec)
St opped: Breakpoint #1

Flash Programming

Most debug operation begin with a flash programming operation, if this should fail, then the debug
operation will be aborted.

Flash programming common operations:

1. Mass Erase: a mass erase will reset all the bytes in flash (usually to Oxff). Such an
operation may clear any internal low level structuring such as protection of flash areas (from
programming).

2. Sector Erase: internally flash devices are divided into a number of sectors, where a sector is
the smallest size of flash that can be erased in a single operation. A sector will be larger than
a page (see below). Sectors are usually the same size for the whole flash device, however
this is not always the case. A sector base address will be aligned on a boundary that is a
multiple of its size.

3. Page Program: internally flash devices are divided into a number of pages, where a page is
the smallest size of flash that can be programmed in a single operation. A page will be smaller
than a sector. A page base addresses will be aligned on a boundary that is a multiple of its size.

A programming operation comprises repeated operations of sector erase followed by a set
of program page operations; until the sector is fully programmed or there is no more data to
program.

One of the common problems when programming Kinetis parts relates to their use of flash
configuration block at offset 0x400. For more information please see: Kinetis MCUs Flash
Configuration Block [88] . Flash sector sizes on Kinetis MCUs range from 1KB to 8KB,
therefore the first Sector Erase performed will clear the value of this block to all OxFFs, if this is
not followed by a sucessful program operation and the part is reset, then it will likely report as
‘Secured’ and subsequent debugging will not be possible until the part is recovered.

Such an event can occur if a debug operation is accidently performed to the ‘wrong board’ and
a wrong flash programmer is invoked.

To Recover a ‘locked’ part please see the section LinkServer GUI flash programmer [67]

LinkServer executables

LinkServer debug operations rely on 3 main debug executables.

All information provided in this document is subject to legal disclaimers © 2017 NXP Semiconductors. All rights reserved.

User Guide

Rev. 10.0 — 21 March, 2017 19



NXP Semiconductors MCUXpresso IDE User Guide

3.6

3.7

3.7.1
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e arm-none-eabi-gdb — this is a version of GDB built to target ARM based MCUs

e crt_emu_cm_redlink — this executable (known as the debug stub) communicates with GDB
and passes low level commands to the LinkServer executable (also known as redlink server)

e redlinkserv — this is the LinkServer executable and takes stub operations and communicates
directly with the ARM Cortex debug hardware via the debug probe.

If a debug operation fails, or a crash occurs, it is possible that one or more of these processes
will fail to shut down. Therefore, if the IDE has no active debug connection but is experiencing
problems making a new debug connection, ensure that none of these executables is running.

P&E Debug Connections
P&E Micro software and drivers are automatically installed when MCUXpresso IDE installs.
There is no need to perform any additional setup to use P&E Micro debug connections.

Currently we have tested using:

e Multilink Universal (FX)

¢ Cyclone Universal (FX) (USB and Ethernet)

« P&E firmware installed into onboard OpenSDA debug probe hardware (as shipped by default
on certain Kinetis FRDM and TWR boards)

P&E Debug Operation

The process to debug via a P&E compatible debug probe is exactly the same as for a native
LinkServer (CMSIS-DAP) compatible debug probe. Simply select the project via the ‘Project
Explorer’ view then click Debug from the QuickStart panel and select the P&E debug probe from
the Probe Discovery Dialogue.

If more than one debug probe is presented, select the required probe and then click ‘OK’ to start
the debug session. At this point, the projects launch configuration files will be created. Note: P&E
Launch configuration files will contain the string ‘PE’.

MCUXpresso IDE stores the probe information, along with its serial number in the projects launch
configuration. This mechanism is used to match any attached probe when an existing launcher
configuration already exits.

Note: If the project already had a launch configuration, this will be selected and used. If they are
no longer appropriate for the intended connection, simply delete the files and allow new launch
configuration files to be created.

Important Note: Low level debug operations via P&E debug probes are supported by P&E
software. This includes, Part Support handling, Flash Programming, and many other features.
If problems are encountered, P&E Micro maintain a range of support forums at http:/
www.pemicro.com/forums/

P&E Differences from LinkServer Debug

MCUXpresso IDE core technology is intended to provide a seamless environment for code
development and debug.

When used with P&E debug probes, the debug environment is provided by the P&E debug server.
This debug server does not 100% match the features provided by native LinkServer connections.
However basic debug operations will be very similar to LinkServer debug.

Note: LinkServer advanced features such as Instruction Trace, SWO Trace, Power
Measurement, Live Global Variables etc. will not be available via a P&E debug connection.
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3.7.2

3.8

3.8.1

P&E Micro Software Updates

P&E Micro support within MCUXpresso IDE is via an Eclipse Plugin. The P&E update site is
automatically added to the list of Available Software Update sites.

To check whether an update is available, please select:
Help -> Check for Updates

Any available updates from P&E will then be listed for selection and installation.

SEGGER Debug Connections

SEGGER J-Link software and documentation pack is installed automatically with the
MCUXpresso IDE Installation for each host platform. No user setup is required to use the
SEGGER debug solution within MCUXpresso IDE.

Currently we have tested using:

¢ J-Link debug probes (USB and Ethernet)
¢ J-Link firmware installed into onboard OpenSDA debug probe hardware (as shipped by default
on certain Kinetis FRDM and TWR boards)

SEGGER software installation

Unlike other debug solutions supplied with MCUXpresso IDE, the SEGGER software installation
is not integrated into the IDE installation, rather it is a separate SEGGER J-Link installation on
your host.

The installation location will be similar to:

On Wndows: C:./Program Files (x86)/SEGGER JLi nk_V614/j Li nkGDBSer ver CL. exe
On Mac: /Applications/ SEGGER/ JLi nk_V614/ JLi nkCGDBSer ver

MCUXpressolDE automatically locates the required executable and it is remembered as a
Workspace preference. This can be viewed or edited within the MCUXpresso IDE preferences
as below.

eC e Preferences
J-Link Options f=11 v -

» General
P C/IC++
> Help JLink Server executable | /Applications/SEGGER/JLink_V614/JLinkGDBServer Browse...
¥ Install/Update . ) .
¥ MCUXpresso IDE Enable discovering of SEGGER J-Link IP probes
Debug Options (Advan Enable SEGGER J-Link user actions
Debug Options (Misce
Debug Probe Discover
Default Tool settings
General
[
LinkServer Options
LPC-Link Options
LPC-Link2 SWO Trace

SEGGER J-Link probe preferences

MCU settings
Paths and Directories
Quickstart Panel
SDK Options
User Interface Enabler |
Utilities |
» Mylyn
» Run/Debug
FTeam Restore Defaults Apply
@ Cancel (TN

Figure 3.10. Segger Preferences

MCUXpresso IDE User Guide -

Note: this preference also provides the option to enable scanning for SEGGER IP probes (when
a probe discovery operation is performed). By default, this option is disabled.
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3.9

3.9.1
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From time to time, SEGGER may release later versions of their software, which the user could
choose to manually install.

MCUXpresso IDE will continue to use the SEGGER installation path as referenced in a projects
workspace unless the required executable cannot be found (for example, the referenced
installation has been deleted). If this occurs:

1. The IDE will automatically search for the latest installation it can find. If this is successful, the
Workspace preference will automatically be updated
2. If a SEGGER installation cannot be found, the user will be prompted to located an installation

To force a particular workspace to update to use a newer installation location simply click the
Restore Default button.

To permanently select a particular SEGGER installation version, the location of the SEGGER
GDB Server can be stored in an environment variable.

For example, under Windows you could set:

MCUX_SEGGER_SERVER="C: / Program Fi | es (x86)/ SEGGER/ JLi nk_V612i/j Li nkCGDBSer ver CL. exe"

This location will then be used, overriding any workspace preference that maybe set.
SEGGER software un-installation

If MCUXpresso IDE is uninstalled, it will not remove the SEGGER J-Link installation. If this is
required, then the user must manually uninstall the SEGGER J-Link tools.

Note: If for any reason MCUXpresso IDE cannot locate the SEGGER J-Link software, then the
IDE will prompt the user to either manually locate an installation or disable the further use of the
SEGGER debug solution.

SEGGER Debug Operation

The process to debug via a J-Link debug probe is exactly the same as for a native LinkServer
(CMSIS-DAP) compatible debug probe. Simply select the project via the ‘Project Explorer’ view
then click Debug from the QuickStart Panel and select the Segger Probe from the Probe
Discovery Dialogue.

If more than one debug probe is presented, select the required probe and then click ‘OK’ to start
the debug session. At this point, the projects launch configuration files will be created.

Note: If the project already had a launch configuration, this will be selected and used. If an existing
launch configuration file is no longer appropriate for the intended connection, simply delete the
files and allow new launch configuration files to be created.

Important Note: Low level debug operations via SEGGER debug probes are supported by
SEGGER software. This includes, Part Support handling, Flash Programming, and many other
features. If problems are encountered, SEGGER'’s provide a range of support forums at http://
forum.segger.com/

SEGGER Differences from LinkServer Debug

MCUXpresso IDE core technology is intended to provide a seamless environment for code
development and debug. When used with SEGGER debug probes, the debug environment is
provided by the SEGGER debug server. This debug server does not 100% match the features
provided by native LinkServer connections. However basic debug operations will be very similar
to LinkServer debug.
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Note: LinkServer features such as Instruction Trace, SWO Trace, Power Measurement, Live
Global Variables etc. will not be available via a SEGGER debug connection.

3.10 SEGGER Troubleshooting

When a debug operation to a SEGGER debug probe is performed, the SEGGER GDB server
is called with a set of arguments provided by the launch configuration file. The command and
resulting output is logged within the IDE Segger Debug Console. The console can be viewed
as below:

nory & Instruction Trace [EZ] SWO Trace Confia B2 Power Measurement Tool [SelbHIEY DR % | E
» 1 FreeRTOS Task Aware Debugger Console
2 RedlinkServer
E 3COT Glonal Build Console

j Xamples_gpio_led_output JLink Debug [GDB Segger Interface Debugging] gdb traces
ﬂ 7 <terminated> irdmkl432 drwer _examples_gpio_led_output JLink Debug [GDB Segger Interface Debugging] arm-none-eabi-gdb (7.12.0.20161204)

Figure 3.11. Segger Server

The command can be copied and called independently of the IDE to start a debug session and
explore connection issues.

Below is the shortened output of a successful debug session to a Kinetis KL43 Freedom Board.

Executing Server: /Applications/ SEGGER/ JLi nk_V614/ JLi nkGDBServer -nosil ent
-swoport 2332 -sel ect USB=621000000 -tel netport 2333 -endian little -noir
-speed auto -port 2331 -vd -device MKL43Z256xxx4 -if SWD -nohalt -reportuseraction
bc. .

SEGCER J-Link GDB Server V6.14 Command Line Version
bc. .

JLinkARM dI | V6. 14 (DLL conpiled Feb 23 2017 17: 31: 36)
bc. .

----- CDB Server start settings-----

GDBInit file: none

GDB Server Listening port: 2331

SWO raw out put |istening port: 2332

Terminal 1/0 port: 2333

Accept renote connection: yes

Generate logfile: of f

Verify downl oad: on

Init regs on start: of

Si | ent node: of

Si ngl e run node: of f

Target connection timeout: 0 ns

------ J-Link related settings------

J-Link Host interface: UsB

J-Link script: none

J-Link settings file: none

------ Target related settings------

Tar get devi ce: MKL43Z256xxx4

Target interface: SWD

Target interface speed: auto

Target endi an: little

bc. .

Connecting to J-Link...
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J-Link is connected.

Devi ce "MKL43Z256XXX4" sel ect ed.

Fi rmwar e: J-Link OpenSDA conpiled Nov 16 2016 09:42: 59
Har dwar e: V1. 00

S/'N: 621000000

Checki ng target voltage...

Target voltage: 3.30 V

Li stening on TCP/IP port 2331

Connected to target

Waiting for GDB connection...Connected to 127.0.0.1

Readi ng all registers

...Target halted (PC = 0x00000150)

Read 4 bytes @ address 0x00000150 (Data = 0x46CO0E7FE)

Resetting target

Sem - hosting enabl ed (Handl e on BKPT)

Downl oadi ng 6940 bytes @ address 0x00000000 - Verified OK

J-Link: Flash downl oad: Flash programmi ng perfornmed for 1 range (7168 bytes)
J-Link: Flash downl oad: Total tine needed: 0.480s (Prepare: 0.081s, Conpare: 0.024s,
Erase: 0.105s, Program 0.238s, Verify: 0.023s, Restore: 0.007s)
Witing register (PC = 0x00010000)

Read 4 bytes @ address 0x00000100 (Data = 0xB672B510)

Read 2 bytes @ address 0x00000414 (Data = 0xF000)

Read 2 bytes @ address 0x00000414 (Data = 0xF000)

Read 2 bytes @ address 0x00000414 (Data = 0xF000)

Setting breakpoint @address 0x00000414, Size = 2, BPHandl e = 0x0001
Starting target CPU...

... Breakpoi nt reached @ address 0x00000414

Readi ng all registers

Read 4 bytes @ address 0x00000414 (Data = O0xF816F000)

Renovi ng breakpoi nt @ address 0x00000414, Size = 2
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4. SDKs and Pre-Installed Part Support Overview

To support a particular MCU (or family of MCUs), a number of elements are required. These
break down into:

e Startup code

« This code will handle specific features required by the MCU
¢ Memory Map knowledge

* The addresses and sizes of all memory regions
 Peripheral knowledge

 Detailed information allowing the MCUs peripherals registers to be viewed and edited
* Flash Drivers

» Routines to program the MCU'’s on and off chip flash devices as efficiently as possible
* Debug capabilities

« Knowledge of the MCU debug interfaces and features (e.g. SWO, ETB)
* Example Code

» Code to demonstrate the features of the particular MCU and supporting drivers

MCUXpresso IDE uses these data elements for populating its wizards, and for built in intelligence
features, such as the automatic generation of linker scripts etc.

MCUXpresso IDE delivers its part support through an extensible scheme.

4.1 Pre-installed Part Support
Firstly the IDE installs with an enhanced version of the part support as provided with LPCXpresso
IDE v 8.2.2. This provides support for the majority of LPC parts ‘out of the box’. This is known
as pre-installed part support.
Example code for these pre-installed parts is provided by sophisticated LPCOpen packages (and
Code Bundles). Each of these contains code libraries to support the MCU features, LPCXpresso
boards (and some other popular ones), plus a large humber of code examples and drivers.
Version of these are installed by default at:
<install dir>/idel/ Exanpl es/ LPCOpen
<install dir>/idel/ Exanpl es/ CodeBundl es
Further information can be founds at:
http://www.nxp.com/Ipcopen
http://www.nxp.com/LPC800-Code-Bundles
4.2 SDK Part Support
Secondly, MCUXpresso IDE’s part support can be extended using freely available MCUXpresso
SDK2.x packages. These can be installed via a simple ‘drag and drop’ and automatically extend
the IDE with new part knowledge and examples.
SDKs for MCUXpresso IDE can be generated and downloaded as required using the SDK Builder
on the MCUXpresso Config Tools website at:
http://mcuxpresso.nxp.com/
Support for Kinetis devices is delivered by SDK2.x packages, in addition this mechanism will be
used to offer support for new LPC MCUs from NXP such as the LPC54608J512.
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Once an SDK has been installed, the included part support becomes available through the New
Project Wizard and also the SDK example import Wizard.

Important notes for SDK users
Only SDKs created for MCUXpresso IDE can be used

Only SDKs built specifically for MCUXpresso IDE are compatible with MCUXpresso IDE. SDKs
created for any other toolchain will not work! Therefore, when requesting an SDK be sure that
MCUXpresso IDE is specified as the Toolchain.

Shared Part Support handling

Each SDK package will contain part support for one or more MCUSs, therefore it is possible
to have two (or more) SDK packages containing the same part support. For example, a user
might request a Tower K64 SDK and later a Freedom K64 SDK that both target the same
MK64FN1MOxxx12 MCU. If both SDKs are installed into the IDE, both sets of examples and
board drivers will be available, but the IDE will select the most up to date version of part support
specified within these SDKs. This means the various wizards and dialogues will only ever present
a single instance of an MCU, but may offer a variety of compatible boards and examples. Note:
If a board is selected (from one SDK) and part support is provided by another SDK, a message
will displayed within the project wizard to show this has occured but no user action is required.

If two SDKs with matching part support are installed, and the SDK providing part support later
deleted, then part support will automatically be used from the remaining SDK.

Building a Fat SDK

An SDK can be generated for a selected part (processor type/MCU) or a board. If just a part is
selected, then the generated SDK will contain both part support and also board support data for
the closest matching development board.

Therefore, to obtain an SDK with both Freedom and Tower board support for say the Kinetis
MK®64... part, simply select the part and the board support will be added automatically.

If a part is chosen that has no directly matching board, say the Kinetis MK63... then the generated
SDK will contain:

e part support for the requested part i.e. MK63...

« part support for the recommended closest matching part that has an associated development
board i.e. MK64...

¢ board support packages for the above part i.e. Freedom and/or Tower MK64...

Uninstallation Considerations

MCUXpresso IDE allows SDKs to be installed and uninstalled as required (although for most
users there is little benefit in uninstalling an SDK). However, since the SDK provides part support
to the IDE, if an SDK is uninstalled, part support will also be removed. Any existing project built
using part support from an uninstalled SDK will no longer build or debug. Such a situation can
be remedied by re-installing the missing SDK. Note: if there is another SDK installed capable of
providing the ‘missing’ part support, then this will automatically used.

Sharing Projects

If a project built using part support from an SDK and is then exported — for example to share the
project with a colleague who also uses MCUXpresso IDE, then the colleague must also install
an SDK providing part support for the projects MCU. Note: it is recommeded that any required
SDKs are installed before a project requiring SDK part support is imported. However, if this is
not done, simply select the imported project in the project explorer and right click and select: C/
C++ Build -> MCU settings ensure the correct MCU is selected and click Refresh MCU Cache.
Please see the section Importing Example Projects [54]
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4.2.2 Differences in Pre-installed and SDK part handling

4.3

Since SDKs bundle part (MCU) and board support into a single package, MCUXpresso IDE is
able to provide linkage between SDK installed MCUs and their related boards when creating or
importing projects.

For pre-installed parts, the board support libraries are provided within LPCOpen packages and
Code Bundles. It is the responsibility of user to match an MCU with its related LPCOpen board
and chip library when creating or importing projects.

Creating and importing project using Pre-Installed and SDK part support is described in the
following chapters.

Viewing Pre-installed Part Support

When MCUXpresso IDE is installed, it will contain pre-installed part support for most LPC based
MCUs.

To explore the range of pre-installed MCUs simply click ‘New project’ in the QuickStart panel.
This will open a page similar to the image below:

| €3 Please select a target device or a board ‘ L &

. Board and/or Device selection page

~ EDK MCUs

SDK Wizard

MCUs from installed SDKs
Target

* Preinstalled MCUs

MCUs from preinstalled LPC
and generic Cortex-M part
Suppe

»LPCT1AxXx
»LPC11E6x
»LPC11Exx
vLPC11U6x
LPC11UB6
LPC11U67
LPC11U6B8
»LPC11Uxx

Target Core:
Description:

@

Figure 4.1. New Project Wizard

Available boards 1% &

Please select an available board for your project.

LPCXpresso812-MAX LPCXpresso812 LPCXpressoB45-MAX LPCXpresso824-MAX

| Ve anaE A4 A | P WnsananE 44 A0 | Y s A0 | Ve ana AR EAT

SDKs for selected MCU

Mame Version Location

Cancel

The list of pre-installed parts is presented on the bottom left of this window.
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You will also see a range of related development boards indicating whether a matching LPCOpen
Library or Code Bundle is available.

For creating project with Pre-Installed part support please see: Creating Projects with Pre-
Installed part support) [47]

If you intend to work on an MCU that is not available from the range of Pre-Installed parts for

example a Kinetis MCU then you must first extend the part support of MCUXpresso IDE with
the required SDK.

4.4 Installing an SDK

The process to follow is simple, first download the SDK package, then install this into
MCUXpresso IDE.

The easiest way to do this is to switch to the “Installed SDKs” view within the MCUXpresso IDE
console view (highlighted below).

‘e0e® workspace - Develop - http://kex.nxp.com/en/welcome - MCUXpresso IDE
ol cGeia S P A0 0@ cGlet oo
[t Project E % %, Peripher 4% Register & Symbol = B @ Welcome to MCUXpresso | MCUXpresso Config Tools 52 =8
BS <
NXO MCUXpresso  OVERVIEW TOOLS ~ MANAGE ~ @ Engiish ~ L Guest- B

MCUXpresso Config Tools

MCUXpresso Config Tools provides a set of system configuration tools that help users of all levels with
a Kinetis or LPC-based MCU solution. Let it be your guide from first evaluation to preduction
development.

#) Login to view configurations

()

Specify optional Generate a downloadable Assign signals to pins, set Setup the system clocks
O Quick % ®-Cloba - Varia © Break g= Outin = O middleware and SDK archive for use with electrical properties, and and generate initialization
5 MCUXpresso IDE (Pro Edition) environment settings for desktop MCUXpresso generate initialization code. code.
T your configuration Tools

~ Start here

@ Installed SDKs 5¢ []™pperties [ Console [£] Problems [ Memory € Instruction Trace £ SWO Trace Gonfig &3 Power Measurement Tool e mE =0
B New project...
Slnsia dsSD

B Import SDK examplels)...

® Import project(s) To install an SDK, simply drag and drop an SDK (zip file/folder) into the ‘Installed SDKs' view.
R Name Version Location

e

k-3

k3

o

(2 Quick Settings>>

&

&

~ Manage SDK

0 items selected

Figure 4.2. SDK Import

SDKs are free to download (login is required); MCUXpresso IDE offers a link to the SDK portal
from the Installed SDK Console view (as indicated above). If required, the necessary SDK can
be downloaded onto the host machine.

To install the SDK, simply open a Windows Explorer / filer onto the directory containing the SDK
package(s), then select the ZIP file(s) and drag them into the “Installed SDKs” view.
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You will then be prompted with a dialog asking you to confirm the import — click OK. The SDK or
SDKs will then be automatically installed into MCUXpresso IDE part support repository.

Notes:

* MCUXpresso IDE can import an SDK as a zipped package or unzipped folder. Typically
importing as a zipped package is expected.

« The main consequence of leaving SDKs zipped is that you will not be able to create (or
import projects) into a workspace with linked references back to the SDK source files.

* When an SDK is imported via drag and drop, required files are copied and the original file/
folder is unaffected. This also installs imported data into a default location allowing imported
SDKs to be shared among different IDE instances/installations and workspaces.

Once complete the “Installed SDKs” view will update to show you the package(s) that you have
just installed.

[ Installed SDKs % [[] Properties B Console %! Problems [J Memory & Instruction Trace [ SWO Trace Config BD Power Measurement Tool @3 & ==l
‘0 Installed SDKs

To install an SDK, simply drag and drop an SDK (zip file/folder) into the 'Installed SDKs' view.
MName Version Location

1 SDK_2.x_LPCXpresso54608 2.2.0 [_Q SDK_2.x_LPCXp b Boards

2 SDK_2.x_FRDM-K64F 2.2.0 [& <Default Location>/SDK_2.x_FROM-JCR & 10 0o =]

1 SDK_2.x_FRDM-KL43Z 2.2.0 @ SDK_2.x_FRDM- » [m Compilers

11 SDK_2.x_FRDM-KB6F 2.2.0 15} SDK_2.x_FRDM- » i3 Toolchains
» (®Toolchain Settings
» ik Components

Figure 4.3. SDK Import View

The display will show whether the SDKs are stored as zipped folders or not. MCUXpresso IDE
offers the option to unzip an archive in place via a right click option onto the selected SDK (as
below).

<~ Import archive...
<= Import folder...
Unzip archive

o> Open Location
(= Open Default Location

# Delete SDK
Note: Unzipping an SDK may take some time and is generally not needed unless you wish to

make use of referenced files or perform many example imports (where some speed improvement
will be seen).

Once an SDK has been unzipped, its icon will be updated to reflect that it is now stored internally
as a folder.
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'@ Installed SDKs

Name

Figure 4.4. SDK Unzipped

1 SDK_2.x_LPCXpresso54608
# SDK_2.x_FRDM-KB4F

# SDK_2.x_FRDM-KL43Z

£ 8DK_2.x_FRDM-K&6F

[ Installed SDKs 5% | [ Properties E Console [f! Problems [0 Memory & Instruction Trace [5; SWO Trace Config B2 Pow

To install an SDK, simply drag and drop an SDK (zip file/folder) into the “Installed SDKs' view.

Version Location
2.2.0 =
220
220 i
2.2.0 B

SDK_2.x_LPCXpresso54608
SDK_2.x_FRDM-KGB4F
SDK_2.x_FRDM-KL43Z
SDK_2.x_FRDM-K66F

You can explore each of the SDKs within the “Installed SDKs” view to examine its contents as

below:

[ Installed SDKs 8 [ Properiies

@ Installed SDKs

Name

£ SDK_2.x_LPCXpresso54608
4 8DK_2.x_FRDM-K64F

£ SDK_2.x_FRDM-KL43Z

5 SDK_2.x_FRDM-K88F

Figure 4.5. SDK Explore

Console (2! Problems (] Memory €

To install an SDK, simply drag and drop an SDK (zip file/folder) into the 'Installed SDKs' view.

Version Location

2.2.0 b SDK_2.x_LPCXpresso54608
220 (2 <Default Location>/SDK_2.x_FRDM-K64F

220 3 SDK_2.x_FRDM-KL43Z
220 i) SDK_2.x_FRDM-K66F

» B Devices

Instruction Trace 5. SWO Trace Config =D Power Measurement Tool

» E cmsis_driver_examples
» = demo_apps

» S driver_examples

» Z emwin_examples

» £ mmcau_examples

» £ multiprocessor_examples
£ rtos_examples
MNEusb_examples

4.4.1 Advanced Use: SDK Importing and Configuration

Although using the “Installed SDKs” view offers the most straight forward way of importing SDKSs,
MCUXpresso IDE also provides additional capabilities for importing and configuring its SDK

usage.

If you go to Preferences->MCUXpresso IDE->SDK Options then the following window will appear:
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» General

»C/C++

» Help

¥ Install/Update

¥ MCUXpresso IDE
Debug Options (Advar
Debug Options (Misce
Debug Probe Discover
Default Tool settings
General
J-Link Options
LinkServer Options
LPC-Link Options
LPC-Link2 SWO Trace
MCU settings
Paths and Directories
Quickstart Panel
SDK Options
User Interface Enabler
Utilities

» Run/Debug

»Team

©

Figure 4.6. SDK Preferences

Prefarences

SDK Options

v v

L

Add SDK install locations to the following table to provide part support in

MCUXpresso IDE.
SDK refresh palicy on startup:

Always unzip SDK zipped files when installing.

Do not ask for unzipping SDK on import.
Refresh and recreate part info
SDK search roots:

Msers/peterhenry/mcuxpresso/SDKPackages

2. Recreate part info

New...

Hide middleware components in the SDK New Project Wizard.

Restore Defaults

Cancel

Apply

L OK

From here you can add paths to other folders where you have stored or plan to store SDK
folders/zips. Those SDKs will appear in the Installed SDKs View along with those from the default

location.

The main differences between having SDKs in the default location or leaving them in other folders

are:

« “Delete SDK” function is disabled when using non-default locations
 since these SDKs are not imported, they may be original files
« The knowledge of the SDKs and their part support is per-workspace

The order of the SDKs in the SDK location list may be important on occasion: if you have multiple
SDKs for the same part in various locations, you can choose which to load by reordering. If
multiple SDK are found, a warning is displayed into the Installed SDK view.
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5. Creating New Projects using SDKs

For creating project with Pre-Installed part support please see: Creating Projects with Pre-
Installed part support [47]

From the QuickStart Panel in the bottom left of the MCUXpresso IDE window there are two
options:

) Quic 53 Glob Var Brea Out = [m]
- MCUXpresso IDE (Pro Edition)
ICE

~ Start here

. New project...
. Import SDK example(s)...

® Import project(s)

2 Quick Settings==

oy Build all projects []

Figure 5.1. SDK Projects

The first will invoke the New Project Wizard, that guides the user in creating new projects from
the installed SDKs (and also from pre-installed part support — which will be discussed in a later
chapter).

The second option invokes the SDK Import Wizard that guides the user to import SDK example
projects from installed SDKs.

This option will be explored in the next chapter.

Click New project to launch the New Project Wizard.

5.1 New Project Wizard

The New Project Wizard will begin by opening the “Board and/or device selection” page, this
page is populated with a range of features described below:
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e0e SDK Wizard

E) Creating project for device: MKB4FN1M0xxx12 with no board. )‘— @ ‘ k @

. Board and/or Device selection page

MCUs Available boards / \A
hiWs from installed S i innt
NXP MKB4FN1M
»LPC

> MKLxx

¥ MKxx
MKB4FN1MOxxx12
MKBEFN2MOxxx18

stalled MCUs T )
N from preinstalled LPC and —

generic Cortex-M part support frdmkl43z

frdmk&6f frdmk64f LPCXpresso812-MAX

Target
»LPC1102
»LPC112x

»LPC11Axx |
»LPC11E6x |
»LPC11Exx E

»LPC11UBx
FLPC11Uxx
»LPC11xx

»LPCT 1LV LPCXpresso812 LPCXpresso845-MAX LPCXpresso824-MAX |pcxpresso54608

KSDK\
=/

Selected Device: MKB4FN1MO0xxx12 with no board. SDKs for selected MCU
Name Varsion Location

Target Core: cortex-md
| 8DK_2.x_FRDM-K64F 220 [ <Default Locatiol M-K

Description:
KB4_120; Kinetis® K64-120 MHz, 256KB SRAM
Microcontrollers (MCUs) based on ARM® Cortex 4

@ Cancel

Figure 5.2. New Project Wizard first page

1. Adisplay of all parts (MCUSs) installed via SDKs. Click to select the MCU and filter the available
matching boards. SDK part support can be hidden by clicking on the triangle (highlighted in
the blue oval)

2. A display of all pre-installed parts (these are all LPC or Generic M parts). Click to select the
MCU and filter the available matching boards (if any). Pre-Installed part support can be hidden
by clicking on the triangle (highlighted in blue)

3. A display of all boards from both SDKs or matching LPCOpen packages. Click to select the
board and its associated MCU.

« Boards from SDK packages will have ‘SDK’ superimposed onto their image.
4. Some description relating to the users selection

5. A display to show the matching SDK for a chosen MCU or Board. If more than one matching
SDK is installed, the user can select the SDK to use from this list

6. Any Warning, Error or Information related to the current selection

7. An input field to filter the available boards e.g. enter ‘64’ to see matching MK64... Freedom
or Tower boards available

8. 3 options: to Sort boards from A-Z, Z-A or clear any filter made through the input field or a
select click. Note: once a project has been created, the filter settings will be remembered the
next time the Wizard is entered (unless cleared by an external event such as the installation
of a new SDK).

This page provides a number of ways of quickly selecting the target for the project that you want
to create.
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In this description, we are going to create a project for a Freedom MK64xxx board (The required
SDK has already been imported).

First, to reduce the number of boards displayed, we can simply type ‘64’ into the filter (7). Now
only boards with MCUs matching ‘64’ will be displayed.

[ JoN ) SDK Wizard
(D Creating project for device: MK64FN1MOxxx12 using board: FRDM-K64F ‘ k &
. Board and/or Device selection page

~ SDKMCUs Available boards LR e
MCUs from installed SDKs Please select an available board for your project.

NXP MKB4FN1MOxxx12 m
FLPC

MKLxx

e
| MKEB4FN1MOxxx12
| v o0 Lray e O

~ Preinstalled MCUs

MCUs from preinstalled LPC and
generic Cortex-M part support frdmk64f

Target
»LPC1102
FLPC112x
HLPC11AxXx
»LPC11E6x
»LPC11Exx
»LPC11U6x
FLPC11Uxx
HLPC11xx
FLPC11xxLV

Selected Device: MK64FN1MDxooc12 using board: FRDM-KB4F SDKs for selected MCU

Target Core: cortex-m4 MName Varsion Location
Description: ++ SDK_2.x_FRDM-K64F 2.2.0 #<Default Location)fSDK_zx_FFlDl\D

K64_120: Kinetis® K64-120 MHz, 256KB SRAM
| Microcontrollers (MCUs) based on ARM® Cortex®-M4 Core

@ BT | cancel

Figure 5.3. New Project Wizard selection

When the (SDK) board is selected, you can see highlighted in the above figure that the matching
MCU (part) and SDK are also selected automatically.

With a chosen board selected, now click ‘Next'...

5.1.1 SDK New Project Wizard: Basic Project Creation and Settings

The SDK New Project Wizard consists of two pages offering basic and advanced configuration
options. Each of these pages is preconfigured with default options (the default options offered
on the advanced page may be set based on user settings from the basic page).

Therefore, to create a simple ‘Hello World’ C project for the Freedom MK64... board we selected,
all that is required is simply click ‘Finish’.

Note: The project will be given a default name based on the MCU name. If this name matches a
project within the workspace e.g. the wizard has previously been used to generate a project with
the default name, then the error field will show a name clash and the ‘next’ and ‘finish’ buttons
will be ‘greyed out’. To change the new project’'s name; the blank ‘Project Name Suffix’ field can
be used to quickly create a unique name but retain the original prefix.
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This will create a project in the chosen workspace taking all the default Wizard options for our
board.

However, the wizard offers the flexibility to select/change many build, library and source code
options. These options and the components of this first Wizard page are described below.

e0® SDK Wizard

: i )<_® o

. Configure the project

Project name‘ MKB4FN1MOxxx12_Project ' 4— @ /7 | Project name suﬂix@‘— @ &

Use default location

Location: o

Device Packages )

o MKB4FN1MOVDC12
MKB4FN1MOVLL12

Board Project Type Project Options

© Empty board files
Default board files

© C Project C++ Project Enable semihost
C Static Library C++ Static Library CMSIS-Core

MKB4FN1MOVLQ12 Copy sources

& | driver o utilities i Sﬁ

MName ersion Mame Version MName Version
It baremetal 1.0.0 B 2.0.0 o @debug_console 1.0.0
T lptfreertos 9.0.0 . 2.1.0 T litmisc_utilities 1.0.0
. 2.0.0 T lgknotifier 1.0.0
. T lgkshell 1.0.0
» -@ﬂexbus
@ < Back Next > Cancel [ Finish |

Figure 5.4. New Project Wizard basic SDK settings

1. Project Name: The default project name prefix is automatically selected based on the part
selected on the previous screen

2. Project Suffix: An optional suffix to append to a project name can be entered here

3. Error and Warnings: Any error or warning will be displayed here. The ‘Next’ option will not
be available until any error is handled — for example, a project name has been selected that
matches an existing project name in your workspace. The suffix field (2) allows a convenient
way of updating a project name

4. MCU Package: The device package can be selected from the range contained with the SDK.
The package relates to the actual device packaging and typically has no meaning for project
creation

5. Board files: This field allows the automatic selection of a default set of board support files, else
empty files will be created. If a part rather than a board had been selected on the previous
screen, these options will not be displayed.
« if you intend to use board specific features such as output over UART, you should ensure

Default board files are selected
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5.1.2

MCUXpresso IDE User Guide -

6. Project Type: C or C++ projects or libraries can be selected. Selecting ‘C’ will automatically

select RedLib libraries, selecting C++ will select NewlibNano libraries. See C/C++ Library
Support [72]

7. Project Options:

¢ Enable Semihost: will cause the Semihosted variant of the chosen library to be selected.
For C projects this will default to be Redlib Semihost-nf. Semihosting allows 10 operations
such as printf and scanf to be emulated by the debug environment.

¢ CMSIS-Core: will cause a CMSIS folder containing a variety of support code such as Clock
Setup, header files to be created. It is recommended to leave this options ticked

e Copy Sources: For zipped SDKs, this option will be ticked and greyed out. For unzipped
SDKs, projects can be created that use linked references back to the original SDK folder.
This feature is recommended for ‘Power Users’ only

8. Each set of components support a filter and check boxes for selection. These icons allow
filters to be cleared, all check boxes to be set, all check boxes to be cleared

9. OS: This provides the option to pull in and link against Operating System resources such as
FreeRTOS.

10.driver:; enables the selection of supporting driver software components to support the MCU
peripheral set.

11.utilities: a range of optional supporting utilities.

« For example select the debug_console to make use of the SDK Debug Console handling
of 10

¢ Selecting this option will cause the wizard to substitute the (SDK) PRINTF() macro for C
Library printf() within the generated code

« the debug console option relies on the OpenSDA debug probe communicating to the host
via VCOM over USB.

Finally, if there is no error condition displayed, ‘Finish’ can be selected to finish the wizard,
alternatively, select ‘Next’ to proceed to the Advanced options page (described next).

SDK New Project Wizard: Advanced Project Settings
The advanced configuration page will take certain default options based on settings from the first

configure project page, for example a C project will pre-select Redlib, where as a C++ project
will pre-select NewlibNano.
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[ JoN | SDK Wizard

. Advanced project settings

f~ C/C++ Library Settings 2
Set library type (and hosting variant) Redlib (semihost-nf) a
Redlib: Use floating point version of printf
Redlib: Use character rather than string based printf
Redirect SDK "PRINTF" to C library "printf"
Redirect printf/scanf to ITM
Redirect printf/scanf to UART 3
ﬂ Memory Configuration
Memory details
Type Name Alias Lecation Size Driver
Flash PROGRAM_FLASH Flash 0x0 0x100000 FTFE_4K.cfx
RAM SRAM_UPPER RAM 0x20000000 0x30000 Edit
RAM SRAM_LOWER RAM2 0x1fff0000 0x10000
RAM FLEX_RAM RAM3 0x14000000 0x1000
\
~ Hardware settings
Set Floating Point type | Fpy4 (HardABI) ‘ a

* MCU C Compiler
Language standard | Compiler default l o

@ < Back Cancel [ Finsn

Figure 5.5. New Project Wizard advanced SDK settings

1. This panel allows options to be set related to Input/Output. Note if a C++ project was
selected on the previous page, then the Redlib options will be Greyed out. See C/C++ Library
Support [72]

* Redlib Floating Point printf: If this option is ticked, floating point support for printf will
automatically be linked in. This will allow printf to support the printing out of floating point
variables at the expense of larger library support code.

* Redlib use Character printf: selecting this option will avoid heap usage and reduce code
size but make printf operations slower

¢ Redirect SDK “PRINTF": many SDK examples use a PRINTF macro, selecting this option
causes redirection to C library 10 rather than options provided by the SDK debug console

¢ Redirect printf/scanf to ITM: causes a C file 'retarget_itm.c to be pulled into your project.
This then enables printf/scanf 1/O to be sent over the SWO channel. The benefit of this is
that 1/0 operations can be performed with little performance penalty. Furthermore, these
routines do not require debugger support and for example could be used to generate logging
that would effectively go to Null unless debug tools were attached. Note: not available on
Cortex MO and MO+ parts

« Redirect printf/scanf to UART: Sets the define SDK_DEBUGCONSOLE_UART causing the
C libraries printf functions to re-direct to the SDKs debug console UART code

2. This panel allows the selection of various library variants. See C/C++ Library Support [72]
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Redlib {none)
Redlib {nohost)
Redlib (semihost)
Redlib (nohost-nf)

+ Redlib {semihost-nf)
NewlibNano (hone)
NewlibNano (nohost)

! NewlibNano (semihost)
Newlib (none)
Newlib (nohost)
Newlib (semihost)

3. Memory Configuration: This panel shows the Flash and RAM memory layout for the MCU
project being created. The pre-selected LinkServer flash driver is also shown. Note: this flash
driver will only be used for LinkServer (CMSIS-DAP) debug connections.

¢ Clicking Editinvokes the IDE’'s memory configuration editor. From this dialogue, the project’s
default memory setting and hence automatically generated linker settings can be changed.
See Memory Configuration and Linker Scripts [82]

Browse...

e @
i Memory configuration editor
I Edit configuration for MK64FN1MOxx12

MCUXpresso IDE

| Memory configuration
i Default flash driver |

Type  Name Nias Location Size Driver

! |Flash PROGRAM_FLASH Flash  Ox0 0x100000  FTFE_4K.cfx i
| RAM SRAM_UPPER  RAM  0x20000000 0x30000
RAM SRAM_LOWER  RAM2  Ox1iff0000  0x10000 &
t RAM  FLEX_RAM RAM3  0x14000000 0x1000
|
|
|
| | Add Flash Add RAM Split Delete
]
1 Import... Merge...
Cancal [ oKk |

L

4. Hardware Settings: from this drop down you can set options such as the type of floating point
support available/required. This will default to an appropriate value for your MCU.
None

FPv4 (SoftABI)
Set Floating Point type .+ FPy4 (HardABI) I

~ Hardware settings

5. MCU C Compiler: from this drop down you can set various compiler options that can be set
for the GNU C/C++ compiler.

~ Hardware settin

Set Floating Point 1

* MCU C Compile

GNU €99 (-std=gnug9)

GNU C11 (-std=gnu11)

ISO €30 / ANSI C89 (-std=c90) |
1SO ©99 (-std=cog)

1SO C11 (-std=c11)

GNU C80 (-std=gnu80)

Language standarc . Compiler default |

5.2 SDK Build Project

MCUXpresso IDE User Guide -

To build a project created by the SDK New Project Wizard, simply select the project in the ‘Project
Explorer’ view, then go to the ' QuickStart' Panel and click on the build button to build the
project. This will build the project for the default projects ‘Debug’ configuration.

Note: MCUXpresso IDE projects are created with two build configurations, Debug and Release
(more can be added if required). These differ in the default level of compiler optimisation. Debug
projects default to None (-O0), and Release projects default to (-Os). For more information
on switching between build configurations, see How do | switch between Debug and Release

builds? [117]
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The build log will be displayed in the console view as below.

) Installed SDKs [ Properties &l Console 2 [2 Problems [J Memory €& Instruction Trace ESWO Trace Config B2 Power Measurement Tool LU TS <‘5.> 5 | % MBE-M-= 8
CDT Build Console [MKB84FN1MOxxx12_Project]

Building file: ../CMSIS/system_MKB4F12.c

Invoking: MCU € Compiler

arm-none-eabi-gee -DCR_INTEGER_PRINTF -DSDK_DEBUGCONSOLE-® -D__MCUXPRESSO -D__USE_CMSIS -DDEBUG -DSDK_OS_BAREMETAL -DFSL_RTOS_BM -DCPU_MKE4FNIM@VDC1Z -DCPU_MKG4FNIMAVDC1Z_cmd -|
Finished building: ../startup/startup_mk64f12.c

Finished building: ../source/MK64FN1MOxxx12_Project.c

Finished building: ../(MSIS/system_MKG4F12.c

Building target: MKBAFNIM3xxx1Z_Project.axf
(Invoking: MCU Linker
jorm-none-eabi-gce -nostdlib -Xlinker -Mop="MKG64FN1M8xxx12 Project.map” -Xlinker --gc-sections -Xlinker -print-memory-usage -mcpu=cortex-md -mfpu=Ffpvé-sp-d16 -mfloat-abi=hard -m

Memory region Used Size Region Size Xoge Used
PROGRAM_FLASH: 8216 B 1 M8 8.78%
SRAM_UPPER: 8302 B 192 KB 4.27%
SRAM_LOWER: @ GB 64 KB 9.00%
FLEX_RAM: @ GB 4 KB 9.00%

Finished building target: MKE4FNIM@xxx12_Project.axf

make --no-print-directory post-build
Performing post-build steps
arm-none-eabi-size "MKG4FN1MBxxx12_Project.axf"; # arm-none-eabi-objcopy -v -0 binary "MKE4FNIM@xxx12_Project.axf" "MKE4FNIM@xxx12_Project.bin" ; # checksum -p MKE4FNIM@xxx12 -1
text  data bss dec hex filename
8212 4 8388 16604  40dc MKBAFNIMOxxx12_Project.axf

15:15:38 Build Finished (took 669ms}

Figure 5.6. New Project Wizard Build

The projects memory usage as highlighted above is shown below:

Menory region Used Size Region Size %age Used

PROGRAM_FLASH: 8216 B 1 M 0. 78%
SRAM_UPPER: 8392 B 192 KB 4.27%
SRAM_LOVER: 0GB 64 KB 0. 00%
FLEX_RAM 0GB 4 KB 0. 00%

Fi ni shed buil ding target: MG64FNLM)xxx12_Proj ect . axf

By default, the application will build and link against the first flash memory found within the
devices memory configuration. For most MCUs there will only be 1 flash device available. In this
case our project requires 8216 bytes of Flash memory storage, 0.78% of the available Flash

storage.

RAM will be used for global variable, the heap and the stack. MCUXpresso IDE provides a flexible
scheme to reserve memory for Stack and Heap. The above example build has reserved 4KB
each for the stack and the heap. Please See Memory Configuration and Linker Scripts[82]

for detailed information.
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6. Importing Example Projects (from SDKSs)

In addition to drivers and part support, SDKs also deliver many example projects for the target
MCU.

To import examples from an installed SDK, go to the QuickStart panel and select Import SDK
example(s).

) Quickstart &2 Global Var Variables Breakpoint Outline = O

. MCUXpresso IDE (Pro Edition)
o€

- Start here

' . Import SDK example(g)... '

¥ Import projeci(s) from file sysiem...

& Quick Settings>>

lo Build all projects [

Figure 6.1. SDK Example

This option invokes the SDK Import Wizard that guides the user to import SDK example projects
from installed SDKs.

Like the New Project wizard, this will initially launch a page allowing MCU/board selection.
However now, only SDK supported parts and boards will be presented.
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[ ] @ SDK Import Wizard

@ Please select a board ‘ ’ »
NS

. Board and/or Device selection page

~ SDK MCUs Available boards [C L)
MCUs from installed SDKs
NXP MKEAFN1 MO 12

¥LPC

Please select an available board for your project.

LPC54608J512

¥ MKLxx
MKL43Z256xxx4

v MKxx
MKB4FN1MOxxx12
MKBBFN2MOxxx18

frdmkl43z frdmk66f frdmk64f lpexpresso54608
Selected Device: MK64FN1MOxxx12 using board: FRDM-K64F SDKs for selected MCU
Target Core:  cortex-mé Name Version Location
1 SDK_2.x_FRDM-KB4F 2.2.0 #<Default Location>/SDK_2.x_FRDM-|

Description:
K64_120: Kinetis® K64-120 MHz, 256KB SRAM
Microcontrollers (MCUs) based on ARM® Cortex®-M4 Core

@ Cancel

Figure 6.2. SDK Example Board

6.1 SDK Example Import Wizard

Selection and filtering work in the same way as for the New Project Wizard [32] but note,
examples are created for particular development boards, therefore a board must be selected to
move to the ‘Next’ page of the wizard.

6.1.1 SDK Example Import Wizard: Basic Selection

The SDK Example Import Wizard consists of two pages offering basic and advanced
configuration and selection options. The second configuration page is only available when a
single example is selected for import. This is because examples may set specific options, and
therefore changing settings globally is not sensible.

The first page offers all the available examples in various categories. These can be expanded to
view the underlying hierarchical structure. The various settings and options are explained below:
Note: The project will be given a default name based on the MCU name, Board name and
Example name. If this name matches a project within the workspace e.g. the wizard has
previously been use to generate an example with the default name, then the error field will show
a name clash and the ‘next’ and ‘finish’ buttons will be greyed out. To change the new example
name, the blank ‘Project Name Suffix’ field can be used to quickly create a unique name but
retain the original prefix e.g. add ‘1'.
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MCUXpresso IDE will create a project with common default settings for your chosen MCU and
board. However, the wizard offers the flexibility to select/change many build, library and source
code options. These options and the components of this first Wizard page are described below.

@ Please select one or mare examples to import ‘ L &
. Import projects

SDK Import Wizard

(Projecl name prefix: | frdmkgaf_ w 7 Gro]ect name suffix: )P@ 7

Use default location

Location:

(Projeat Type

Project Options
Enable semihost o

Examples

d

Copy sources
: Version

» = cmsis_driver_examples

» = demo_apps

S driver_examples

I
» = emwin_examples

» = mmcau_examples ‘_

» = multiprocessor_examples

»

2

= rtos_examples
S usb_examples

3
@

Figure 6.3. SDK Example Selection

< Back Cancel
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. Project Name: A project name is automatically created with a name of the form: prefix_SDK

example path_example name_suffix.

. Project Suffix: An optional suffix to append to a project name can be entered here. This is

particularly useful if you are repeating an import of one or more projects since an entry here
can make all auto generated names unigue for the current workspace... Note: Changing the
default name of Imported SDK MultiCore examples may cause linkage to fail.

. Project Type: These will be set by the pre-set type of the example being imported. If more

than one example is imported, then these options will appear greyed out.

. Project Options: ‘Enable semihost’ check this box to create projects with semihosting support

(options and libraries). ‘Copy sources’ For unzipped SDKSs, you can untick this option to create
project containing source links to the original SDK files. This option should only be unticked
with care, since editing linked example source will overwrite the original files!

. Examples Filter: Enter text into this field to select matches for example ‘LED’, ‘bubble’ will

select common examples from the set. This filter is case insensitive.

. Examples: The example list broken into categories. Note for some parts there will be many

potential examples to import
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7. Various options:

¢ Opens a filer window to allow an example to be imported from an XML description. This is
intended as a developer feature and is described in more detail below.

e Clear any existing filter

« Select (tick) all Examples

¢ Clear all ticked examples

¢ Open the example structure
¢ Close the example structure

Finally, if there is no error condition displayed, ‘Finish’ can be selected to finish the wizard,
alternatively if only one example has been selected the option to select ‘Next’ to proceed to the
Advanced options page is available (described in the next section).

Note: SDKs may contain many examples, 185 is indicated for the FRDM MK64 SDK example
shown below. Importing many examples will take time ... Consider that each example may consist
of many files and associated description XML. A single example import may only take a few
seconds, but this time is repeated for each additional example. Furthermore, the operation of the
IDE maybe impacted by a large number of project in a single workspace, therefore it is suggested
that example imports be limited to sensible numbers.
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€ Please select one or more examples to import

MP=

. Import projects

Project name prefix:  framkeaf /| Project name suffix:

/| Use default location

Location:

Project Type Project Options

v

V| Copy sources

Examples

MCUXpresso IDE

z

ame
= : .
v = cmsis_driver_examples
= :
¥ = dspi
dma_transfer
terrupt_transfer

‘You have selected '185' projects to import.
Import may take a considerable amount of time.

v Si2e

dma_transfer
terrupt_transfer
ad_accel_value_transfer

< (&)%) ()RR &) (=)&)

v S uvart
edma_transfer
= interrupt_transfer
=
v = demo_apps
v = Iwip
¥ £ Iwip_dhcp
=bm
=
v = lwip_httpsrv
=bm
= freertos
¥ £ Iwip_httpssrv_mbedTLS
= bm
= freertos
¥ £ Iwip_httpssrv_wolfssl

SN RN RN RN RN NN RN NN NN N

< &)

LM% BB

< Back

| @

Figure 6.4. SDK Example Selection Many

Cancel

6.1.2 SDK Example Import Wizard: Advanced options

The advanced configuration page (shown below) will take certain default options based on the
example’s selected, for example a C project will pre-select Redlib libraries, where as a C++

project will pre-select NewlibNano.
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. Advanced project settings

SDK Wizard

f~ C/C++ Library Settings 2
Set library type (and hosting variant) Redlib (semihost-nf) E
Redlib: Use floating point version of printf
Redlib: Use character rather than string based printf
Redirect SDK "PRINTF" to C library "printf"
Redirect printf/scanf to ITM
Redirect printf/scanf to UART 3
ﬂ Memory Configuration
Memory details
Type Name Alias Lecation Size Driver
Flash PROGRAM_FLASH Flash 0x0 0x100000 FTFE_4K.cfx
RAM SRAM_UPPER RAM 0x20000000 0x30000 Edit
RAM SRAM_LOWER RAM2 0x1fff0000 0x10000
RAM FLEX_RAM RAM3 0x14000000 0x1000
\
~ Hardware settings
Set Floating Point type | Fpy4 (HardABI) ‘ E

* MCU C Compiler
Language standard

Compiler default ) l @ a

@

Figure 6.5. New

< Back Cancel [ Finish |

Project Wizard advanced SDK settings

6.1.3
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These settings closely match those in SDK New Project Wizard description. Therefore See SDK
New Project Wizard:Advanced Options [36] for a description of these options. Note: Changing
these advanced options may prevent an example from building or executing.

SDK Example Import Wizard: Import from XML fragment

This option works in conjunction with the ‘Project Explorer’ -> Tools -> Generate Example XML
(and is also used to import project created by the MCUXpresso Config Tools Project Generator).

The functionality here is to merge existing sources within a selectable board package framework.
To create an XML “fragment” for an existing project in your workspace, right click on the project
in the ‘Project Explorer’ (or just in the ‘Project Explorer’ view with no project selected) and choose

Tools->Generate examples.xml file

The selected project or all the projects in the workspace (if no projects are selected) will be
converted into a fragment within a new folder created in the workspace itself:
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m—=
==
==
—-=

[ Project Explorer 32 | &, Peripherals+ Regi

v = boards
¥ (= frdmkB4f
¥ (=~ dummy
¥ (= Category
b = MKBAFN1MOxxx12_Project
examples.xml
b 5 frdmkB4f_demo_apps_bubble

To create a project from a fragment, click on “Import SDK examples...” in the QuickStart Panel
view:

Then select a board and then click on the button “Import from XML..." (highlighted below and
described in the previous section). You will see the examples definitions from the external
fragment in list of examples as shown and selected below.

BN | SDK Import Wizard

| @ You have selected '1' projects to import. ‘ k @ ‘
| |
I |

. Import projects

Project name prefix:  frqmkg4f | Project name suffix: ML fragment

Use default location

Location:
Project Type

© C Project Copy sources

Examples R B

me
» S cmsis_driver_examples
» = demo_apps
» = driver_examples
» = emwin_examples

Project Options

Version

F = mmcau_examples
» = multiprocessor_examples
» = rtos_examples

¥ = dummy
¥ = Category
MKE4FN1MOxxx12_Project

eV 0000000 g

@ < Back MNext > Cancel ﬁ

Select the external examples you want to re-create and click on “Finish”. The project(s) will be
created in the workspace.
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7. Creating New Projects using Pre-Installed Part Support

For Creating project using SDKs please see Creating New Projects using SDKs [32]

To explore the range of pre-installed parts/MCUs simply click ‘New project’ in the QuickStart
panel. This will open a page similar to the image below:

0@ SDK Wizard

| Wy
| € Please select a target device or a board ‘ L &
|

|
. Board and/or Device selection page

~ EDK MCLUs Available boards Bl g

MCUs from installed SDKs Please select an available board for your project.

Target

* Preinstalled MCUs

MCUs from preinstalled LPC
and generic Cortex-M part LPCXpressodi12-MAX LPCXpressofi2 LPCXpressoB45-MAX LPCXpressof24-MAX

»LPC11Axx
»LPC11E6x
»LPC11Exx
vLPC11U6x

LPC11UB6
LPC11Us7
| LPC11U68

|V E A4 A | AV nnnn 44 A |V e A0 | Ve n AR O AT

SDKs for selected MCU

Target Core: Name Version Leocation

Description:

@ Cancel
|

Figure 7.1. New Project Wizard Preinstalled

The list of pre-installed parts is presented on the bottom left of this window.

You will also see a range of related development boards indicating whether a matching LPCOpen
Library is available.

For details of this page see: New Project Wizard details [32]

7.1 New Project Wizard

This wizard page provides a number of ways of quickly selecting the target for the project that
you want to create.

In this description, we are going to create a project for an LPC4337 MCU (for this MCU an
LPCOpen project exists), so we can locate the MCU using the board filter.

To reduce the number of boards displayed, we can simply type ‘4337’ into the filter. Now only
boards with MCUs matching ‘4337 will be displayed.
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(@ Creating project for device: LPC4337 using board: LPCXpressod337 ‘ k @ |

~ SDKMCUs Available boards [C =
MCUs from installed SDKs Please select an available board for your project.
NXP MKB4FN1MOxxx12
4337
»LPC
F MKLxx
» MKxx

| = Preinstalled MCUs

MCUs from preinstalled LPC and
generic Cortex-M part support LPCXpressod3d7?

NXP LPC4337
LPC4325
LPC4325-M0O
LPC4327
LPC4327-M0O
LPC4330
LPC4330-M0O
LPC4333

Selected Device: LPC4337 using board: LPCXpresso4337 SDKs for selected MCU

Target Core: cortex-md

Description: Multicore Cortex-Md4/Cortex-MO based microcontroller, with up
to 1MB Flash and 136KB RAM

| )

@

| . Board and/or Device selection page

SDK Wizard

Name Version Location

R ce

Figure 7.2. New Project Wizard selection for Pre-Installed MCUs

7.2
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When the board is selected, you can see highlighted in the above figure that the matching MCU
(part) is selected automatically.

Note: if no matching board is available, the required MCU can be selected from the list of Pre-
Installed MCUs.

Note: Boards added to MCUXpresso IDE from SDKs will have an ‘SDK’ graphic superimposed
on the board image. Boards without the SDK graphic indicate that a matching LPCOpen package
is available for that board and associated MCU.

LPCOpen is described in section LPCOpen Software Drivers and Examples [54]
With a chosen board selected, now click ‘Next'...

The wizards for Pre-Installed MCUs are very similar to those featured in LPCXpresso IDE.

Creating a Project

The MCUXpresso IDE includes many project templates to allow the rapid creation of correctly
configured projects for specific MCUs.

This New Project wizard supports 2 types of projects:

e Those targeting LPCOpen libraries
e Standalone projects
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In addition, certain MCUs like the LPC4337 support multiple core internally, for these MCUs,
Multicore options will also be presented (as below):

e0 @
New project...
LPC43xx (Cortex-M4 basic) -> C Project (Semihosted)

. Wizard selection page.

Wizard
vLPC1800/ LPC4300
¥ PC43xx (Cortex-M4 basic
LPCOpen - C Project
LPCOpen - C Static Library Project
LPCOpen - C++ Project
D Ope n- a H H o P ia
C Project (Semihosted
C Static Library Project
C++ Project
C-++ Static Library Project
TLPC43xx Multicore M4
LPCOpen - C Project
LPCOpen - C++ Project
C Project
C Project (Semihosted)
C++ Prgject

@ [ Next > JERCUTT

Figure 7.3. New project: wizard selection

You can now select the type of project that you wish to create (see below for details of Wizard
types).

In this case, we will show the steps in creating a simple C ‘Hello World’ example project.

7.2.1 Selecting the Wizard Type

For most MCU families the MCUXpresso IDE provides wizards for two forms of project: LPCOpen
and non-LPCOpen. For more details on LPCOpen, see Software drivers and examples[54]
. For both kinds, the main wizards available are:

C Project

¢ Creates a simple C project, with the min() routine consisting of an infinite wniie(1) loop that
increments a counter.

¢ For LPCOpen projects, code will also be included to initialize the board and enable a LED.

C++ Project

¢ Creates a simple C++ project, with the nai n() routine consisting of an infinite wni1e(1) loop that
increments a counter.

¢ For LPCOpen projects, code will also be included to initialize the board and enable a LED.

C Static Library Project
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1.2.2

7.3

7.3.1
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« Creates a simple static library project, containing a source directory and, optionally, a directory
to contain include files. The project will also contain a “liblinks.xml” file, which can be used by
the smart update wizard on the context-sensitive menu to create links from application projects
to this library project. For more details, please see the FAQ at

https://community.nxp.com/message/630594

C++ Static Library Project

¢ Creates a simple (C++) static library project, like that produced by the C Static Library Project
wizard, but with the tools set up to build C++ rather than C code.

The non-LPCOpen wizard families also include a further wizard:

Semihosting C Project

¢ Creates a simple “Hello World” project, with the mai n() routine containing a printf() call, which
will cause the text to be displayed within the Console View of the MCUXpresso IDE. This
is implemented using “semihosting” functionality. See the section on Semihosting [75] for
more information.

Configuring the Project

Once you have selected the appropriate project wizard, you will be able to enter the name of
your new project, this must be unique for the current workspace.

Finally you will be presented with one or more “Options” pages that provide the ability to set
a number of project-specific options. The choices presented will depend upon which MCU you
are targeting and the specific wizard you selected, and may also change between versions of
the MCUXpresso IDE. Note that if you have any doubts over any of the options, then we would
normally recommend leaving them set to their default values.

The following sections detail some of the options that you may see when running through a
wizard.

Wizard Options

LPCOpen Library Project Selection

When creating an LPCOpen-based project, the first option page that you will see is the LPCOpen
library selection page.
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o0 e
New project..

@ Select an LPCOpen Chip library project within the current workspace

. Wizard properties page.

Select the LPCOpen Chip and (optionally) Board library project(s) that you want your new project to link against.

Selected library project(s) must be present in this workspace. If they are not, then click the

Impeort...
‘Import’ button to run the Impeort Wizard p

Select LPCOpen Libraries
LPCOpen Chip Library Project Ipc_chip,_43sx ﬁ Browse...

LPCOpen Board Library Project ﬁ Browse.

If a Board Library Project is selected, then the coerresponding Chip Library Project must also be selected

"?} < Back Cancel

Figure 7.4. LPCOpen library selection
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This page allows you to run the “Import wizard” to download the LPCOpen bundle for your target
MCU/board from http://www.nxp.com/Ipcopen and import it into your Workspace, if you have not
already done so.

You will then need to select the LPCOpen Chip library for your MCU using the Workspace
browser (and for some MCUs an appropriate value will also be available from the dropdown next
to the Browse button). Note that the wizard will not allow you to continue until you have selected
a library project that exists within the Workspace.

Finally, you can optionally select the LPCOpen Board library for the board that your MCU is fitted
to, using the Workspace browser (and again, in some cases an appropriate value may also be
available from the dropdown next to the Browse button). Although selection of a board library is
optional, it is recommended that you do this in most cases.

CMSIS-CORE Selection

For backwards compatibility reasons, the non-LPCOpen wizards for many parts provide the
ability to link a new project with a CMSIS-CORE library project. The CMSIS-CORE portion of
ARM’s Cortex Microcontroller Software Interface Standard (or CMSIS) provides a defined
way of accessing MCU peripheral registers, as well as code for initializing an MCU and accessing
various aspects of functionality of the Cortex CPU itself. The MCUXpresso IDE typically provides
support for CMSIS through the provision of CMSIS library projects. CMSIS-CORE library projects
can be found in the Examples directory of your MCUXpresso IDE installation.

Generally, if you wish to use CMSIS-CORE Ilibrary projects, you should use
OMBI S_CORE_<part fani | y> (these projects use components from ARM’s CMSIS v3.20 specification).
The MCUXpresso IDE does in some cases provide libraries based on early versions of the CMSIS
specification with names such as cvsi svip3o_<part fani I y>, but these are not recommended for use
in new projects.
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The CMSIS library option within the MCUXpresso IDE allows you to select which (if any) CMSIS-
CORE library you want to link to from the project you are creating. Note that you will need to
import the appropriate CMSIS-CORE library project into the workspace before the wizard will
allow you to continue.

For more information on CMSIS and its support in the MCUXpresso IDE, please see the FAQ at
https://community.nxp.com/message/630589

Note: The use of LPCOpen instead of CMSIS-CORE library projects is recommended in most
cases for new projects. (In fact LPCOpen actually builds on top of many aspects of CMSIS-
CORE.) For more details see Software drivers and examples [54]

CMSIS DSP Library Selection

ARM’s Cortex Microcontroller Software Interface Standard (or CMSIS) specification also
provides a definition and implementation of a DSP library. The MCUXpresso IDE provides
prebuilt library projects for the CMSIS DSP library for Cortex-M0/M0+, Cortex-M3 and Cortex-
M4 parts, although a source version of it is also provided within the MCUXpresso IDE Examples.

Note: The CMSIS DSP library can be used with both LPCOpen and non-LPCOpen projects.

Peripheral Driver Selection

For some parts, one or more peripheral driver library projects may be available for the target
MCU from within the Examples area of your MCUXpresso IDE installation. The non-LPCOpen
wizards allow you to create appropriate links to such library projects when creating a new project.
You will need to ensure that you have imported such libraries from the Examples before selecting
them in the wizard.

Note: The use of LPCOpen rather than these peripheral driver projects is recommended in most
cases for new projects.

Enable use of Floating Point Hardware

Certain MCUs may include a hardware floating point unit (for example NXP LPC32xx,
LPC407x_8x, and LPC43xx parts). This option will set appropriate build options so that code is
built to use the hardware floating point unit and will also cause startup code to enable the unit
to be included.

Code Read Protect

NXP’s Cortex based LPC MCUs provide a “Code Read Protect” (CRP) mechanism to prevent
certain types of access to internal flash memory by external tools when a specific memory location
in the internal flash contains a specific value. The MCUXpresso IDE provides support for setting
this memory location. See the section on Code Read Protection [87] for more information.

Enable use of romi vi de Library

Certain NXP Cortex-MO0 based MCUs, such as LPC11Axx, LPC11Exx, LPC11Uxx, and LPC12xx,
include optimized code in ROM to carry out divide operations. This option enables the use of
these Romdivide library functions. For more details see the FAQ at

https://community.nxp.com/message/630743

Disable Watchdog

Unlike most MCUs, NXP’s LPC12xx MCUs enable the watchdog timer by default at reset. This
option disables that default behavior. For more details, please see the FAQ at
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https://community.nxp.com/message/630654

LPC1102 ISP Pin

The provision of a pin to trigger entry to NXP’s ISP bootloader at reset is not hardwired on the
LPC1102, unlike other NXP MCUs. This option allows the generation of default code for providing
an ISP pin. For more information, please see NXP’s application note, AN11015, “Adding ISP to
LPC1102 systems”.

Redlib Printf Options

The “Semihosting C Project” wizard for some parts provides two options for configuring the
implementation of printf family functions that will get pulled in from the Redlib C library:

« Use non-floating-point version of printf
« If your application does not pass floating point numbers to print () family functions, you can
select a non-floating-point variant of printf. This will help to reduce the code size of your
application.
» For MCUs where the wizard does not provide this option, you can cause the same effect by
adding the symbol cr_I NTEGER PRI NTF tO the project properties.

¢ Use character- rather than string-based printf

e By default printf() and puts() make use of malioc() to provide a temporary buffer on the
heap in order to generate the string to be displayed. Enable this option to switch to using
“character-by-character” versions of these functions (which do not require additional heap
space). This can be useful, for example, if you are retargeting printf() to write out over a
UART —since in this case it is pointless creating a temporary buffer to store the whole string,
only to print it out over the UART one character at a time.

» For MCUs where the wizard does not provide this option, you can cause the same effect by
adding the symbol cr_prINTF_cHAR tO the project properties.

Note: if you only require the display of fixed strings, then using puts() rather than printf() will
noticeably reduce the code size of your application.

For more information see C/C++ Library Support [72]

Project Created

Having selected the appropriate options, you can then click on the Finish button, and the wizard
will create your project for you, together with appropriate startup code and a simple min. ¢ file.
Build options for the project will be configured appropriately for the MCU that you selected in
the project wizard.

You should then be able to build and debug your project, as described in Section 8.5 and
Chapter 9.
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8. Importing Example Projects (from the file sytem)

8.1

8.2
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MCUXpresso IDE supports two schemes for importing examples:

¢ From SDKs — see the QuickStart Panel -> Import SDK example(s). See Importing Examples
Projects (from SDK) [40]

¢ From the filing system — see the QuickStart Panel -> Import project(s) from file System
« this option is discussed below:

Note: This option can also be used to import projects exported from MCUXpresso IDE. See
Exporting Projects [57]

MCUXpresso IDE installs with a large number of example projects for pre-installed parts, that
can be imported directly into a workspace: These are located at:

<install _dir>\ide\Exanpl es

and consist of:

¢ CMSIS-DSPLIB
« asuite of common signal processing functions for use on Cortex-M processor based devices.
CodeBundles for LPC800 family

« which consist of software examples to teach users how to program the peripherals at a basic
level.

FlashDrivers

« example projects to create flash driver used by LinkServer

* Legacy

« arange of historic examples and drivers including CMSIS / Peripheral Driver Library
LPCOpen

< High quality board and chip support libraries for LPC MCUs, plus example projects

Code Bundles for LPC800 Family devices

The LPC800 Family of MCUs are ideal for customers who want to make the transition from 8
and 16-bit MCUs to the Cortex MO/MO+. For this purpose, we've created Code Bundles which
consist of software examples to teach users how to program the peripherals at a basic level. The
examples provide register level peripheral access, and direct correspondence to the memory
map in the MCU User Manual. Examples are concise and accurate explanations are provided
within the readmes and source file comments. Code Bundles for LPC800 family devices are
made available at the time of the series product launch, ready for use with a range of tools
including MCUXpresso IDE.

More information on code bundles together with latest downloads can be found at:

https://www.nxp.com/LPC800-Code-Bundles

LPCOpen Software Drivers and Examples

LPCOpen is an extensive collection of free software libraries (drivers and middleware) and
example programs that enable developers to create multifunctional products based on LPC
microcontrollers. Access to LPCOpen is free to all LPC developers.

Amongst the features of LPCOpen are:
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MCU peripheral device drivers with meaningful examples

« Common APIs across device families

« Commonly needed third party and open source software ports
Support for Keil, IAR and LPCXpresso/MCUXpresso IDE toolchains

LPCOpen is thoroughly tested and maintained. The latest LPCOpen software now available
provides:

* MCU family-specific download package

e Support for USB ROM drivers

« Improved code organization and drivers (efficiency, features)

¢ Improved support for the MCUXpresso IDE

CMSIS / Peripheral Driver Library / code bundle software packages are still available, from
within your MCUXpresso IDE install directory in \ide\Examples\Legacy . But generally, these
should only be used for existing development work. When starting a new evaluation or product
development, we would recommend the use of LPCOpen if available.

More information on LPCOpen together with package downloads can be found at:

http://www.nxp.com/lpcopen

8.3 Importing an Example Project

To import an example project from the file system, locate the QuickStart panel and select ‘Import
projects from Filesystem’

) Quickstart 52 Global Var Variables Breakpoint Outline = B

. MCUXpresso IDE (Pro Edition)
oe

- Start here
. MNew project...

(. Import SDK example(s)..
*

Import project(s) from file syslem‘.)

2 Quick Settings>>

o Build all projects ]

Figure 8.1. Importing project(s)

From here you can browse the file system.
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[ JoN ] Impaort project(s)

Import project(s) i o
Select the examples archive file to import. / /'

Projects are contained within archives (.zip) or are unpacked within a directory. Select your
project archive or root directory and press <Mext=. On the next page, select those projects you
wish to import, and press <Finishz.

Project archives for LPCOpen and 'legacy’ examples are provided.

Project archive {zip)

Archive \ Browse...

Project directory (unpacked)

Root directory Browse...

LPCOpen

LPCOpen is the recommended code base for Cortex-M based NXP LPC Micracontrollers.

MCUXpresso IDE includes the LPCOpen packages which can be imported directly by pressing the Browse
button in the Project archive (zip) section, above, and navigating to the Examples/LPCOpen directory.

Alternatively, press the button below to Browse the nxp.com website for latest resources.

Browse LPCOpen resources on nxp.com...

A
@ Cancel

Figure 8.2. Importing examples

8.3.1
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* Browse to locate Examples stored in zip archive files on your local system. These could
be archives that you have previously downloaded (for example LPCOpen packages from
http://www.nxp.com/Ipcopen or the supplied, but deprecated, sample code located within the
Examples/Legacy subdirectory of your MCUXpresso IDE installation).

* Browse to locate projects stored in directory form on your local system (for example, you can
use this to import projects from a different Workspace into the current Workspace).

« Browse LPCOpen resources to visit http://www.nxp.com/lpcopen and download an
appropriate LPCOpen package for your target MCU. This option will automatically open a web
browser onto a suitable links page.

To demonstrate how to use the Import Project(s) functionality, we will now import the LPCOpen
examples for the LPCXpresso4337 development board.

Importing Examples for the LPCXpresso04337 Development Board

First of all, assuming that you have not previously downloaded the appropriate LPCOpen
package, click on Browse LPCOpen Resources, which will open a web browser window. Click
on LPC4300 Series, and then locate NXP LPCXpresso04337, and then download 2.xx version
for LPCXpresso Tookchain (LPCOpen packages created for LPCXpresso IDE are compatible
with MCUXpresso IDE).

Note: LPCOpen Packages for the LPC4337 are pre-installed and located at:

<instal |l _dir>\ide\ Exanpl es\ LPCOpen\. ..

Once the package has downloaded, return to the Import Project(s) dialog and click on the Browse
button next to Project archive (zip); then locate the LPCOpen LPCXpresso4337 package
archive previously downloaded. Select the archive, click Open and then click Next. You will then
be presented with a list of projects within the archive, as shown in Figure 8.3.
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Figure 8.3. Selecting projects to import

[ BON Import project(s)
Import project(s) r
¢ Select a directory to search for existing Eclipse projects. / ;4
Projects:
freertos_blinky (freertos_blinky) Select All
lib_lpespifilib {lib_lpcspifilib)
Ipc_board_nxp_lpcxpresso_4337 (lpe_board_nxp_lpcxpresso_4337) Deselect All
Ipc_board_nxp_lpcxpresso_4337_m0 (lpc_board_nxp_lpcxpresso_4337 _n
1 Ipc_chip_43xx (lpc_chip_43xx) Refresh
Ipc_chip_43xx_m0 {Ipc_chip_43xx_mO0)
LPCUSBIib_AudioOutputHost (LPCUSBIib_AudioOutputHost)
LPCUSBIib_KeyboardHost (LPCUSBIib_KeyboardHost)
LPCUSBIlib_MassStorageHost (LPCUSBIlib_MassStorageHost)
LPCUSBIib_SerialHost (LPCUSBIib_SerialHost)
Iwip_freertos_tcpecho (lwip_freertos_tcpecho)
Iwip_ freertos webserver (lwip freertos webserver)
{ . |
Options
| [ |
a
Working sets
Add project to working sets
Working sets: <
@ < Back cancel | (EEEINN

8.4
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Select the projects you want to import and then click Finish. The examples will be imported into
your Workspace.

Note: generally, it is a good idea to leave all projects selected when doing an import from a zip
archive file of examples. This is certainly true the first time you import an example set, when you
will not necessarily be aware of any dependencies between projects. In most cases, an archive
of projects will contain one or more library projects, which are used by the actual application
projects within the examples. If you do not import these library projects, then the application
projects will fail to build.

Exporting Projects

MCUXpresso IDE provides the following export options from the QuickStart panel:

¢ Export project(s) to archive (zip)
« Export prokect(s) and references to archive (zip)
« choose this option to export project(s) and automatically also export referenced libraries

To export one or more projects, first select the project(s) in the Project Explorer then from the

QuickStart Panel -> Export project(s) to archive (zip). This will launch a filer window. Simply
select the destination and enter a name for the archive to be exported then click ‘OK’.
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8.5 Building Projects

Building the projects in a workspace is a simple case of using the Quickstart Panel to “Build all
projects”. Alternatively, a single project can be selected in the ‘Project Explorer’ View and built.
Note that building a single project may also trigger a build of any associated library projects.

8.5.1 Build Configurations

By default, each project will be created with two different “build configurations”: Debug and
Release. Each build configuration will contain a distinct set of build options. Thus a Debug build
will typically compile its code with optimizations disabled ( - ) and Release will compile its code
optimizing for minimum code size ( -cs). The currently selected build configuration for a project
will be displayed after its name in the QuickStart Panel's Build/Clean/Debug options.

For more information on switching between build configurations, see How do | switch between
Debug and Release builds? [117]
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9. Debugging a Project

9.1
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This chapter shows how a simple debug session should be performed on an example application/
project. The details below are common to all supported debug solutions. Refer to the chapter
Debug Solutions Overview [10] for more details of supported debug solutions and management
of debug operations.

Debugging overview

The debug chain usually starts with a debug probe USB connection to the host computer
(although IP probes from P&E and SEGGER are also supported). Some debug probes such as
LPC-Link2 or SEGGER J-Link Plus are separate physical devices, however many LPCXpresso,
Freedom and Tower boards also incorporate a built in debug probe.

Note: If a separate debug probe is used, you must ensure that the appropriate cables are used
to connect the probe to the target, and that the target is powered.

Note: Some LPCXpresso development boards have two USB connectors fitted. Make sure that
you have connected the lower connector marked DFU-Link.

Note: Many Freedom and Tower boards also have two USB connectors fitted. Make sure that
you have connected to the one marked ‘OpenSDA’ - this is usually (but not always) marked on
the board. If in doubt, the debug processor used on these designs is a Kinetis K20 MCU, it is
aproximately 6mm square. The USB nearest this MCU will be the OpenSDA connection.

To start debugging a project on your target MCU, simply highlight the appropriate project in
the ‘Project Explorer’, and then in the Quickstart Panel click on Debug 'Project Name', as in

Figure 9.1, alternatively click the blue bug icon 1o perform the same action.

Note: The green bug icon should not be used because this invokes the standard Eclipse debug
operation and so skips certain essential MCUXpresso IDE debug steps.

By default, this operation will first build the project and (assuming there is no build error), launch
a debug probe discovery operation (see next section).
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Figure 9.1. Launching a debug session

) Quickstart P 23 Global Variab Variables Breakpoints Outline = 8
. MCUXpresso IDE (Pro Edition)
IDE

~ Start here
. MNew project...
. Import SDK example(s)...
® Import project(s) from file system...

&, Build 'frdmk64f_driver_examples_gpio_led_output' [Debug]

e Debug 'frdmkB4f_driver_examples_gpio_led_output' [Debug]

B Edit 'frdmk64f_driver_examples_gpio_led_output' project settings
 Quick Settings>>

,@ Export projects to archive (zip)

JE Export projects and references to archive (zip)

o Build all projects [Debug]

9.11
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Note: Previously debugged projects will contain launch configuration files. Please see the section
A note about Launch Configuration files [11] for more information.

Once a debug probe has been selected (and ‘OK’ clicked) the binary contents of the .axf file will
automatically be downloaded to the target via the debug probe connection. Typically, projects
are built to target MCU flash memory, and in these cases, a suitable flash driver will automatically
be selected to perform the flash programming operation. Next a default breakpoint will be set on

the first instruction in mai n() , the application will be started (by simulating a processor reset), and
code will be executed until the default breakpoint is hit.

Debug Probe Selection Dialog

The first time you debug a project, the Debug Probe Discovery Dialogue will be displayed. This
will show all supported probes that are attached to your computer. In the example shown in

Figure 9.2, a LinkServer (LPC-Link2), a P&E Micro Multilink and also a J-Link (OpenSDA) probe
have been found.
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[ JON ] Probes discovered
Connect to target: MK64FN IMOxxx12

3 probes found. Select the probe to use:

| Available attached probes

: Name Serial number/ID Tvpe Manufactur IDE Debug Mode
| . LPC-LINK2 CMSIS-DAP V5.18 IWFUATEW LinkServe NXP Semi Non-Stop

| Eﬂ USB1 - Multilink Universal Rev PEMB34663 USB1 P&E Micre All-Stop

| ﬂ J-Link OpenSDA 621000000 usB SEGGER All-Stop

Supported Probes {tick/untick to enable/disable)

| MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes
P&E Micro probes
SEGGER J-Link probes

Probe search options

Search again

Remember my selection (for this Launch configuration)

"
@ Cancel

Figure 9.2. Attached probes: debug emulator selection

MCUXpresso IDE supports unique debug probe association.

Debug probes can return an ID (Serial number) that is used to associate a particular debug
probe with a particular project. Some debug probes will always return the same ID, however
debug probes such as the LPC-Link2 will return a unique ID for each probe — in our example
IWFUAL1EW.

For any future debug sessions, the stored probe selection will be automatically used to match the
project being debugged with the previously used debug probe. This greatly simplifies the case
where multiple debug probes are being used.

However, if a debug operation is performed and the previously remembered debug probe cannot
be found, then a debug probe discovery operation will be performed for within the same family
e.g. LinkServer, P&E or SEGGER.
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[ ] [ ] Probes discovered
Connect to target: LinkServer

€ LinkServer not found.
This could be because it is disconnected, not powered, or already in use

Available attached probes

Namea Serial number/1D Type Manufactur IDE Debug Mode

Supported Probes {tick/untick to enable/disable)
MCUXpresso |IDE LinkServer (inc. CMSIS-DAP) probes

Probe search options

Search for LinkServer again Search for any enabled probe

':?3' Cancel

Figure 9.3. LPC-Link2 no longer connected
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This might have been because you had forgotten to connect the probe, in which case simply
connect it to your computer and select Search again. If you are using a different debug probe
from the same family of debug probes, simply select the new probe and this will replace the
previously selected probe.

Notes:

« The “Remember my selection” option is enabled by default in the Debug Emulator Selection
Dialog, and will cause the selected probe to be stored in the launch configuration for the current
configuration (typically Debug or Release) of the current project. You can thus remove the
probe selection at any time by simply deleting the launch configuration.

* You will need to select a probe for each project that you debug within a Workspace (as well
as for each configuration within a project).

« If you wish to debug a project using a different family of debug probe, then the simplest option is
to delete the launch configuration files associated with the project and start a debug operation.
Please see the section A note about Launch Configuration files [11] for more information.

Controlling Execution

When you have started a debug session a default breakpoint is set on the first instruction in
mai n() , the application is started (by simulating a processor reset), and code is executed until the
default breakpoint is hit.

Program execution can now be controlled using the common debug control buttons, as listed

in Table 9.1, which are displayed on the global toolbar. The call stack is shown in the Debug
View, as in Figure 9.4,
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00 MR R I EBRRR S L L HF0Q &®B P
%5 Debug 53
T.frd mkE4f_driver_examples_gpio_led_output Debug [C/C++ (NXP Semiconductors) MCU Application]
¥ T frdmkB4f_d river_examples_gpio_led_output.axf [MKBAFN1MOxxx12 {cortex-md}]
¥ o Thread #1 1 (Stopped) (Suspended : Signal : SIGINT:Interrupt)
= delay{) at gpio_led_output.c:64 Ox7fc

= main(} at gpio_led_output.c:92 0xB52
g arm-none-eabi-gdb (7.12.0.20161204)

Figure 9.4. Debug controls and Debug Call Stack

Table 9.1. Program execution controls

Button Description Keyboard Shortcut
& Restart program execution (from reset)

i Run/Resume the program F8

i Pause Execution of the running program

Terminate the debug Session Ctrl + F2
e =) Run, Pause, Terminate all debug sessions

2 Step over a C/C++ line F6

= Step into a function F5

@ Return from a function F7

e Step in, over, out all debug sessions

= Show disassembled instructions

Note: The debug controls for ‘all’ debug sessions will perform identically to their single session
counterparts if only one debug session exists.

Note: Typically a user will only have a single active debug session. However if there is more
than one debug session, the active session can be chosen by clicking within the debug call stack
within the debug pane.

Setting a breakpoint

To set a breakpoint, simply double-click on the left margin area of the line on which you wish to
set the breakpoint (before the line number).

Restarting the application

If you hit a breakpoint or pause execution and want to start execution of the application from the
beginning again, you can do this using the Restart button.

Stopping debugging
To stop debugging just press the Stop button.

If you are debugging using the Debug Perspective, then to switch back to the C/C++
Perspective when you stop your debug session, just click on the C/C++ tab in the upper right
area of the MCUXpresso IDE (as shown in Figure 2.2).

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2017 NXP Semiconductors. All rights reserved.

User Guide Rev. 10.0 — 21 March, 2017 63




NXP Semiconductors MCUXpresso IDE User Guide

10. LinkServer Flash Support

MCUXpresso IDE’s LinkServer based debug connections makes use of a RAM loadable flash
driver mechanism. Such a flash driver contains the knowledge required to program the internal
flash on a particular MCU (or potentially, family of MCUSs). This knowledge may be either prebuilt
into the driver, or some of it may be determined by the driver as it starts up (typically known as
a “generic” flash driver).

At the time the debug connection is started from within the MCUXpresso IDE, the LinkServer
debug session running on the host will typically download a flash driver into RAM on the target
MCU. It will then communicate with the downloaded flash driver via the debug probe in order to
program the required code and data into the flash memory.

In addition, the loadable flash driver mechanism also provides the ability to produce flash drivers
which can be used to program external flash memory (for instance via the SPIFI flash memory
interface on LPC18x, LPC40xx, LPC43xx and LPC5460x families). The sources for some of
these drivers is provided in the Examples/Flashdrivers subdirectory within the MCUXpresso IDE
installation directory.

LinkServer flash drivers have a .cfx file extension. For Preinstalled MCUs, the flash driver used for
each part/family will be located in the /bin/Flash subdirectory of the MCUXpresso IDE installation.
For SDK installed MCUs, the flash driver will generally be supplied within the SDK, though
versions are also provided in the /bin/Flash subdirectory too.

10.1 Default vs Per-Region Flash drivers

By default, for legacy reasons, Preinstalled MCUs are configured to use what is called a “Default”
flash driver. This means that this flash driver will be used for all Flash memory blocks that are
defined for that MCU (i.e. as displayed in the Memory Configuration Editor).

For most users, there is never any need to change the automatically selected flash driver for the
MCU being debugged.

However, MCUXpresso IDE also supports the creation and programming of projects that span
multiple flash devices. In order to allow this to work, flash drivers can also be specified per-region.

For example, this allows a project based on an LPC43xx device with internal flash to also make
use of external SPIFI flash device. This is achieved by removing the default flash driver from
the memory configuration and instead explicitly specifying the flash driver to use for each flash
memory block (per-region flash drivers). A typical use case could be to create an application to
run from the MCU'’s internal flash that makes use of static constant data (e.qg. for graphics) stored
in external SPIFI device.

Note: SDK installed MCUs are always defined using Per-Region flash drivers.

10.2 Special case Flash drivers for LPC MCUs

For most projects, the selection of a flash driver is automatically performed by the Project wizard,
however for some MCUs some user intervention may be required.

10.2.1 LPC18xx / LPC43xx Internal Flash Drivers

A number of LPC18/43 parts provide dual banks of internal flash, with bank A starting at address
0x1A000000, and bank B starting at address 0x1B000000.

* LPC18x3/ LPC43x3 : Flash 2x 256KB (512 KB total)
* LPC18x5/ LPC43x5 : Flash = 2x 384KB (768 KB total)
* LPC18x7/LPCA3x7 : Flash = 2x 512KB ( 1 MB total)
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10.2.2

When you create a new project using the New Project Wizard for one of these
parts, an appropriate default flash driver (from LPC18x3_43x3_2x256_BootA.cfx /
LPC18x5_43x5_2x384 BootA.cfx /LPC18x7_43x7_2x512_ BootA.cfx) will be selected which
after programming the part will also configure it to boot from Bank A flash.

If you wish to boot from Bank B flash instead, then you will need to manually configure
the project to use the corresponding “BootB” flash driver ( LPC18x3_43x3_2x256_BootB.cfx /
LPC18x5_43x5 2x384 BootB.cfx / LPC18x7_43x7_2x512_ BootB.cfx). This can be done by
selecting the appropriate driver file in the “Flash driver” field of the Memory Configuration Editor.
Note: you will also need to delete Flash Bank A from the list of available memories (or at least
reorder so that Flash Bank B is first).

SPIFI Flash Drivers

A number of LPC parts provide support for external SPIFI flash, usually in addition to internal
flash. Programming these flash memories provides a number of challenges because the size of
memory (if present) is unknown, and the actual memory device is also unknown. These issues
are handled using Generic Drivers which can interrogate the memory device to find its size and
programming requirements.

At the time of writing, these LPC devices comprise:

Table 10.1. SPIFI details

LPC Part SPIFI Address Bootable Flash Driver
LPC18xx/LPC43xx  0x14000000 Yes LPC18_43_SPIFI_GENERIC.cfx
LPC40xx 0x28000000 No LPC40xx_SPIFI_GENERIC.cfx
LPC5460x 0x10000000 No LPC546x_SPIFI_GENERIC.cfx
During a programming operation, the flash driver will interrogate the SPIFI flash device to identify
its configuration. If the device is recognised, its size and name will be reported in the MCUXpresso
IDE Debug log - as below:
I nspected v.2 External Flash Device on SPl using SPIFl |ib LPC18_43_SPI Fl _GENERI C. cf x
| mage ' LPC18/43 Generic SPIFI Mar 7 2017 13:14:25'
Openi ng flash driver LPC18_43_SPI FI _GENERI C. cf x
flash variant ' MX25L8035E' detected (1MB = 16*64K at 0x14000000)
Note: Although the flash driver reports the size and location of the SPIFI device, the IDE’s view
of the world is determined by the project memory configuration settings. It remains the users
responsibility to ensure these setting match the actual device in use.
10.3 Configuring projects to span multiple flash devices
https://community.nxp.com/thread/388979
10.4 Kinetis Flash Drivers
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Kinetis MCUs make use of a range of generic drivers, which are supplied as part of the SDK
part support package. When a project is created or imported, the appropriate flash driver is
automatically selected and associated with the project.

Kinetis flash drivers follow a simple namimg convention i.e. FTFx_nK_xx where:

¢ FTFx is the flash module name of the MCU, where x can take the value E, A or L
« nK represents the flash sector size the flash device supports, where n can take the value 1,
2,4,8
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* a sector size is the smallest amount of flash that can be erased on that device

¢ XX is an optional suffix for special case drivers e.g. __Tiny for use on parts with a small quantity
of RAM

So for example a K64F MCU's flash driver will be called FTFE_4K, because the K64F MCU uses
the FTFE flash module type and support a 4KB flash sector size.

When a debug session is started that programs data into flash memory, the IDE’s debug log file
will report the flash driver used and parameters it has read from the MCU. Below we can see
the driver identifled a K64 part and the size of the internal Flash available. It also reports the
programming speed achieved when programming this device. These logs can be useful when
problems are encountered.

Note: when the flash driver starts up, it will interogate the MCU and report a number of data
items. However, due to the nature of internal registers with the MCU, these many not exactly
match the MCU being debugged.

Probe Firnware: LPC-LINK2 CMVSI S-DAP V5. 181 (NXP Semi conduct or s)
Serial Nunmber: |WUALEW

VID:PID: 1FC9: 0090

USB Path: USB_1fc9 0090 14131100 ff 00

Probe(0): Connected&Reset. Dpl D: 2BA01477. Cpul D. 410FC240. I|nfo: <None>
Debug protocol: SWD. RTCK: Disabl ed. Vector catch: Disabled.
Inspected v.2 On chip Kinetis Flash nenory nodul e FTFE_4K. cf x

I mage 'Kinetis Sem Generic Feb 17 2017 17:24:02'

Openi ng flash driver FTFE_4K. cf x

flash variant 'K64 FTFE Generic 4K detected (1MB = 256*4K at 0x0)
Closing flash driver FTFE_4K. cfx

NXP:  MK64FN1MDxxx12

Connect ed: was_reset=true. was_stopped=true

MCUXpr essoPro Full License - Unlimted

Awai ting telnet connection on port 3331 ...

GDB nonst op node enabl ed

Opening flash driver FTFE_4K. cfx (al ready resident)

Witing 26732 bytes to address 0x00000000 in Flash

Erased/ Wote page 0-6 with 26732 bytes in 285nsec

Closing flash driver FTFE_4K. cfx

Fl ash Wite Done

Fl ash Program Sunmary: 26732 bytes in 0.28 seconds (91.60 KB/ sec)

Flash drivers for a number of Kinetis MCUs are listed below:

K64F FTFE_4K (1MB)

K22F FTFA_2K (512KB)
KL43 FTFA_1K (256KB)
KL27 FTFA_1K (64KB)
K40  FTFL_2K (256KB)

Using the LinkServer flash programmer

As well as supporting the programming of flash when starting a debug session, the flash
programming capabilities of LinkServer can also be accessed directly, both via the GUI and from
the command line. This might be useful, for instance, in carrying out small production runs.
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10.5.1 The GUI flash programmer
The flash programming utility, which is invoked automatically when you launch a debug session,
can also be accessed at other times within the MCUXpresso IDE environment by clicking on the
“Program Flash” icon on the toolbar at the top of the IDE window....
Q- Y& S - A= [E
LinkServer GUI Flash programmer

This button provides access to 3 distinct flash programming operations:
1. Programming an .axf or .bin file
2. Flash Mass Erase
3. Kinetis Flash Recovery
The behaviour of these 3 operations can be modified by a common set of self describing check
boxes.
Before clicking on the “Program Flash” icon, ensure that you have a project selected in the Project
Explorer pane which is configured for the MCU that you are going to program. This will ensure
that appropriate configuration options for the flash programmer are set correctly. Alternatively,
you can directly select a .bin or .axf file within a project, the flash programming tool will then also
pick up the appropriate filename.
Note: These features are for LinkServer connections only so only LinkServer compatible debug
probes will be used. Each use of the GUI flash programmer will be proceeded by a Debug Probe
Discovery process.
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Programming an .axf or .bin file

[ ] LinkServer GUI Flash programmer
Program Flash using DAPLink CMSIS-DAP
Program target Flash (NXP MKL28Z512xxx7)

Options

Display progress log Reopen on completion

Repeat on completion Aun flash command and copy to clipbeard

Just copy flash command to clipboard Confirm command before executing
Connection Options
Use JTAG interface

Additional options

LinkServer connect script Browse.
Flash Driver
Flash driver <Default> Browse...
Group
_ Erase flash memory | Resurrect locked Kinetis device|
Select file Browse

IGase address )

Reset target on completion

Erase Options

' Mass erase © Erase only required sectors

From this view you can select a .axf or .bin file to be programmed. Note: for a bin file you must
also provide an appropriate base address. The utility will inherit the flash driver from the projects
configuration or alternatively a different flash driver can be selected.
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Flash Mass Erase

LinkServer GUI Flash programmer
Program Flash using DAPLink CMSIS-DAP
| Program target Flash (NXP MKL282512xxx7)

Options
Display progress log | Aeopen on completion
| Aepeat on completion | Aun flash command and copy to clipboard

| Just copy flash command to clipboard | | Confirm command before executing

Connection Options
| Use JTAG interface

Additional options

LinkServer connect script Browse

Flash Driver

Flash driver <Default>

Browse...

Group

Program flash memory _ Resurrect locked Kinetis device|

Algorithm

© Mass erase | Erase by sector

On occasion it can be useful to completely erase the memory on a flash device. The utility will
inherit the flash driver from the projects configuration or alternatively a different flash driver can be
selected. The mass erase option with the flash driver will be used to perform the erase operation.
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Kinetis Flash Recovery

O LinkServer GUI Flash programmer
Program Flash using DAPLink CMS5I5-DAP
Program target Flash (NXP MKL28Z512xxx7)

Options

Display progress log Reopen on completion
Repeat on completion Aun flash command and copy to clipboard
Just copy flash command to clipboard Confirm command before executing

Connection Options
Use JTAG interface

Additional options

LinkServer connect script ( Kinetismasserase.scp n Browse... )
Flash Driver

Flash driver <Default> n Browse...
Group

Program flash memory | Erase flash memory _—

The referenced connect script will attempt to unlock a Kinetis MCU by restoring
the Flash Configuration field at offset 0x400.

( Resurrect Kinetis board )

cancel | (TSN

This operation is designed to recover Kinetis MCUs whose flash devices have become ‘secured’.
A secured MCU cannot be programmed by a normal flash programming operation.

Should this occur, simply check the box labeled ‘Resurrect Kinetis Board’, this will populate the
Connect Script field with a kinetismasserase.scp script and click ‘OK’. This will cause a script to
be run that will attempt to recover the flash device.

Note: Should this process fail to recover the part, an alternate script called kinetisunlock.scp may

be successful. This alternate script must be manually selected via the Connecct Script Browse
button.

10.5.2 The command line flash programmer

Flash programming is usually invoked automatically when you launch a debug session from
within the MCUXpresso IDE, but can also be accessed directly using a command line utility. This
can be useful for things like programming the flash for devices with limited production runs.

The MCUpresso IDE flash programming stubs are located at:

<install _dir>/ide/bin/
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To run a flash programming operation from the command line, the correct flash utility stub for
your part should be called with appropriate options. For example:

crt_emu_cmredlink -flash-1oad-exec "LPC11U68_App. axf" -vendor=NXP - pLPC11U68

Note: A simple way of finding the correct command and options, is to use the GUI flash
programmer described above, the completion dialog shows the exact command line invoked by
the GUIL.

The flash programming utility takes the following options:

crt_emu_cmredlink -ptarget -vendor=NXP -flash-|oad[-exec] "filename" [-|oad-base=base_address] [-flash-driver

« target is the target chip name. For example LPC1343, LPC1114/301, LPC1768 etc.

« filename is the file to flash program. It may be an executable (axf) or a binary (bin) file. If using
a binary file, the base_address also must be specified.

« base_address is the address where the binary file will be written. It should be specified as a
hex value with a leading Ox.

« flashdriver for parts with external flash, a flash driver can be specified, see LPC18 / LPC43
External Flash Drivers for more information.
« -flash-load will leave the processor in a stopped state.
 -flash-load-exec will start execution of application as soon as download has completed.
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11. C/C++ Library Support
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MCUXpresso IDE ships with three different C/C++ library families. This provides the maximum
possible flexibility in balancing code size and library functionality.

Overview of Redlib, Newlib and NewlibNano

¢ Redlib Our own (non-GNU) ISO C90 standard C library, with some C99 extensions.
¢ Newlib GNU C/C++ library
* NewlibNano a version of the GNU C/C++ library optimized for embedded.

By default, MCUXpresso IDE will use Redlib for C projects, NewlibNano for SDK C++ projects,
and Newlib for C++ projects for preinstalled MCUs.

Newlib provides complete C99 and C++ library support at the expense of a larger (in some cases,
much larger) code size in your application.

NewlibNano was produced as part of ARM's “GNU Tools for ARM Embedded Processors”
initiative in order to provide a version of Newlib focused on code size. Using NewlibNano can
help dramatically reduce the size of your application compared to using the standard version of
Newlib — for both C and C++ projects.

If you need a smaller application size and don’t need the additional functionality of the C99 or C+
+ libraries, we recommend the use of Redlib, which can often produce much smaller applications.

Redlib extensions to C90

Although Redlib is basically a C90 standard C library, it does implement a number of extensions,
including some from the C99 specification. These include:

« Single precision math functions

» Single precision implementations of some of the math.h functions such as sinf() and cosf()
are provided.

 stdbool.h
* An implementation of the C99 stdbool.h header is provided.
* itoa
« itoa() is non-standard library function which is provided in many other toolchains to convert

an integer to a string. To ease porting, an implementation of this function is provided,
accessible via stdlib.h. More details can be found later in this chapter.

Newlib vs NewlibNano

Differences between Newlib and NewlibNano include:

* NewlibNano is optimized for size.

¢ The printf and scanf family of routines have been re-implemented in NewlibNano to remove
a direct dependency on the floating-point input/output handling code. Projects that need to
handle floating-point values using these functions must now explicitly request the feature
during linking.

e The printf and scanf family of routines in NewlibNano support only conversion specifiers
defined in C89 standard. This provides a good balance between small memory footprint and
full feature formatted input/output.

* NewlibNano removes the now redundant integer-only implementations of the printf/scanf
family of routines (iprintf/iscanf, etc). These functions now alias the standard routines.

« In NewlibNano, only unwritten buffered data is flushed on exit. Open streams are not closed.
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« In NewlibNano, the dynamic memory allocator has been re-implemented

Library variants

Each C library family is provided in a number of different variants : None, Nohost and Nohost-nf,
Semihost and Semihost-nf (Redlib only). These variants each provide a different set of ‘stubs’
that form the very bottom of the C library and include certain low-level functions used by other
functions in the library.

Each variant has a differing set of these stubs, and hence provides differing levels of functionality:

¢ Semihost
 This library variant provides implementation of all functions, including file I1/0. The file 1/O will
be directed through the debugger and will be performed on the host system (semihosting).
For example, printf/scanf will use the debugger console window and fread/fwrite will operate
on files on the host system. Note: emulated I/O is relatively slow and can only be used when
debugging.
¢ Semihost-nf (no files)
» Redlib only. Similar to Semhost, but only provides support for the 3 standard built-in streams
— stdin, stdout, stderr. This reduces the memory overhead required for the data structures
used by streams, but means that the user application cannot open and use files, though
generally this is not a problem for embedded applications.
* Nohost and Nohost-nf
* This library variant provides the string and memory handling functions and some file-based
I/O functions. However, it assumes that you have no debugging host system, thus any file
I/O will do nothing. However, it is possible for the user to provide their own implementations
of some of these 1/O functions, for example to redirect output to the UART.
* None
e This has literally no stub and has the smallest memory footprint. It excludes low-level
functions for all file-based 1/0 and some string and memory handling functions.

In many embedded microcontroller applications it is possible to use the None variant by careful
use of the C library, for instance avoiding calls to printf().

If you are using the wrong library variant, then you will see build errors of the form:

* Linker error "Undefined reference to ‘xxx

For example for a project linking against Redlib(None) but using printf() :

..libcr_c.a(fpprintf.o): In function “printf':

fpprintf.c:(.text.printf+0x38): undefined reference to ~__sys wite'
fpprintf.c:(.text.printf+0x4c): undefined reference to ~__Ci ob'
...libcr_c.a(_deferredl azyseek.o0): In function ~_ flsbuf':

_deferredl azyseek.c: (.text.__flsbuf+0x88): undefined reference to ~__sys_istty'

...libcr_c.a(_witebuf.o): In function ~_Cwitebuf':

_writebuf.c:(.text._Owitebuf+0x16): undefined reference to "_ sys flen'
_writebuf.c:(.text._Owitebuf+0x26): undefined reference to ~__ sys_seek’
_writebuf.c:(.text._Owritebuf+0x3c): undefined reference to ~__sys wite'

...libcr_c.a(alloc.0): In function ~_Csys_alloc':
alloc.c:(.text._Csys_all oc+0Oxe): undefined reference to ~__sys wite'
alloc.c:(.text._Csys_all oc+0x12): undefined reference to ~__sys_appexit'
...libcr_c.a(fseek.0): In function "fseek':

fseek.c: (.text.fseek+0Ox16): undefined reference to ~__sys_istty'

fseek.c: (.text.fseek+Ox3a): undefined reference to ~__sys_flen'

Or if linking against NewlibNano(None):
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...libc_nano.a(lib_a-witer.o0): In function ~_wite_r":
witer.c:(.text._wite_r+0x10): undefined reference to "~_wite'
...libc_nano.a(lib_a-closer.o0): In function *_close_r":
closer.c:(.text._close_r+0xc): undefined reference to " _close'
...libc_nano.a(lib_a-lseekr.o0): In function "~ _lseek_r":

| seekr.c: (.text._| seek_r+0x10): undefined reference to " _I seek’
...libc_nano.a(lib_a-readr.o): In function *_read_r"':

readr.c: (.text._read_r+0x10): undefined reference to "_read
...libc_nano.a(lib_a-fstatr.o): In function *_fstat_r":
fstatr.c:(.text._fstat_r+0xe): undefined reference to ~_fstat’
...libc_nano.a(lib_a-isattyr.o): In function "~ _isatty r':
isattyr.c:(.text._isatty_r+0xc): undefined reference to *_isatty'

In such cases, simply change the library hosting being used (as described below), or remove the
call to the triggering C library function.

Switching the selected C library

Normally the library variant used by a project is set up when the project is first created by the
New Project Wizard. However it is quite simple to switch the selected C library between Redlib,
Newlib and NewlibNano, as well as switching the library variant in use.

To switch, highlight the project in the Project Explorer view and go to:
Quickstart -> Quick Settings -> Set library/header type

and select the required library and variant.

Manually switching
Alternatively, you can make the required changes to your project properties manually as follows...

When switching between Newlib(Nano) and Redlib libraries you must also switch the headers
(since the 2 libraries use different header files). To do this:

1. Select the project in Project Explorer

2. Right-click and select Properties

3. Expand C/C++ Build and select Settings
4

. In the Tools settings tab, select Miscellaneous under MCU C Compiler. Note: Redlib is not
available for C++ projects

. In Library headers, select Newlib or Redlib
6. In the Tools setting tab, select Architecture & Headers under MCU Assembler
7. In Library headers, select Newlib or Redlib

(€2}

Repeat the above sequence for all Build Configurations (typically Debug and Release).

To then change the libraries actually being linked with (assuming you are using Managed linker
scripts):

1. Select the project in Project Explorer

. Right-click and select Properties

. Expand C/C++ Build and select Settings

. In the Tools settings tab, select Managed Linker Script under MCU Linker

. In the Library drop-down, select the Newlib, NewlibNano or Redlib library variant that you
require (None, Nohost, Semihost, Semihost-nf).

a b~ wWwN
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Again repeat the above sequence for all Build Configurations (typically Debug and Release).
Note: Redlib is not available for C++ projects.

What is Semihosting?

Semihosting is a term to describe application 10 via the debug probe. For this to operate, library
code and debug support are required.

Background to Semihosting

When creating a new embedded application, it can sometimes be useful during the early stages
of development to be able to output debug status messages to indicate what is happening as
your application executes.

Traditionally, this might be done by piping the messages over, a serial cable connected to a
terminal program running on your PC. The MCUXpresso IDE offers an alternative to this scheme,
called semihosting. Semihosting provides a mechanism for code running on the target board to
use the facilities of the PC running the IDE. The most common example of this is for the strings
passed to a printf being displayed in the IDE’s console view.

The term “semihosting” was originally termed by ARM in the early 1990s, and basically indicates
that part of the functionality is carried out by the host (the PC with the debug tools running on
it), and partly by the target (your board). The original intention was to provide 1/O in a target
environment where no real peripheral-based 1/0O was available at all.

Semihosting implementation

The way it is actually implemented by the tools depends upon which target CPU you are running
on. With Cortex-M based MCUs, the bottom level of the C library contains a special BKPT
instruction. The execution of this is trapped by the debug tools which determine what operation
is being requested — in the case of a printf, for example, this will effectively be a “write character
to stdout”. The debug tools will then read the character from the memory of the target board —
and display it in the console window within the IDE.

Semihosting also provides support for a number of other 1/0O operations (though this relies upon
your debug probe also supporting them)... For example it provides the ability for scanf to read its
input from the IDE console. It also allows file operations, such that fopen can open a file on your
PC's hard drive, and fscanf can then be used to read from that file.

Semihosting Performance

It is fair to say that the semihosting mechanism does not provide a high performance 1/O system.
Each time a semihosting operation takes place, the processor is basically stopped whilst the data
transfer takes place. The time this takes depends somewhat on the target CPU, the debug probe
being used, the PC hardware and the PC operating system. But it takes a definite period of time,
which may make your code appear to run more slowly.

Important notes about using semihosting

When you have linked with the semihosting library, your application will no longer work
standalone — it will only work when connected to the debugger.

Semihosting operations cause the CPU to drop into “debug state”, which means that for the
duration of the data transfer between the target and the host PC no code (including interrupts) will
get executed on the target. Thus if your application uses interrupts, then it is normally advisable to
avoid the use of semihosting whilst interrupts are active — and certainly within interrupt handlers
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themselves. If you still need to use printf, then you can retarget the bottom level of the C library to
use an alternative communication channel, such as a UART or the Cortex-M CPU’s ITM channel.

Semihosting Specification

The semihosting mechanism used within MCUXpresso IDE is based on the specification
contained in the following document available from ARM'’s website... => ARM Developer Suite
(ADS) v1.2 Debug Target Guide, Chapter 5. Semihosting

Use of printf

By default, the output from printf() (and puts()) will be displayed in the debugger console via the
semihosting mechanism. This provides a very easy way of getting basic status information out
from your application running on your target.

For printf() to work like this, you must ensure that you are linking with a “semihost” or “semihost-
nf” library variant.

Note that if you only require the display of fixed strings, then using puts() rather than printf() will
noticeably reduce the code size of your application.

Redlib printf variants

Redlib provides the following two variants of printf. Many of the MCUXpresso New project wizards
provide options to select which of these to use when you create a new project.

Character vs String output

By default printf() and puts() functions will output the generated string at once, so that a single
semihosted operation can output the string to the console of the debugger. Note that these
versions of printf() /puts() make use of malloc() to provide a temporary buffer on the heap in order
to generate the string to be displayed.

It is possible to switch to using “character-by-character” versions of these functions (which do
not require additional heap space) by specifying the build define “CR_PRINTF_CHAR” (which
should be set at the project level). This can be useful, for example, if you are retargeting printf()
to write out over a UART (as detailed below)- as in this case it is pointless creating a temporary
buffer to store the whole string, only to then print it out over the UART one character at a time

Integer only vs full printf (including floating point)

The printf() routine incorporated into Redlib is much smaller than that in Newlib. Thus if code
size is an issue, then always try to use Redlib if possible. In addition if your application does
not pass floating point numbers to printf, you can also select a “integer only” (non-floating point
compatible) variant of printf. This will reduce code size further.

To enable the “integer only” printf from Redlib, define the symbol “CR_INTEGER_PRINTF” (at
the project level). This is done by default for projects created from the SDK new project wizard.

NewlibNano printf variants

By default, NewlibNano uses non-floating point variants of the printf and scanf family of functions,
which can help to dramatically reduce the size of your image if only integer values are used by
such functions.

If your codebase does require floating point variants of printf/scanf, then these can be enabled
by going to:
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Project -> Properties -> C/C++ Build -> Settings -> MCU Linker -> Managed Linker Script and
selecting the " Enable printf/scanf float" tick box.

Newlib printf variants

Newlib provides an “iprintf” function which implements integer only printf

Printf when using LPCOpen

If you are building your application against LPCOpen, you may find that printf output does not
get displayed in the MCUXpresso IDE’s debug console by default. This is due to many LPCOpen
board library projects by default redirecting printf to a UART output.

If you want to direct printf output to the debug console instead, then you will need to modify your
projects so that:

1. Your main application project is linked against the “semihost” variant of the C library, and
2. You disable the LPCOpen board library’s redirection of printf output by either:
¢ locating the source file board.c within the LPCOpen board library and comment out the line:
#include "retarget.h, or
« locating the file board.h and enable the line: #define DEBUG_SEMIHOSTING

Printf when using SDK

The MCUXpresso SDK codebase provides its own printf style functionality through the macro
PRINTF. This is set up in the header file fs|_debug_console.h such that it can either point to the
printf function provided by the C library itself, or can be directly to the SDK function pseudo-printf
function : DbgConsole_Printf() . This will typically cause the output to be sent out via a UART
(which may be connected to an onboard debug probe which will sent it back to the host over a
USB VCOM channel). This is controlled by the macro SDK_DEBUGCONSOLE thus:

 |If SDK_DEBUGCONSOLE ==
e PRINTF is directed to C library printf()
e |f SDK_DEBUGCONSOLE ==
* PRINTF is directed to SDK DbgConsole_Printf()

The Advanced page of the SDK new project wizard and Import SDK examples wizard offer
the option to configure a project so that PRINTF is directed to C library printf() by setting
SDK_DEBUGCONSOLE appropriately.

In addition if PRINTF is being directed to the C library printf(), then if
SDK_DEBUGCONSOLE_UART is also defined, then printf output will still be directed to the
UART. Again the Advanced page of the SDK new project wizard and Import SDK examples
wizard offer an option to control this.

Retargeting printf/scanf

By default, the printf function outputs text to the debug console using the “semihosting”
mechanism.

In some circumstances, this output mechanism may not be suitable for your application. Instead,
you may want printf to output via an alternative communication channel such as a UART or — on
Cortex-M3/M4 — the ITM channel of SWO Trace. In such cases you can retarget the appropriate
portion of the bottom level of the library.

The section “How to use ITM Printf” below provides an example of how this can be done.

Note: when retargeting these functions, you can typically link against the “nohost” variant of the
C Library, rather than the “semihost” one.

All information provided in this document is subject to legal disclaimers © 2017 NXP Semiconductors. All rights reserved.

User Guide

Rev. 10.0 — 21 March, 2017 77



NXP Semiconductors MCUXpresso IDE User Guide

11.5.7

MCUXpresso IDE User Guide -

Redlib

To retarget Redlib’s printf(), you need to provide your own implementations of the function
__sys_write():

int __sys wite(int iFileHandl e, char *pcBuffer, int ilLength)

Function returns number of unwritten bytes if error, otherwise 0 for success

Similarly if you want to retarget scanf(), you need to provide your own implementations of the
function __sys_readc():

int __sys_readc(void)

Function returns character read
Note: these two functions effectively map directly onto the underlying “semihosting” operations.
Newlib / NewlibNano

To retarget printf(), you will need to provide your own implementation of the Newlib system
function _write():

int _wite(int iFileHandl e, char *pcBuffer, int ilLength)

Function returns number of unwritten bytes if error, otherwise 0 for success

To retarget scanf, you will need to provide your own implementation of the Newlib system function
_read():

int _read(int iFileHandl e, char *pcBuffer, int ilLength)

Function returns number of characters read, stored in pcBuffer

More information on the Newlib system calls can be found at: https://sourceware.org/newlib/
libc.html#Syscalls

How to use ITM Printf

ITM Printf is a scheme to achieve application 10 via a debug probe without the usual semihosting
penalties.

ITM Overview

As part of the Cortex-M3/M4 SWO Trace functionality available when using an LPC-Link2 (with
NXP’s CMSIS-DAP firmware), MCUXpresso IDE provides the ability to make use of the ITM :
The Instrumentation Trace Macrocell (ITM) block provides a mechanism for sending data from
your target to the debugger via the SWO trade stream. This communication is achieved though
a memory-mapped register interface. Data written to any of 32 stimulus registers is forwarded to
the SWO stream. Unlike other SWO functionality, using the ITM stimulus ports requires changes
to your code and so should not be considered non-intrusive.

Printf operations can be carried out directly by writing to the ITM stimulus port. However the

stimulus port is output only. And therefore scanf functionality is achieved via a special global
variable, which allows the debugger to send characters from the console to the target (using
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the trace interface). The debugger writes data to the global variable named ITM_RxBuffer to be
picked up by scanf.

Note: MCUXpresso IDE currently only supports ITM via stimulus port 0.

Note: For more information on SWO Trace, please see the MCUXpresso IDE LinkServer SWO
Trace Guide.

ITM printf with SDK

The Advanced page of the SDK new project wizard and Import SDK examples wizard offer the
option to configure a project so as to redirect printf/scanf to ITM. Selecting this option will cause
the file retarget_itm.c to be generated in your project to carry out the redirection.

ITM printf with LPCOpen

To use this functionality with an LPCOpen project you need to: Include the file retarget_itm.c in
your project — available from the Examples subdirectory of your IDE installation Ensure you are
using a semihost, semihost-nf, or nohost C library variant. Then simply add calls to printf and
scanf to your code.

If you just linking against the LPCOpen Chip library, then this is all you need to do. However if you
are also linking against an LPCOpen board library then you will likely see build errors of the form:

../srclretarget.h:224: nmultiple definition of *~__sys_ wite'
../srclretarget.h:240: nmultiple definition of ~__sys_readc’

locating the file board.h and enable the line: #define DEBUG_SEMIHOSTING, or locating
the source file board.c within the LPCOpen board library and comment out the line: #include
"retarget.h

itoa() and uitoa()

itoa() is non-standard library function which is provided in many other toolchains to convert an
integer to a string.

Redlib

To ease porting, the MCUXpresso IDE provides two variants of this function in the Redlib C
library....

char * itoa(int value, char *vstring, unsigned int base);
char * uitoa(unsigned int value, char *vstring, unsigned int base);

which can be accessed via the system header....

#i ncl ude <stdlib. h>

itoa() converts an integer value to a null-terminated string using the specified base and stores
the result in the array pointed to by the vstring parameter. Base can take any value between 2
and 16; where 2 = binary, 8 = octal, 10 = decimal and 16 = hexadecimal.

If base is 10 and the value is negative, then the resulting string is preceded with a minus sign (-).

With any other base, value is always considered unsigned. The return value to the function is a
pointer to the resulting null-terminated string, the same as parameter vstring.
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uitoa() is similar but treats the input value as unsigned in all cases.

Note: the caller is responsible for reserving space for the output character array — the
recommended length is 33, which is long enough to contain any possible value regardless of
the base used.

Example invocations

char vstring [33];
itoa (value,vstring,10); // convert to decinal
itoa (value,vstring,16); // convert to hexadeci mal

itoa (value,vstring,8);; // convert to octal

Standards compliance

As noted above, itoa() / uitoa() are not standard C library functions. A standard-compliant
alternative for some cases may be to use sprintf() - though this is likely to cause an increase in
the size of your application image:

sprintf(vstring,"%l",value); // convert to decimal
sprintf(vstring,"%",value); // convert to hexadeci mal
sprintf(vstring,"%",value); // convert to octal

Newlib/NewlibNano

Newlib and NewlibNano now also provide similar functionality though with slightly different
naming - itoa() and utoa().

Libraries and linker scripts

When using the managed linker script mechanism, as described in the chapter “Memory
configuration and Linker Script Generation”, then the appropriate settings to link against the
required library family and variant will be handled automatically.

However if you are not using the managed linker script mechanism, then you will need to define
which library files to use in your linker script. To do this, add one of the following entries before
the SECTION line in your linker script:

« Redlib (None), add
* [C project only]: GROUP (libcr_c.a libcr_eabihelpers.a)
« Redlib (Nohost), add
« [C projects only]: GROUP (libcr_nohost.a libcr_c.a libcr_eabihelpers.a)
¢ Redlib (Semihost-nf), add
 [C projects only]: GROUP (libcr_semihost_nf.a libcr_c.a libcr_eabihelpers.a)
¢ Redlib (Semihost), add
* [C projects only]: GROUP (libcr_semihost.a libcr_c.a libcr_eabihelpers.a)

* NewlibNano (None), add

* [C projects]: GROUP (libgcc.a libc_nano.a libm.a libcr_newlib_none.a)

e [C++ projects]: GROUP (libgcc.a libc_nano.a libstdc++_nano.a libm.a libcr_newlib_none.a)
* NewlibNano (Nohost), add

¢ [C projects]: GROUP (libgcc.a libc_nano.a libm.a libcr_newlib_nohost.a)

o [C++ projects]: GROUP (libgcc.a libc_nano.a libstdc++_nano.a libm.a
libcr_newlib_nohost.a)

+ NewlibNano (Semihost), add
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* [C projects]: GROUP (libgcc.a libc_nano.a libm.a libcr_newlib_semihost.a)
o [C++ projects]: GROUP (libgcc.a libc_nano.a libstdc++_nano.a libm.a
libcr_newlib_semihost.a)

« Newlib (None), add
» [C projects]: GROUP (libgcc.a libc.a libm.a libcr_newlib_none.a)
¢ [C++ projects]: GROUP (libgcc.a libc.a libstdc++.a libm.a libcr_newlib_none.a)
¢ Newlib (Nohost), add
e [C projects]: GROUP (libgcc.a libc.a libm.a libcr_newlib_nohost.a)
e [C++ projects]: GROUP (libgcc.a libc.a libstdc++.a libm.a libcr_newlib_nohost.a)
« Newlib (Semihost), add
* [C projects]: GROUP (libgcc.a libc.a libm.a libcr_newlib_semihost.a)
¢ [C++ projects]: GROUP (libgcc.a libc.a libstdc++.a libm.a libcr_newlib_semihost.a)

In addition, if using NewlibNano, then tick box method of enabling printf/scanf floating point
support in the Linker pages of Project Properties will also not be available. In such cases, you
can enabling floating point support manually by going to:

Project -> Properties -> C/C++ Build -> Settings -> MCU Linker -> Miscellaneous
and entering -u _printf_float and/or -u _scanf_float into the “Linker flags” box.

A further alternative is to put an explicit reference to the required support function into your project
codebase itself. One way to do this is to add a statement such as:

asm (“.global _printf_float”);

to one (or more) of the C source files in your project.
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12. Memory Configuration and Linker Scripts

12.1 Introduction

A key part of the core technology within MCUXpresso IDE is the principle of a default defined
memory map for each MCU. For devices with internal flash, this will also specify a flash driver to
be used to program that flash memory (for use with LinkServer “native” debug probes).

For pre-installed MCUSs, the definition of the memory map is contained within the MCU part
knowledge that is built into the product. For MCUs installed into MCUXpresso IDE from an SDK,
the definition of the memory map is loaded from manifest file within the SDK structure.

But in both cases, the defined memory map is used by the MCUXpresso IDE to drive the
“managed linker script” mechanism. This auto-generates a linker script to place the code and
data from your project appropriately in memory, as well as being made available to the debugger.

A projects memory map can be viewed and modified by the user to add, remove (split/join)
or reorder blocks using the Memory Configuration Editor. For example, if a project targets an
MCU that supports external flash (e.g. SPIFI), then its memory map can be easily extended to
define the SPIFI memory region (base and size). In addition, an appropriate flash driver can be

associated with the newly defined region.

[ ] MCUXpresso IDE

| Memory configuration editor
| Edit configuration for MKB4FN1MOxxx12

Memory configuration

Default flash driver |

Type Name Alias Location Size
Flash PROGRAM_FLASH Flash 0x0 0x100000
RAM  SRAM_UPPER RAM 0x20000000 0x30000
RAM  SRAM_LOWER RAMZ2  Ox1fff0000 0x10000
RAM  FLEX_RAM RAM3  0x14000000 Ox1000
|
Add Flash Add RAM Split
Import... Merge... Export... Generate...

Figure 12.1. Memory Configuration

Cancel

Browse...

Driver

FTFE_4K.cfx i

Delete

12.2 Managed Linker Script Overview

By default, the use of “managed linker scripts” is enabled for projects. This mechanism allows
the MCUXpresso IDE to automatically create a script for each build configuration that is suitable
for the MCU selected for the project, and the C libraries being used. It will create (and at times
modify) three linker script files for each build configuration of your project:

<proj nane>_<bui l dconfig>_lib.ld
<proj nane>_<bui | dconfi g> nmem | d
<proj nane>_<bui | dconfig>.1d
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This set of hierarchical files are used to define the C libraries being used, the memory map of
the system and the way your code and data is placed into the memory map. These files will be
located in the build configuration subdirectories of your project (typically — Debug and Release).

Figure 12.2. Project Explorer Debug folder Linker Scripts

[ Project Explorer 52 | 2, Peripherals+ 1 Registers . Symbol Viewer
=15
b #4 Binaries
b will Includes
» B CMSIS
b 2 accel
> (2 board
b = drivers
» B source
b Estartup
> 2 utilities
¥ =-Debug
» =accel
F = board
b = CMSIS
» =drivers
» [=-sOurce
» (= startup
» = utilities
b 35 frdmkB4f demo apps bubble.axf - [arm/le
=] frdmk64f_demo_apps_bubble_Debug_library.ld
frdmk&4f_demo_apps_bubble_Debug_memory.ld

frdmkB4f_demo_apps_bubble_Debug.ld
demo_apps_b

| @ makefile
| @objects.mk
| @sources.mk
b (= doc
= frdmkB4f_demo_apps_bubble Debug.launch
=l frdmkE4f_demo_apps_bubble Release.launch

12.3
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The managed linkers script mechanism also automatically takes into account memory map
changes made in Memory Configuration Editor as well as other configuration changes, such as
C/C++ library setting.

How are managed linker scripts generated?

The MCUXpresso IDE passes a set of parameters into the linker script generator (based on
the “Freemarker” scripting engine) to create an appropriate linker script for your project. This
generator uses a set of conditionally parsed template files, each of which control different aspects
of the generated linker script.

It is possible to modify certain aspects of the generated linker script by providing one or more
modified template files locally within \linkscripts subdirectory of project directory structure. Any
such templates that you provide locally will then override the default ones built into MCUXpresso.
A full set of the default linker templates (.1dt) files are provided inside \Wizards\linker subdirectory
of your IDE install.
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12.4 Default image layout

Code and initial values of initialised data items are placed into first bank of flash (as show in
memory configuration editor). During startup, the MCUXpresso IDE startup code copies the data
into the first bank of RAM (as show in memory configuration editor), and zero initializes the BSS
data directly after this in memory. This process uses a global section table generated into the
image from the linker script.

Other RAM blocks can also have data items placed into them under user control, and the startup
code will also initialize these automatically. See later in this chapter for more details.

Figure 12.3. Default Memory Layout

0X2000 4000

RAMZ -] (o P BSSZ
0x2000 0000 " DATA2
0x1000 8000 |

Co|
RAM :py Heap {}

Zerg. oo BSS
Ox 1000 0000 . ----------- > | DAT,A
0x0001 0000 E
. Copy
DATA2 | -
Flash DATA .
CODE { c'::E CODE
0x0000 0000 .,
Load view Runtime view
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Note: The above memory layout is simply the default used by the IDE’s managed linker script
mechanism. There are a number of mechanisms that can be used to modify the layout according
to the requirements of your actual project — such as simply editing the order of the RAM banks
in the Memory Configuration Editor. These various methods are described later in this chapter.

The default memory layout will also locate the heap and stack in the first RAM bank, such that:

« the heap is located directly after the BSS data, growing upwards through memory
« the stack located at the end of the first RAM bank, growing down towards the heap

Again this heap and stack placement is a default and it is very easy to modify the locations for
a particular project, as will be described later in this chapter.

Note: When you import a project, you may find that the defaults have already been modified.
Check the Project Properties to confirm the exact details.
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Examining the layout of the generated image

Looking at the size of the AXF file generated by building your project on disk does not provide any
information as to how much Flash/RAM space your application will occupy when downloaded
to your MCU. The AXF file contains a lot more information than just the binary code of
your application, for example the debug data used to provide source level information when
debugging, that is never downloaded to your MCU.

Looking at the size of the AXF file generated by building your project on disk does not provide any
information as to how much Flash/RAM space your application will occupy when downloaded
to your MCU. The AXF file contains a lot more information than just the binary code of
your application, for example the debug data used to provide source level information when
debugging, that is never downloaded to your MCU.

Linker --print-memory-usage

MCUXpresso IDE projects use the --print-memory-usage option on the link step of a build to
display memory usage information in the build console of the following form:

Menory region Used Size Regi on Size %ge Used
PROGRAM_FLASH: 26764 B 1 MB 2.55%
SRAM_UPPER: 8532 B 192 KB 4.34%
SRAM_LOVER: 0GB 64 KB 0. 00%
FLEX_RAM 0GB 4 KB 0. 00%
Fi ni shed building target: frdnk64f_deno_apps_bubbl e. axf

The memory regions displayed here will match up to the memory banks displayed in the memory
configuration editor when the managed linker script mechanism is being used.

By default, the application will build and link against the first flash memory found within the
devices memory configuration. For most MCUs there will only be 1 flash device available. In this
case our project requires 26764 bytes of Flash memory storage, 2.55% of the available Flash
storage.

RAM will be used for global variable, the heap and the stack. MCUXpresso IDE provides a flexible
scheme to reserve memory for Stack and Heap. This build has reserved 4KB each for the stack
and the heap contributing 8KB to the overall 8532 bytes reported.

If using the LPCXpresso style of heap and stack placement (described later in this chapter), the

RAM consumption provided by this is only that of your global data. It will not include any memory
consumed by your stack and heap when your application is actually executing.

arm-none-eabi-size

In addition, a post-build step will normally invoke the arm-none-eabi-size utility to provide this
information in a slightly different form....

t ext dat a bss dec hex fil enane
2624 524 32 3180 c6e LPCXpr ess01768_systi ck_t wi nkl e. axf

« text - shows the code and read-only data in your application (in decimal)

« data - shows the read-write data in your application (in decimal)

¢ bss - show the zero initialized (‘bss’ and ‘common’) data in your application (in decimal)
« dec - total of ‘text’ + ‘data’ + ‘bss’ (in decimal)

¢ hex - hexadecimal equivalent of 'dec’
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Typically:

« the flash consumption of your application will then be text + data
« the RAM consumption of your application will then be data + bss

Again if using the LPCXpresso style of heap and stack placement (described later in this chapter),
the RAM consumption will not include any memory consumed by your stack and heap when your
application is actually executing.

You can also manually run the arm-none-eabi-size utility on both your final application image, or
on individual object files within your build directory by right clicking on the file in Project Explorer
and selecting the Binary Utilities -> Size option.

Linker Map files

The linker option “-map” option, which is enabled by default by the project wizard when a new
project is created, allows you to analyse in more detail the contents of your application image.
When you do a build, this will cause a file called projectname.map to be created in the Debug (or
Release) subdirectory, which can be loaded into the editor view. This contains a large amount
of information, including:

¢ Alist of archive members (library objects) included with details

¢ Alist of discarded input sections (because they are unused and the linker option --gc-sections
is enabled).

¢ The location, size and type of all code, data and bss items that have been placed in the image

Symbol Viewer

The Symbol Viewer provides a simple way of displaying the symbols in an object, library archive
or executable. By default, this is located in the top left of the MCUXpresso IDE window, in parallel
with the Project Explorer view.

Viewing Symbols in the Viewer

To open an image in the Symbol Viewer, either highlight it in the Project Explorer Views and
use the context sensitive menu ‘Tools->View Symbols’ menu, or use the Browse button on the
Toolbar within the Symbol Viewer windows itself

The Symbol Viewer can display object files (.0), libraries (.lib) and executables (.axf or .elf)
The image will be processed and displayed in the Symbol Viewer as shown in the next section.

It is possible to open multiple Symbol Viewers by pressing the ‘Green +" icon in the toolbar. The
symbols for different images can then be displayed simultaneously.

Using the Symbol Viewer

When first opening a file, the viewer will display the sections found in the file (e.g. .text, .bss etc).
Expanding a section will show the symbols within that section. Clicking on the symbol name wiill
open the source file in an editor window at the symbol definition (if source is available).

The columns of the symbol viewer show information about the symbols:

¢ Symbol Name:

¢ Address: The address (or value) of the Symbol

« Size: The size of the symbol, in bytes. For functions this would be the size of the function. For
variables, this would be the size occupied by the variable

* Flags: The type of the Symbol. Typically this would be Local or Global and Function or Object
(data variable)
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[(5 Project Explorer =, Peripherals+ 1} Registers | £ Symbol Viewer 2 = 8
E] T O T
Symbol Address (Range) Size Flags
TMKB4FN1MOxxx12_Project.axf
F text (00000000-000... 8212 Local Debug
¥.data (20000000-200... 4 Local Debug
SystemCoreClock 20000000 4 Global Object
_data 20000000 0 Global
_edata 20000004 0 Global
.data_RAM2 (00000000-000... 0 Local Debug
E_I
v b ss (20000004- 200 19 Local Debug
i.5865 20000004 4 Local Object
ermao 20000010 4 Global Object
_ehss 2000008 0 Global
_bss 20000004 0 Global
__heaps 20000008 4 Global Object
__end_of_heap 2000000¢ 4 Global Object
__Ciob 20000014 180 Global Object
¥.uninit_RESERVED (00000000-000... 0 Local Debug
_end_uninit RESERVED 20000000 CI Global
.noinit_RAM2 (00000000-000... 0 Local Debug
.noinit_RAM3 (00000000-000... O Local Debug
» .noinit (00000000-000... O Local Debug
¥ . heap (00000000-000... O Local Debug
_pvHeapLimit 2000108 ] Global
_pvHeapStart 2000008 0 Global
heap2stackfill (00000000-000... O Local Debug
b .stack (00000000-000... O Local Debug
»*ABS* (00000000-000... 0 Local Debug

Figure 12.4. Symbol Viewer

Note: The symbols displayed are a snapshot of the symbols for a particular build, therefore these
should be refreshed when a new build is performed. This can easily be done using the Reload
icon in the Symbol Viewer window.

Other utilities

The arm-none-eabi-nm utility is effectively a command line version of the Symbol Browser. But
it can sometime be useful when looking at the size of your application, as it can produce some
of the information provided in the linker map file but in a more concise form. For example:

arm none-eabi -nm -S --size-sort -s project.axf

produces a list of all the symbols in an image, their sizes and their addresses, listed in size order.
For more information on this utility, please see the GNU binutils documentation.

Note: you can run arm-none-eabi-nm as a post-build step, or else open a command shell using
the status bar shortcuts (at the bottom of the IDE window).

12.6 Other options affecting the generated image

12.6.1 LPC MCUs — Code Read Protection

Most of NXP’s LPC Cortex-M based MCUs which have internal flash memory contain “Code
Read Protection” (CRP) support. This mechanism uses one of a number of known values being
placed in a specific location in flash memory to provide a number of levels of protection. When
the MCU boots, this specific location in flash memory is read and depending upon its value, the
MCU may prevent access to the flash memory by external devices. This location is typically at
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0x2FC though for LPC18xx/43xx parts with internal flash, the CRP location is at an offset of
0x2FC from the start of the flash bank being used.

CRP : Preinstalled MCUs

Support for setting up the CRP memory location is provided via a combination of the Project
Wizard, a header file and a number of macros. This support allows specific values to be easily
placed into the CRP memory location, based on the user’s requirements.

The New Project wizard contains an option to allow linker support for placing a CRP word to be
enabled when you create a new project. This is typically enabled by default. This wizard option
actually then controls the “Enable CRP” checkbox of the Project Properties linker Target tab.

In addition the wizard will create a file, ‘crp.c’ which defines the ‘CRP_WORD’ variable which will
contain the required CRP value. A set of possible values are provided by the NXP/crp.h header
file that this then includes. Thus for example ‘crp.c’ will typically contain:

#i ncl ude <NXP/crp. h>
__CRP const unsigned int CRP_WORD = CRP_NO CRP ;

which is then placed at the correct location in Flash by the linker script generated by the managed
linker script mechanism:

. = 0x000002FC ;
KEEP(*(.crp))

Note: the value CRP_NO_CRP ensures that the flash memory is fully accessible. When you
reach the stage of your project where you want to protect your image, you will need to modify
the CRP word to contain an appropriate value.

Important Note: You should take particular care when modifying the value placed in the CRP
word, as some CRP settings can disable some or all means of access to your MCU (including
debug). Before making use of CRP, you are strongly advised to refer to the User Manual for the
LPC MCU that you are using.

CRP : MCUs installed by Importing an SDK

The support for CRP in LPC parts imported into MCUXpresso IDE from an SDK, is generally
similar to the Preinstalled MCUs. However rather than having a separate crp.c file, the
CRP_WORD variable definition is generally found within the startup code.

Kinetis MCUs - Flash Config blocks

Kinetis MCUs provides an alternative means of protecting the user’s image in Flash using the
Flash Configuration Block. The Flash Configuration Field is generally located at addresses
0x400-0x40F and unlike the LPC CRP mechanism only specific values give access, whereas
any other values are likely to lock the part.

The value of the Flash Configuration block for a project is provided by the following structure
which will be found in the startup code:

_attribute__ ((used,section(".FlashConfig"))) const struct {
unsi gned int wordil;
unsi gned int word2;
unsi gned int word3;
unsi gned i nt word4;

} Flash_Config = {OxFFFFFFFF, OxFFFFFFFF, OxFFFFFFFF, OxFFFFFFFE};
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which is then placed appropriately by the linker script generated by the managed linker script

mechanism.

= 0x400 ;

/* Kinetis Flash Configuration data */

PROVI DE(__FLASH CONFI G START__ = .) ;

KEEP(* (. Fl ashConfi g))

PROVI DE(__FLASH CONFIG END__ = .) ;

ASSERT( ! (__FLASH CONFI G_START__ == __FLASH CONFI G_END__),
"Li nker Flash Config Support Enabled, but no .FlashConfig
section provided within application");

/* End of Kinetis Flash Configuration data */

Important Note: The support for placing the Flash Configuration Block can be disabled by
unticking a checkbox of the Project Properties linker Target tab. However this is generally not
advisable as it is very likely to result in a locked MCU.

[ N ) Properties for frdmk64f_demo_apps_bubble
Settings fe=1) - -
*Resource
Tg:‘giir;uild Configuration: | Debug [ Active ] E Manage Configurations...
Build Variables
Environment
Logging #Build steps Build Artifact Binary Parsers @ Error Parsers
MCU settings
fEﬂIirC‘:ghs n Edit ¥ & MCU C Compiler Manage linker script
ool Chain Editor N
» C/C++ General %:Dlalecl Enable automatic placement of Flash Configuration field in image )
2 Preprocessor = —
Project References glnclzdes Link application to RAM
Run/Debug Settings (B Optimization Stack offset 0
»Task Repository = . -
= 22 Debugging . . . .
WikiText Warnings Library Redlib (semihost-nf) <]
EMiscellanecus
# Architecture
¥ & MCU Assembler i .
(B General Linker script
(& Architecture & Headers Script path
¥ 52 MCU Linker —
EGeneral Heap and Stack placement = MCUXpresso Style <]
@ Libraries Region Location Size
%Mmcellanleous ) Heap Default Post Data Default
(¥ Shared Library Settings  stack Default End Default
(2 Architecture
£ Managed Linker Script
EMulticore
Restore Defaults Apply
@ cace (CCENNN
Figure 12.5. Linker Settings

12.6.3 Placement of USB data

For MCUs where part support is imported from an SDK, the managed linker script mechanism
supports the automatic placement of USB global data (as used by the SDK USB Drivers),
including for parts with dedicated USB_RAM (small or large variants).
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Modifying the generated linker script / memory layout

The linker script generated by the managed linker script mechanism will be suitable for use,
as is, for many applications. However in some circumstances you may need to make changes.
MCUXpresso IDE provides a number of mechanisms to allow you to do this whilst still being able
to use the managed linker script mechanism. These include:

¢ Changing the layout and order of memory using the Memory Configuration Editor

¢ Changing the size and location of the stack and heap using the Heap and Stack Editor

« Decorating the definitions of variables and functions in your source code with macros from the
cr_section_macros.h to cause them to be placed into different memory blocks

« Providing project specific versions of Freemarker linker script templates to change particular
aspects of how the managed linker script mechanism creates the final linker script

The following sections describe these in more detalil.

Using the Memory Configuration Editor
The Memory Editor is accessed via the MCU settings dialog, which can be found at
Project Properties -> C/C++ Build -> MCU settings

This lists the memory details for the selected MCU, and will, by default, display the memory
regions that have been defined by the MCUXpresso IDE itself.
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Driver
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Figure 12.6. LPC4337... default memory regions

12.8.1 Editing a Memory Configuration

In the example below, we will show how the default memory configuration for an LPC4337... can
be changed. Selecting the Edit... button will launch the Memory configuration editor dialog —

see Figure 12.7.
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'@ MCUXpresso IDE

Memory configuration editor

Edit configuration for LPC4337

Memory configuration

Default flash driver LPC18x7_43x7_2x512_BootA.cfx Browse...
Type Mame Alias Location Size Drriver —
Flash  MFlashA512 Flash 0x1a000000 0x80000 i
Flash MFlashB512 Flash2 0x1b000000 0x80000
RAM  RamlLoc32 RAM 0x10000000 OxB8000 ¢
RAM  RamlLoc40 RAM2 0x10080000 Oxa000
RAM  RamAHB32 RAM3  0x20000000 Ox8000
RAM  RamAHB186 RAM4 0x20008000 O0x4000
RAM RamAHB_ETB16 RAMS  0x2000c000 0x4000

Add Flash Add RAM Split Delete

Import... Merge... Export... Generate...

Cancel [ OK

Figure 12.7. Memory configuration editor

Known blocks of memory, with their type, base location, and size are displayed. Entries can be

created, deleted, etc by using the provided buttons.

For simplicity, the additional memory regions are given sequential aliases, starting from 2, so
RAM2, RAM3 etc (as well as using their “formal” region name — for example RamAHB32).

Table 12.1. Memory editor controls

Button
Add Flash
Add RAM
Split

Join
Delete
Import

Merge

Export
Up / Down

Generate
Driver

Browse(Flash driver)

Details

Add a new memory block of the appropriate type.

Add a new memory block of the appropriate type.

Split the selected memory block into two equal halves.

Join the selected memory block with the following block (if the two are contiguous).
Delete the selected memory block.

Import a memory configuration that has been exported from another project,
overwriting the existing configuration.

Import a partial memory configuration from a file, merging it with the existing memory
configuration. This allows you, for example, to add an external flash bank definition
to an existing project.

Export a memory configuration for use in another project.

Reorder memory blocks. This is important: if there is no flash block, then code will be
placed in the first RAM block, and data will be placed in the block following the one
used for the code (regardless of whether the code block was RAM or Flash).
Generates local part support for the selected MCU.

Highlighted in blue, shows the selection of a per-flash region flash driver. Click this
field to see a drop down of all available drivers. Please see: Introduction to LinkServer
Flash Drivers [64]

Select the appropriate driver for programming the flash memory specified in the
memory configuration. This is only required when the flash memory is external to the
MCU. Flash drivers for external flash must have a “.cfx” file extension and must be
located in the ide\bin\flash subdirectory of the MCUXpresso IDE installation.

MCUXpresso IDE User Guide -
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The name, location, and size of this new region can be edited in place. Note that when entering
the size of the region, you can enter full values in decimal or in hex (by prefixing with ox), or by
specifying the size in kilobytes or megabytes. For example:
¢ To enter a region size of 32KB, enter 32768, 0x8000 OF 32k.

« To enter a region size of 1MB, enter 0x100000 OF 1m

Note: memory regions must be located on four-byte boundaries, and be a multiple of four bytes
in size.

The screenshot below shows the dialog after the “Add Flash” button has been clicked. Use the
highlighted up/down buttons to move this region to be top in the list.

[ ] MCUXpresso IDE

Memory configuration editor
Edit configuration for LPC4337

Memory configuration
Default flash driver LPC18x7_43x7_2x512_BootA.cfx Browse...
Type Mame Alias Leocation Size Driver
Flash MFlashA512 Flash 0x1a000000 0x80000
Flash_00
Md
RAM  RamlLoc40 RAM2 0x10080000 Oxa000
RAM  RamAHB32 RAM3  0x20000000 O0xB000
RAM  RamAHB16 RAM4  0x20008000 Ox4000

RAM RamAHB_ETB16 RAMS  0x2000c000 0x4000

Add Flash Add RAM Split Delete

Impaort... Merge... Export... Generate...

Cancel | (TSN

Figure 12.8. Effect of Add Flash

After updating the new memory configuration, click OK to return to the MCU settings dialog,
which will be updated to reflect the new configuration.
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Figure 12.9. Updated MCU settings
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Refresh MCU Cache
|
|
| Restore Defaults Apply
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Here you can see that the region has been named SPIFI_1MB, and the default flash driver has
been deleted and the Generic SPIFI driver selected for the newly created SPIFI_1MB region.

MCUXpresso IDE provides extended support for the creation and programming of projects that
span multiple flash devices. In addition to a single default flash driver, per region flash drivers can
also be specified (as above). Using this scheme projects can be created that span flash regions
and can be programmed in a single ‘debug’ operation.

Note: that once the memory details have been modified, the selected MCU as displayed on the
“Status Bar” (at the bottom of the IDE window) will be displayed with an asterisk (*) next to it.
This provides an indication that the MCU memory configuration settings for the selected project
have been modified.

Device specific vs Default Flash Drivers

When a project is configured to use additional flash devices via the Memory Configuration Editor,
the flash driver to be used for programming that flash device has to be specified in the Driver
column. Typically for a SPIFI device, this should be:

+ LPC18_43_SPIFI_GENERIC.cfx (for LPC18/LPC43 series MCUs)

e LPC40xx_SPIFI_GENERIC.cfx (for LPC407x/8x MCUS)

e LPC5460x_SPIFI_GENERIC.cfx (for LPC5460x MCUs).
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Restoring a Memory Configuration

To restore the memory configuration of a project back to the default settings, simply reselect the
MCU type, or use the “Restore Defaults” button, on the MCU Settings properties page.

Copying Memory Configurations

Memory configurations can be exported for import into another project. Use the Export and Import
buttons for this purpose.

MCUXpresso IDE provides a standard memory layout for each known MCU. In addition, the
MCUXpresso IDE supports the editing of the target memory layout used for a project. This allows
for the details of external flash to be defined or for the layout of internal RAM to be reconfigured.
Also, it allows a flash driver to be allocated for use with parts with no internal flash, but where
an external flash part is connected.

More advanced heap/stack placement

MCUXpresso IDE provides two models of heap/stack placement. The first of these is the
“LPCXpresso Style”, which is the mechanism provided by the previous generation LPCXpresso
IDE. This is the default model used for projects created for Preinstalled MCUs. The second model
is the “MCUXpresso style”. This is the default model used for projects created for MCUs imported
from SDKs.

The heap/stack placement model being used for a particular project/build configuration can be
modified by right clicking on the project and selecting:

Project Properties -> C/ C++ Build -> Settings -> MCU Linker -> Managed Linker Scripts
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Figure 12.10. MCUXpresso IDE Linker Settings
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Linker script
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Post Data Default
Default End Default

Restore Defaults Apply

Cancel

In the dialogue above, highlights show the managed linker script option along with the selection
of the MCUXpresso Style scheme.

12.9.1

MCUXpresso style heap and stack

By default the heap and stack are placed in the “default” memory region (i.e. the first RAM block
displayed in the memory configuration area), with the heap placed after the application’s data
and the stack rooted at the top of this block.

However, using the Heap and Stack editor in Project Properties, it is very simple to individually
change the stack and heap locations (both the memory block used, and the location within that

MCUXpresso IDE User Guide -

block), and also the size of the memory to be used by each of them.
Region

e Default : Place into first RAM bank as shown in Memory Configuration Editor
« List of memory regions, and aliases, as show in Memory Configuration Editor

Location

« Start : Place at start of specified RAM bank.
« Post Data : Place after any data in specified RAM bank. Default for heap.
e End : Place at end of specified RAM bank. Default for stack.

Size
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e Default: 1/16th of the memory region size, up to a maximum of 4KB (and a minimum of
128bytes). Hovering the cursor over the field will show the current value that will be used.

¢ Value : Specify exact required size. Must be a multiple of 4. Note that when entering the size of
the region, you can enter full values in decimal or in hex (by prefixing with 0x), or by specifying
the size in Kilobytes (or Megabytes). For example:
* To enter a size of 32KB, enter 32768, 0x8000 or 32k.

Note: The MCUXpresso style of setting heap and stack has the advantage over the LPCXpresso
style described below in that the memory allocated for heap/stack usage is also taken into
account in the image size information displayed in the Build console when your project is built.

LPCXpresso style heap and stack

By default the heap and stack are still placed in the “default” memory region (i.e. the first RAM
block displayed in the memory configuration area), with the heap placed after the application’s
data and the stack rooted at the top of this block.

To relocate the stack or heap, or provide a maximum extent of the heap, then the linker “--defsym”
option can be used to define one or more of the following symbols:

__user_stack_top
__user_heap_base
_pvHeapLi m t

To do this, use the _ MCU Linker — Miscellaneous — Other Options_ box in Project Properties.
For example:
--defsym=__user_stack _top=__top_RAM2

« Locate the stack at the top of the second RAM bank (as listed in the memory configuration
editor)

* Note : The symbol _ top_RAM?2 is defined in the project by the managed linker script
mechanism at:

<proj nane>_<bui | dconfi g> nem | d

--defsym=__user_heap_base=__end_bss RAM2
* Locate the start of the heap in the second RAM bank, after any data that has been placed there
--defsym=_pvHeapLimit=__end_bss_RAM2+0x8000

¢ Locate the end of the heap in the second RAM bank, offset by 32KB from the end of any data
that has been placed there

--defsym=_pvHeapLimit=0x10004000
¢ Locate the end of the heap at the absolute address 0x10004000

Reserving RAM for IAP Flash Programming

The IAP flash programming routines available in NXP’s LPC MCUs generally make use of some
of the onchip RAM when executed. For example on the LPC1343 the top 32 bytes of onchip RAM
are used. Thus if you are calling the IAP routines from your own application, you need to ensure
that this memory is not used by your main application — which typically means by the stack.

However, with the managed linker script mechanism, it is easy to modify the start position of the
stack (remember that stacks grow down) to avoid this clash with the IAP routines. To do this go to:
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Project Properties -> C/C++ Build -> Settings -> MCU Linker -> Manager Linker Script

and modify the value in the “Stack Offset” field from 0 to 32. This will work whether you are using
LPCXpresso style or MCUXpresso style of heap/stack placement.

[ ey Properties for LPC11U68
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Tool Chain Editor
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Project References

¥ $5MCU C Compiler Manage linker script
(% Dialect Enable automatic placement of Code Read Protection field in image
(#Preprocessor

’ @lncludes Link application to RAM
Run/Debug Settings

» Task Raposit (= Optimization Stack offset (32 )
ask Repository 4 -
WikiText g\?ﬁ:iﬂ:g Library Redllb (semihost) 5]
EMiscellaneous
# Architecture
¥ £ MCU Assembler . .
(= General Linker script
(#Architecture & Headers  Seript path
¥ B3 MCU Linker
(2 General Heap and Stack placement | LPCXpresso Style
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(#28hared Library Settings
# Architecture
#2Managed Linker Script
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Region
Heap Default
Stack Default

Restore Defaults Apply

@

= Cancel LS

Figure 12.11. MCUXpresso IDE Linker Reserve Stack Space

The value you enter in this field must be a multiple of 4.

You are also advised to check the documentation for the actual MCU that you are using to confirm
the amount of memory required by the IAP routines.

12.9.4 Stack checking

Although, as described above, it is possible to define a size of memory to be used for the stack,
Cortex-M CPUs have no support for hardware stack checking. Thus if you want to automatically

detect if the stack exceeds the memory set aside for it — other mechanisms must be used. For
example:

¢ Locate stack to fall off start of memory block and trigger fault

 Include code that sets the stack to a known value, and periodically checks whether the lowest
address has been overwritten.

* When debugging, set a watchpoint on the lowest address the stack is allowed to reach
¢ Use the Memory Protection Unit (MPU) to detect overflow, on parts which implement one
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Heap Checking

By default, the heap used by the malloc() family of routines grows upwards from the end of the
user data in RAM up towards the stack — a “one region memory model”.

When a new block of memory is requested, the memory allocation function _sbrk() will make a
call to the following function to check for heap overflow:

unsi gned __check_heap_overfl ow (void * new end_of _heap)

This should return:

e 1 - If the heap will overflow
¢ 0 - If the heap is still OK

If 1 is returned, Redlib’s malloc() will set errno to ENOMEM and return a null pointer to the caller

The default version of __check_heap_overflow() built into the MUCXpresso IDE supplied C
libraries carry out no checking unless the symbol “_pvHeapLimit” has been created in your image,
to mark the end location of the heap.

This symbol will have been created automatically if you are using the MCUXpresso style of heap
and stack placement described earlier in this chapter. Or alternatively if using the LPCXpresso
style of heap and stack placements, you can use the --defsym option to set this.

If you wish to use a different means of heap overflow checking, then you can find a reference
implementation of __check_heap_overflow() in the file _cr_check_heap.c that can be found
in the Examples subdirectory of your IDE installation.

This file also provides functionality to allow simple heap overflow checking to be done by
looking to see if the heap has reached the current location of the stack point, which of course
assumes that the heap and stack are in the same region. This check is not enabled by default
implementation within the C library as it can break in some circumstances — for example when
the heap is being managed by an RTOS.

Placement of specific code/data items

It is possible to make small changes to the placement of specific code/data items within the
final image without modifying the Freemarker linker script templates. Such placement can be
controlled via macros provided in an MCUXpresso IDE supplied header file which can be pulled
into your project using:

#i ncl ude <cr_section_nacros. h>

Placing data into different RAM blocks

Many MCUs provide more than one bank of RAM. By default the managed linker script
mechanism will place all of the application data and bss (as well as the heap and stack) into
the first bank of RAM.

However it is also possible to place specific data or bss items into any of the defined banks for the
target MCU, as displayed in the Memory Configuration Editor, by decorating their definitions in
your source code with macros from the cr_section_macros.h MCUXpresso IDE supplied header
file

For simplicity, the additional memory regions are named sequentially, starting from 2, so RAM2,
RAMS etc (as well as using their “formal” region name — for example RamAHB32).
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For example, the LPC1768 has a second bank of RAM at address 0x2007c000. The managed
linker script mechanism creates a data (and equivalent bss) load section for this region thus:

.data_RAM2 : ALI G\N(4)
{
FI LL(Oxff)
*(. dat a. $RAMR*)
* (. dat a. $RamAHB32*)
} > RamAHB32 AT>MFl ash512

To place data into this section, you can use the _ DATA macro, thus:

/1 create an initialised 1k buffer in RAM2
__DATA(RAM2) char data_buffer[1024];

Or the _ BSS macro:

/l create a zero-init buffer in RAM2
__BSS(RAMR) char bss_buffer[128];

In some cases you might need afiner level of granularity than just placing a variable into a specific
memory bank, and rather need to place it at a specific address. In such a case you could then
edit the predefined memory layout for your particular project using the “Memory Configuration
Editor” to divide up (and rename) the existing banks of RAM. This then allows you to provide a
specific named block of RAM into which to place the variable that you need at a specific address,
again by using the attribute macros provided by the “cr_section_macros.h” header file.

Noinit Memory Sections

Normally global variables in an application will end up in either a “.data” (initialized) or
“.bss” (zero-initialized) data section within your linked application. Then when your application
starts executing, the startup code will automatically copy the initial values of “.data” sections from
Flash to RAM, and zero-initialize “.bss” data sections directly in RAM.

MCUXpresso IDE’'s managed linker script mechanism also supports the use of “.noinit” data
within your application. Such data is similar to “.bss” except that it will not get zero-initialized
during startup.

Note: Great care must be taken when using “.noinit” data such that your application code makes
no assumptions about the initial value of such data. This normally means that your application
code will need to explicitly set up such data before using it — otherwise the initial value of such
a global variable will basically be random (i.e. it will depend upon the value that happens to be
in RAM when your system powers up).

One common example of using such .noinit data items is in defining the frame buffer stored in
SDRAM in applications which use an onchip LCD controller (for example NXP LPC178x and
LPC408x parts).

Making global variables noinit

The linker script generated by the MCUXpresso IDE managed linker script mechanism will
contain a section for each RAM memory block to contain “.noinit” items, as well as the “.data”
and “.bss” items. Note that for a particular RAM memory block, all “.data” items will be placed
first, followed by “.bss” items, and then “.noinit” items.

However, normally for a particular RAM memory block where you are going to be put “.noinit”
items, you would actually be making all of the data placed into that RAM “.noinit”.
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The “cr_section_macros.h” header file then defines macros which can be used to place global
variables into the appropriate “.noinit” section. First of all include this header file:

#i ncl ude <cr_section_nacros. h>

The __NOINIT macro can then be used thus:

/] create a 128 byte noinit buffer in RAM2
__NO NI T(RAM2) char noinit_buffer[128];

And if you want “.noinit” items placed into the default RAM bank, then you can use the
__NOINIT_DEF macro thus:

/] create a noinit integer variable in the main bl ock of RAM
__NO NIT_DEF int noinit_var ;

Placing code/rodata into different FLASH blocks

Most MCUs only have one bank of Flash memory. But with some parts more than one bank may
be available — and in such cases, by default, the managed linker script mechanism will still place
all of the application code and rodata (consts) into the first bank of flash (as displayed in the
Memory Configuration Editor).

For example:

« most of the LPC18 and LPC43xx parts containing internal flash (such as LPC1857 and
LPC4357) actually provide dual banks of flash.

* some MCUs have the ability to access external flash (typically SPIFI) as well as their built-in
internal flash (e.g. LPC18xx, LPC40xx, LPC43xx, LPC546xx).

However it is also possible to place specific functions or rodata items into the second
(or even third) bank of Flash. This placement is controlled via macros provided in the
"cr_section_macros.h" header file.

For simplicity, the additional Flash region can be referenced as Flash2 (as well as using its
“formal” region name — for example MFlashB512 — which will vary depending upon part).

First of all include this header file:

#i ncl ude <cr_section_nacros. h>

Then, for example, to place a rodata item into this section, you can use the _ RODATA macro,
thus:

__RODATA(Fl ash2) const int roarray[] = {10, 20, 30, 40, 50};

Or to place a function into it you can use __ TEXT macro:

__TEXT(Fl ash2) void systick_delay(uint32_t del ayTicks) {

In addition the _ RODATA_EXT and __ TEXT_EXT macros can be used to place functions/
rodata into a more specifically named section, for example:
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__ TEXT_EXT(Fl ash2, systi ck_del ay) void systick_del ay(uint32_t del ayTi cks) {

will be placed into the section “.text.$Flash2.systick_delay” rather than “.text.$Flash2”.
Placing specific functions into RAM blocks

In most modern MCUs with built-in flash memory, code is normally executed directly from flash
memory. Various techniques, such as prefetch buffering are used to ensure that code will execute
with minimal or zero wait states, even a higher clock frequencies. Please see the documentation
for the MCU that you are using for more details.

However it is also possible to place specific functions into any of the defined banks of RAM for
the target MCU, as displayed in:

Project -> Properties -> C/C++ Build -> MCU settings

and sometimes there can be advantages in relocating small, time critical functions so that they
run out of RAM instead of flash.

For simplicity, the additional memory regions are named sequentially, starting from 2, (as well
as using their “formal” region name — for example RamAHB32). So for a device with 3 RAM
regions, alias names RAM, RAM2 and RAM3 will be available.

This placement is controlled via macros provided in a header file which can be pulled into your
project using:

#i ncl ude <cr_section_nacros. h>

The macro _ RAMFUNC can be used to locate a function into a specific RAM region.

For example, to place a function into the main RAM region, use:

__RAVFUNC(RAM) void fooRAM void) {...

To place a function into the RAM2 region, use:

__RAMFUNC( RAMR) voi d fooRAM2(void) {...

Alternatively, RAM can be selected by formal name (as listed in the memory configuration editor),
for example:

__RAMFUNC( RamAHB32) voi d Handl erRAMvoid) {...

In order to initialize RAM based code (and data) into specified RAM banks, the managed linker
script mechanism will create a “Global Section Table” in your image, directly after the vector
table. This contains the addresses and lengths of each of the data (and bss) sections, so that the
startup code can then perform the necessary initialization (copy code/data from Flash to RAM) .

Long branch veneers and debugging

Due to the distance in the memory map between flash memory and RAM, you will typically require
a “long branch veneer” between the function in RAM and the calling function in flash. The linker
can automatically generate such a veneer for direct function calls, or you can effectively generate
your own by using a call via a function pointer.
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One point to note is that debugging code with a linker generated veneer can sometimes cause
problems. This veneer will not have any source level debug information associated with it, so that
if you try to step in to a call to your code in RAM, typically the debugger will step over it instead.

You can work around this by single stepping at the instruction level, setting a breakpoint in your
RAM code, or by changing the function call from a direct one to a call via a function pointer.

Reducing Code Size when support for LPC CRP or Kinetis Flash Config Block is
enabled

One of the consequences of the way that LPC CRP and Kinetis Flash Configuration Blocks work
is that the memory between the CPU’s vector table and the CRP word/ Flash Config Block is
often left largely unused. This can typically increases the size of the application image by several
hundred bytes (depending upon the MCU being used).

However this unused space can easily be reclaimed by choosing one or more functions to be
placed into this unused memory. To do this, you simply need to decorate their definitions with
the macro __ AFTER_VECTORS which is supplied in the “cr_section_macros.h” header file

Obviously in order to do this effectively, you need to identify functions which will occupy as much
of this unused memory as possible. The best way to do this is to look at the linker map file.

MCUXpresso IDE startup code already uses this macro to place the various initialization functions
and default exception handlers that it contains into this space, thus reducing the ‘default’ unused
space. But you can also place additional functions there by decorating their definitions with the
macro, for example

__AFTER VECTORS voi d nyStartupFunction(void);

Note you will get a link error if the _ AFTER_VECTORS space grows beyond the CRP/Flash
Configuration Block (when this support is enabled):

nmyproj _Debug. | d: 98 cannot nove | ocation counter backwards (from 00000334
to 000002f c)
collect2: Id returned 1 exit status

make: *** [nyproj.axf] Error 1

In this case, you will need to remove the _ AFTER_VECTORS macro from the definition of one
or more of your functions.

Freemarker Linker Script Templates

By default, MCUXpresso IDE projects use a managed linker script mechanism which
automatically generates a linker script file without user intervention — allowing the project code
and data to be laid out in memory based on the IDE’s knowledge of the memory layout of the
target MCU.

However sometimes the linker script generated in this way may not provide exactly the memory
layout required. MCUXpresso IDE therefore provides a highly flexible and powerful linker script

template mechanism to allow the user to change the content of the linker script generated by
the managed linker script mechanism

Basics

FreeMarker is a template engine: a generic tool to generate text output (HTML web pages,
e-mails, configuration files, source code, etc.) based on templates and changing data. Built
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into MCUXpresso IDE are a set of templates that are processed by the Freemarker template
engine to create the linker script. Templates are written in the FreeMarker Template Language
(FTL), which is a simple, specialized language, not a full-blown programming language like PHP.
Full documentation for Freemarker can be found at :http://freemarker.org/docs/index.html":http://
freemarker.org/docs/index.html .

MCUXpresso IDE automatically invokes Freemarker, passing it a data model that describes
the memory layout of the target together with a ‘root’ template that is processed to create the
linker script. This root template, #include’s further ‘component’ templates. This structure allows
a linker script to be broken down into various components, and allows a user to provide their
own templates for a component, instead of having to (re-)write the whole template. For example,
component templates are provided for text, data and bss sections, allowing the user to provide a
different implementations as necessary, but leaving the other parts of the linker script untouched.

MCUXpresso IDE

Project

User
Templates

System
Templates

Target
Definition

Freemarker
Template engine

Linker script

Reference

Freemarker reads input files, copying text and processing Freemarker directives and ‘variables’,
and writes an output file. As used by the MCUXpresso IDE managed linker script mechanism,
the input files describe the various components of a linker script which, together with variables
defined by the IDE, are used to generate a complete linker script. Any of the component template
input files may be overridden by providing a local version in the project.

The component template input files are provided as a hierarchy, shown below, where each file
#include’s those files nested below. This allows for individual components of the linker script to be
overridden without having to supply the entire linker script, increasing flexibility, while maintaining
the benefits of Managed Linker Scripts.

Linker script template hierarchy

linkscript.ldt (top level)

« user.ldt (an empty file designed to be overridden by users that is included in linkscript, memory
and library templates)

e user_linkscript.ldt (an empty file designed to be overridden by users that is included in linkscript
only)

« linkscript_common.Idt (root for main content)
« header.Idt (the header for scripts)
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« listvars.Idt (a script to output a list of all predefined variables available to the template)
includes.Idt (includes the memory and library scripts)

section_top.ldt (top of the linker script SECTION directive)
text_section.ldt (text sections for each secondary flash)
 text_section_multicore.ldt (text sections for multicore targets)

« text.ldt (for inserting *text)

 rodata.ldt (for inserting rodata)

main_text_section.ldt (the primary text section)

» global_section_table.Idt (the global section table)

 crp.ldt (the CRP information)

e main_text.Idt (for inserting *text)

¢ main_rodata.ldt (read-only data)

» cpp_info.ldt (additional C++ requirements)

exdata.ldt (the exdata sections)

end_text.Idt (end of text marker)

usb_ram_section.Idt (placement of SDK USB data structures)
stack_heap_sdk_start.ldt (placement of MCUXpresso style heap/stack)
data_section.Idt (data sections for secondary ram)

» data_section_multicore.ldt (data sections for multicore targets)
 data.ldt (for inserting *data)

mtb_default_section.ldt (special section for MTB (cortex-m0+ targets)
uninit_reserved_section.ldt (uninitialised data)

main_data_section.ldt primary data section)

* main_data.ldt (for inserting *data)

bss_section.ldt (secondary bss sections)

 bss.Idt (for inserting *bss)

main_bss_section.Idt primary bss section)

e main_bss.ldt (for inserting *bss)

noinit_section.Idt (no-init data)

noinit_noload_section.ldt (no-load data)

stack_heap_sdk_postdata.ldt (placement of MCUXpresso style heap/stack)
stack_heap_sdk_end.Idt (placement of MCUXpresso style heap/stack)
stack _heap.ldt (define the stack and heap)

checksum.Idt (create the LPC checksum)

section_tail.ldt (immediately before the send of linker SECTION directive)

library.ldt (the standard libraries used in the application)

« user.ldt (an empty file designed to be overridden by users that is included in linkscript, memory

and library templates)

e user_library.ldt (an empty file designed to be overridden by users that is included in library only)

memory.ldt (the memory map)

user.ldt (an empty file designed to be overridden by users that is included in linkscript, memory
and library templates)
user_memory.ldt (an empty file designed to be overridden by users that is included in memory

only)

Linker script search paths

Whenever a linker script template is used, LPCXpresso will search in the following locations, in
the order shown:

* project/linkscripts
« the searchPath global variable
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» The searchPath can be setin a script by using the syntax <#global searchPath="c:/windows/
path;d:/another/windows/path”>

each directory to search is separated by a semicolon ;'

* mcuxpresso_install_dir/ide/Data/Linkscripts
* linker templates can be placed in this directory to override the default templates for an entire
installation
« MCUXpresso IDE internally provided templates (not directly visible to users)

Thus, a project can simply override any template by simply creating a linkscript directory within
the project and placing the appropriate template in there. Using the special syntax “super@” an
overridden template can reference a file from the next level of the search path

e.g. <#include “super@user.ldt">
Linker script templates

Copies of the default linker script templates used within MCUXpresso IDE can be found in the
Wizards/linker directory within the MCUXpresso IDE install.

Predefined variables (macros)
List (sequence) variables (used in #list)

« libraries][]
« list of the libraries to be included in the “lib” script
» for example (Redlib nohost)

libraries[O]=libcr_c.a
libraries[1] =i bcr_eabihel pers. a

« configMemory[]

« list of each memory region defined in the memory map for the project. Each entry has the
following fields defined
e name — the name of the memory region
« alias — the alias of the memory region
* location — the base address of the memory
* size — the size of the memory region
* sizek — the printable size of the memory region in k or M
* mcuPattern
 defaultRAM — boolean indicating if this is the default RAM region
 defaultFlash — boolean indication if this is the default Flash region
* RAM - boolean indicating if this is RAM
« flash — boolean indicating if this is Flash

« for example

confi gMenory[ 0] = name=Mrl ashA512 al i as=Fl ash | ocati on=0x1a000000
si ze=0x80000 si zek=512K bytes ntuPattern=Fl ash fl ash=true RAMf al se
def aul t Fl ash=true defaul t RAM=f al se

confi gMenory[ 2] = nanme=RanlLoc32 al i as=RAM | ocat i on=0x10000000
si ze=0x8000 si zek=32K byt es ntuPattern=RAM f| ash=f al se RAM=true
def aul t Fl ash=f al se def aul t RAM=t r ue

« slaves|]
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« list of the slaves in a Multicore project. This variable is only defined in Multicore projects.
Each entry has the following fields defined
* name — name of the slave
» enabled — boolean indicating if this slave is enabled
» objPath — path to the object file for the slave image
* linkSection — name of the section this slave is to be linked in
* runtimeSection
* textSection — name of the text section
* textSectionNormalized — normalized name of the text section
» dataStartSymbol — name of the Symbol defining the start of the data
» dataEndSymbol — name of the Symbol defining the end of the data
» for example

sl aves[ 0] = nanme=MDAPP obj ect Pat h=${ wor kspace_| oc: / MCB4357_Bl i nky_Dual M)/ Debug
/ MCB4357_Bl i nky_Dual M. axf. o}l i nkSecti on=Fl ash2 runti neSecti on= text Secti on=
.core_nDapp textSecti onNornal i zed=_core_nDappdata Start Synbol =__start_data

dat aEndSynbol =__end_dat a enabl ed=true; </ notextil e>

Simple variables:

CODE - name of the memory region to place the default code (text) section
CRP_ADDRESS - location of the Code Read Protect value

DATA — name of the memory region to place the default data section
LINK_TO_RAM - value of the “Link to RAM"” linker option
STACK_OFFSET - value of the Stack Offset linker option

FLASHnN — defined for each FLASH memory

RAMnN — defined for each RAM memory

basename — internal name of the process

bss_align — alignment for .bss sections

buildConfig — the name of the configuration being built

chipFamily — the chip family

chipName — name of the target chip

data_align — alignment for .data section

date — date string

heap_symbol — name of the symbol used to define the heap
isCppProject — boolean indicating if this is a C++ project

isSlave — boolean indicating if this target is a slave — true iff is a slave core in a multicore system
library_include — name of the library include file

libtype — C library type

memory_include — name of the memory include file

mtb_supported — boolean indicating if mtb is supported for this target
numCores — number of cores in this target

procName — the name of the target processor

project — the name of the project

script — name of the script file

slaveName — is the name of the slave (only present for slaves)
stack_section — the name of the section where the stack is to be placed
start_symbol — the name of the start symbol (entry point)

scriptType — the type of script being generated (one of “script”, “memory”, or “library”)
text_align — alignment for .text section

version — product version string

workspace_loc — workspace directory

year — the year (extracted from the date)
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Extended variables
Two ‘extended’ variables are available:

environment

« The environment variable makes the host Operating System environment variables available.
For example, the Path variable is available as ${environment[‘Path”]}. Note that environment
variables are case sensitive.

systemProperties

¢ The Java system properties are available through the systemProperties variable. For example
the “os.name” system property is available as ${systemProperties[‘0os.name”]}. Note that the
system properties are case sensitive.

Outputting variables

A list of all predefined variables and their values can be output to the generated linker script
by setting the Preference: MCUXpresso IDE -> Default Tool settings -> ... and list predefined
variables in the script

A list of extended variables and their values can be output to the generated linker script by
creating a linkscripts/user.ldt file in the project with the content

<#assign |istvarsext=true>

(This is likely to be used less often, hence the slightly longer winded method of specifying the
option)

Freemarker Linker Script Template Examples

The use of Freemarker linker script templates allows more wide ranging changes to be made to
the generated link script than is possible using the cr_section_macros.h macros. The following
examples provide some examples of this.

Relocating code from FLASH to RAM

If you have specific functions in your code base that you wish to place into a particular block
of RAM, then the simplest way to do this is to decorate the function definition using the macro
__RAMFUNC described earlier in this chapter.

However once you want to relocate more than a few functions, or when you don’t have direct
access to the source code, this becomes impractical. In such case the use of Freemarker linker
script templates will be a better approach. The following sections provide a number of such
examples.

Relocating particular objects into RAM

In some cases, it may be required to relocate all of the functions (and rodata) from a given object
file in your project into RAM. This can be achieved by providing three linker script template files
into a linkscripts folder within your project. For example if it was required that all code/rodata
from the files foo.c and bar.c were relocated into RAM, then this could be achieved using the
following linker script templates:

mai n_text.|dt
(EXCLUDE_FI LE(*f00.0 *bar.o0) .text*)
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mai n_r odat a. | dt
* (EXCLUDE_FI LE(*f 00. 0
*( EXCLUDE_FI LE(*f00.0 *bar.o0) .rodata.*)
* (EXCLUDE_FI LE(*f 00. 0
*( EXCLUDE_FI LE(*f00. 0 *bar.o0) .constdata.*)
. = ALIGN(${text_align});

*bar. o) .rodata)

*bar.o0) .constdata)

mai n_dat a. | dt

*fo0o.0(.text*)

*foo.0(.rodata .rodata.* .constdata .constdata.*)
*bar. o(.text*)

*bar.o(.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});

*(.data*)

What each of these EXCLUDE_FILE lines (in main_text.Idt and main_rodata.ldt) is doing in
pulling in all of the sections of a particular type (for example .text), except for the ones from the
named object files. Then in main_data.ldt, we specify explicitly that the text and rodata sections
should be pulled in from the named object files. Note that with the GNU linker, LD, the first
match found in the final generated linker script is always used, which is why the EXCLUDE_FILE
keyword is used in the first two template files.

Note: EXCLUDE_FILE only acts on the closest input section specified, which is why we have
4 separate EXCLUDE_FILE lines in the main_rodata.ldt file rather than just a single combined
EXCLUDE_LINE.

Once you have built your project using the above linker script template files, then you can check
the generated .Id file to see the actual linker script produced, together with the linker map file to
confirm where the code and rodata have been placed.

Relocating particular libraries into RAM

In some cases, it may be required to relocate all of the functions (and rodata) from a given library
in your project into RAM. One example of this might be if you are using a flashless LPC43xx
MCU with an external SPIFI flash device being used to store and execute your main code from,
but you need to actually update some data that you are also storing in the SPIFI flash. In this
case, the code used to update the SPIFI flash cannot run from SPIFI flash.

This can be achieved by providing three linker script template files into a linkscripts folder
within your project. For example if it was required that all code/rodata from the library
MYLIBRARYPROJ were relocated into RAM, then this could be achieved using the following
linker script templates:

mai n_text.|dt
* ( EXCLUDE_FI LE(*1 i bMYLI BRARYPRQJ. a:) .text*)

mai n_r odat a. | dt
* ( EXCLUDE_FI LE(*1 i bMYLI BRARYPRQJ. a: ) .rodata)
* (EXCLUDE_FI LE(*1 i bMYLI BRARYPRQJ. a:) .rodata. *)
* ( EXCLUDE_FI LE(*1 i bMYLI BRARYPRQJ. a:) . constdata)
*( EXCLUDE_FI LE(*1 i bMYLI BRARYPRQJ. a:) .constdata.*)
. = ALIGN(${text_align});

mai n_dat a. | dt
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*| i bMYLI BRARYPRQJ. a: (. t ext *)

*| i bMYLI BRARYPRQJ. a: (.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});

*(.data*)

Relocating majority of application into RAM

In some situations, you may wish to run the bulk of your application code from RAM — typically
just leaving startup code and the vector table in Flash. This can be achieved by providing three
linker script template files into a linkscripts folder within your project:

mai n_t ext.|dt
*startup_*.o (.text.*)
*(.text. main)
*(.text.__main)

mai n_r odat a. | dt
*startup_*.o (.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});

mai n_dat a. | dt

*(.text*)

*(.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});

*(.data*)

The above linker template scripts will cause the main body of the code to be relocated into the
main (first) RAM bank of the target MCU, which by default will also contain data/bss, as well as
the stack and heap.

If the MCU being targeted has more than one RAM bank, then the main body of the code could
be relocated into another RAM bank instead. For example, if you wanted to relocate the code
into the second RAM bank, then this could be done by providing the following data.ldt file instead
of the main_data.ldt above:

dat a. | dt

<#i f menory. al i as==" RAM2" >

*(.text*)

*(.rodata .rodata.* .constdata .constdata.*)
. = ALIGN(${text_align});

</ #if>

*(.data. $${nenory. al i as}*)

*(.dat a. $${ nenory. nane} *)

Note: memory.alias value is taken from the Alias column of the Memory Configuration Editor.

Configuring projects to span multiple flash devices

Most MCUs only have one bank of Flash memory. But with some parts more than one bank may
be available — and in such cases, by default, the managed linker script mechanism will still place
all of the application code and rodata (consts) into the first bank of flash (as displayed in the
Memory Configuration Editor)..

For example

All information provided in this document is subject to legal disclaimers © 2017 NXP Semiconductors. All rights reserved.

User Guide

Rev. 10.0 — 21 March, 2017 110



NXP Semiconductors MCUXpresso IDE User Guide

12.12

MCUXpresso IDE User Guide -

* most of the LPC18 and LPC43xx parts containing internal flash (such as LPC1857 and
LPC4357) actually provide dual banks of flash.

* some MCUSs have the ability to access external flash (typically SPIFI) as well as their built-in
internal flash (e.g. LPC18xx, LPC40xx, LPC43xx, LPC546xx).

The macros provided in the “cr_section_macros.h” header file provide some ability to control the
placement of specific functions or rodata items into the second (or even third) bank of Flash.
However the use of Freemarker linkers script templates allow this to be done in a much more
powerful and flexible way.

One typical use case for this is a project which stores its main code and data in internal flash, but
additional rodata (for example graphics data for displaying on an LCD) in the external SPIFI flash.

For instance, consider an example project where such rodata is all contained in a set of specific
files, which we therefore want to place into the external flash device. One very simple way to do
this is to place such source files into a separate source folder within your project. You can then
supply linker script templates to place the code and rodata from these files into the appropriate
flash.

For example, for a project using the LPC4337 with two internal flash banks, plus external SPIFI
flash, if the source folder used for this purpose were called ‘spifidata’, then placing the following
files into a ‘linkscripts’ directory within your project would have the desired effect:

text.ldt
<#if menory.alias=="Fl ash3">
*spifidatal/ *(.text*)
</ #if>
*(.text_${nenory.alias}*) /* for conpatibility with previous rel eases */
*(.text_${nenory.nane}*) /* for conpatibility wth previous releases */
*(.text.$${nenory. al i as}*)
*(.text.$${nenory. name}*)

rodat a. | dt
<#if menory.alias=="Fl ash3">
*spi fidata/*(.rodata*)
</ #if>
*(rodata. $${ menory. al i as}*)
*(rodat a. $${ menory. nane} *)

Note: the check of the memory.alias being Flash3 is to prevent the code/rodata items from ending
up in the BankB flash bank (which is Flash2 by default).

Disabling managed linker scripts

It is possible to disable the managed linker script mechanism if required and provide your own
linker scripts, but this is not recommended for most users. In most circumstance, the facilities
provided by the managed linker script mechanism, and its underlying Freemarker template
mechanism should allow you to avoid the need for writing your own linker scripts. But if you do
wish to do this, then untick the appropriate option at:

Properties -> C/C++ Build -> Settings -> MCU Linker -> Managed Linker Script

And then in the field Script Path provide the name and path (relative to the current build directory)
of your own, manually maintained linker script.

In such cases you can either create your own linker script from scratch, or you can use the
managed linker scripts as a starting point. One very important point though is that you are advised
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not to simply modify the managed linker scripts in place, but instead to copy them to another
location and modify them there. This will prevent any chance of the tools accidentally overwriting
them if at some point in the future you turn the managed make script mechanism back on.

Note: if your linker script includes additional files (as the managed linker scripts do), then you
will also need to include the relative path information in the include inside the top level script file.

For more details of writing your own linker scripts, please see the GNU Llinker (Id) documentation:
Help -> Help Contents -> Tools (Compilers, Debugger, Utilities) -> GNU Linker

There is also a good introduction to linker scripts available in Building Bare-Metal ARM Systems
with GNU: Part 3 at:

http://www.embedded.com/design/mcus-processors-and-socs/4026080/Building-Bare-Metal-
ARM-Systems-with-GNU-Part-3
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LPC43xx Multicore Projects

The LPC43xx family of MCUs contain a Cortex-M4 “master” core and one or more Cortex-MO
“slave” cores. After a power-on or Reset, the master core boots and is then responsible for
booting the slave core(s). However, this relationship only applies to the booting process; after
boot, your application may treat any of the cores as the master or a slave.

The MCUXpresso IDE allows for the easy creation of “linked” projects that support the targeting
of LPC43xx Multicore MCUs. For more information on creating and using such multicore projects,
please see the FAQ at

https://community.nxp.com/message/637967

LPC541xx Multicore Projects

Some members of the LPC541xx family of MCUs contain a Cortex-M4 core and a Cortex-M0O+
core (with the Cortex-M4 being the master, and the MO+ the slave). After a power-on or Reset, the
master core boots and is then responsible for booting the slave core. However, this relationship
only applies to the booting process; after boot, your application may treat either of the cores as
the master or the slave.

The MCUXpresso IDE allows for the easy creation of “linked” projects that support the targeting of
LPC541xx Multicore MCUs. For more information on creating and using such multicore projects,
please see the FAQ at

https://community.nxp.com/message/630715
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MCUXpresso IDE provides quick access to a range of project settings via the QuickStart Panel
as shown below:

) Quickstart Panel 2 (9= Global Variables (*)= Variables ©s Breakpoints o= Qutline

- MCUXpresso IDE (Pro Edition)
IDE

- Start here

. New project...

. Import SDK example(s)...

® Import project(s) from file system...

4, Build 'frdmkl28z_demo_apps_bubble' [Delug]

& Clean 'frdmkl28z_demo_apps_bubble' [Debug]
#’ Debug 'frdmkl28z_demo_apps_bubble' [Debug]

¥ Edit 'frdmkl28z_demo_apps_bubble' project settings
 Quick Settings>:

1 & Defined symbols [frdmkl28z_demo_apps_bubble Debug]

B Export project(s} 2 1 Undefined symbols [frdmki28z_demo_apps_bubble Debug]

JE Export project(s) 3 g3 Include paths [frdmkl28z_demo_apps_bubble Debug]

5 Build all projects 4 &3 Library search paths [frdmki282_demo_apps_bubble Debug]
5 & Libraries [frdmkl28z_demo_apps_bubble Debug]
6 (# SDK Debug Console »
7 (£ Set Floating Point type >
| & 2 Set library/header type >

Note: These settings apply to the selected project’s default build configuration only and simplify
access to commonly used settings normally accessed from Properties -> C/C++ Build -> Settings

OO~ WDN B

. Defined symbols — select to edit the (-D) symbols

. Undefined symbols — select to edit the (-U) symbols

. Include paths — select to edit the (-) the include paths

. Library search paths — select to edit the (-L) the library

. Libraries — select to edit the (-I) the linker libraries search

. SDK Build Console — select the SDK Build Console’s PRINTF output to be via UART or to

redirect via the C libraries printf function
 selecting printf will increase the size of the project binary compared to UART output

« for semihosted printf output to generated, the project must be linked against a suitable
library.

« for more information see the section on Semihosting and the use of printf [75]

. Set Floating Point type — select to switch between the available Floating Point options

« for more information see the section on Hardware Floating Point Support [120]

. Set Library/Header type — select to switch the current C/C++ Library

« for more information see the section on C/C++ Library Support [72]

Launch Configurations

Within each MCUXpresso IDE project, there will be a “launch configuration file” for each build
variant, which is used to store the settings for a debug connection for that build configuration.
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These will be created in the root directory of a project the first time that you launch a debug
session for that project and are typically called

{proj name} Debug. | aunch
{proj name} Rel ease. | aunch

Normally, there is no need to touch the launch configurations, as the default settings created
by the tools will be suitable. However, in some circumstances, you may need to modify them —
typically under direction from an FAQ. In such cases, the best way to do this is via the “Launch
Configurations” entry on the context sensitive menu available from the Project Explorer view...

[(5 Project Explorer 3% 7, Peripherals+ lili Registers & Symbol Viewer

» SLPI New Lg
» ESLPI Go Into
:g:‘:‘: Open in New Window
& Copy ®C
Paste
*& Delete =
Remove from Context
Source >
Move...
Rename... F2

i1 IMport...
# Export...

Build Project

Clean Project

Refresh F5
Close Project

Close Unrelated Projects

Build Configurations
Build Targets
Index

Run As

Debug As

Profile As

Restore from Local History...
35 Edit cunent.

Smart update ## Create new...

Utilities ## Create and edit new...

Tools % Delete...

? FUmICASE Coce Arsl y=tx % Delete JTAG configurations...
Bam

Compare With
Configure

¥YyYyY ¥Y¥Y%¥Y

yY yvYL
y¥yYyYyrwy

Yy

Properties Bl

A number of options are available here:

Edit current

¢ Allows various debug settings to be modified
¢ We do not recommend this for normal use unless you are explicitly instructed.

Create New

¢ Creates launch configurations for the selected project, if they do not already exist.
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« Normally you will not need this option as it is carried out automatically the first time that you
debug your project. However if you Delete your launch configuration and want to then edit a
new default launch configuration before debugging, then you will need to use this option to
do so.

Create and Edit New

¢ Allows new launch configurations to be created and immediately opened for editing.

Delete Current

« Allows the launch configurations for the selected project (or projects) to be deleted.

¢ This can be useful as it allows you to put the debug connection settings back to the default
after making modifications for some reason, or if you are moving your project to a new version
of the tools, and want to ensure that your debug settings are correct for this version of the tools.

Delete JTAG Configuration

¢ Allows the JTAG configuration files for the selected project (or projects) to be deleted. These
files are stored in the Debug/Release subdirectories.

Editing a Launch Configuration

WARNING: - Modifying the default settings for a launch configuration can prevent a successful
debug connection from being made. Make changes with care!

After selecting the “Edit current” or “Create and Open New” launch configuration menu entry, you
will then see a new dialog box pop up, which looks like the following...
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Create, manage, and run configurations PP

v . C/C++ (NXP Semiconductors) MCU Application’
B MKB4FN1MOxxx12_Project Debug
B MKB4FN1MOxxx12_Project Release
TOTT

[£]C/C++ Attach to Application
[E1C/C++ Postmortem Debugger
[E1C/C++ Remote Application
[c]GDB Hardware Debugging
[E2GDB PEMicro Interface Debugging
EAGDB Segger Interface Debugging

Name: MKB4FN1MOxxx12_Project Debug

[El Main (% Source |[] Commor{| %5 Debugger

+| Stop on startup at: | main Force hardware breakpeoint

Debugger Options

Main
Debug options for NXP MKB4FN1MOxxx12 (cortex-md)

Debug Connection SWD | ¥

B Launch Group Configuration Option v Value
al: Additional options
iz| Attach only False
ahl: Connect Script kinetisconnect.scp
abf- Debug Level 2
i/ Debugger memory cache Disable
isconnect behavior cont

Load image True

Maximum wire speed
iz Memory Access Checking off
abl: Pre launch command
iZ| Reset Handling
=t[: Reset Script
:2/ Run/Continue image cont

Semihosting support On
i Vector catch false

=tf: Wirespeed (Hz)

Miscellaneous
Emulator selection  LinkServer i

Edit scripts...

Debug options template

Debua Configuration (Y v Show all

Filter matched 11 of 11 items

A
( 3/- Close

Most settings that you may need to modify can be found in the Debugger tab, in the Target
configuration sub-tab (as shown in the above screenshot).

Some examples of modifications that you may need to make in particular circumstances are:

* Changing the initial breakpoint on debug startup
« When the debugger starts, it automatically sets an initial (temporary) breakpoint on the first
statement in main(). If desired, you can change where this initial breakpoint is set, or even
remove it completely.
« Modifying the Debugger connect behavior
« via a Connect Script e.g. kinetisconnect.scp
e Connecting to a target via JTAG rather than SWD
« if supported by the target, you can edit the Debug type
¢ Connecting to a running syste
« set Attach only to True

How do | switch between Debug and Release builds?

Changing the build configuration of a single project

You can switch between Debug and Release build configurations by selecting the project you
want to change the build configuration of in the Project Explorer view, then using one of the
below methods:
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« Select the menu item Project->Build Configuration->Set Active and select Release or
Debug as necessary

¢ Use the drop down arrow next to the ‘sundial’ (Manage configurations for the current project)
icon on the main toolbar (next to the ‘hammer’ icon) and select Release or Debug as
necessary. Alternatively you can use the drop down next to the *hammer’ icon to change the
current configuration and then immediately trigger a build.

AB-iQ-e P iEr
118 4 41 Debug (Debug build) :
2 Release (Release build)

* Right click in the Project Explorer view to display the context sensitive menu and select Build
Configurations->Set Active entry.

Changing the build configuration of multiple projects

Itis also possible to set the build configuration of multiple projects at once. This may be necessary
if you have a main application project linked with a library project, or you have linked projects for
a multicore MCU such as an LPC43xx or LPC541xx (one project for the master Cortex-M4 CPU
and another for a slave Cortex-M0/M0O+ CPU).

To do this, you first of all you need to select the projects that you wish to change the build
configuration for in the Project Explorer view — by clicking to select the first project, then use
shift-click or control-click to select additional projects as appropriate. If you want to change all
projects, then you can simply use Ctrl-A to select all of them.

Note it is important that when you select multiple projects, you should ensure that none of the
selected projects are opened out — in other words, when you selected the projects, you must not
have been able to see any of the files or the directory structure within them. If you do not do this,
then some methods for changing the build configuration will not be available.

Once the required projects are selected, you then need to simply change the build configuration
as you would do for a single project.

Editing Hints and Tips

The editor view within Eclipse, which sits under the MCUpresso IDE, provides a large number
of powerful features for editing your source files.

Multiple views onto the same file
The Window -> Editor menu provides several ways of looking at the same file in parallel.

e Clone : two editor views onto the same file
e Toggle Split Editor : splits the view onto the current file into two (either horizontally or
vertically)

Viewing two edited files at once

To see more than one file at the same time, simply to click one the file tabs that you have open
in the editor view, and then keep the mouse button held down and you should just be able to
drag that file tab across to the right. After you've moved to the side, or below, slightly, and outline
should be appear showing you where that tab will be placed once you let go of the mouse button.

Source folding

Within the editor view, functions, structures etc may be folded to show the structure and hide
the detail.
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To enable folding, right click in the margin of the editor view to bring up the context sensitive
menu, then select Folding->Enable Folding

You can then click on the + or - icon that now appear in the margin next to each function, structure,
etc, to expand or collapse it, or use the Folding->Expand all and Folding->Collapse all options
from the context sensitive menu

Various settings for Folding can also be controlled through Window -> Preferences -> C/C++
-> Editor -> Folding

Editor templates and Code completion

Within the editor, a number of related pieces of functionality allow you to enter code quickly and
easily.

First of all, templates are fragments of code that can be inserted in a semi-automatic manner to
ease the entering of repetive code — such as blocks of code for C code structures such as for
loops, if-then-else statements and so on.

Secondly, the indexing of your source code that is done by default by the tools, allows for auto
completion of function and variable names. This is known as “content assist”.

¢ Ctrl-Space at any point will list available editor template, function names etc
« Citrl-Shift-Space will display function parameters
« Alt-/ for word completion (press multiple times to cycle through multiple options).

In addition, the predefined templates are user extensible via Window -> Preferences -> C/C+
+ -> Editor -> Templates

Brace matching
The editor can highlight corresponding open and closing braces in a couple of ways.

First of all, if you place the cursor immediately to the right of a brace (either an opening or closing
brace), then the editor will display a rectangle around the corresponding brace.

Secondly, if you double click immediately to the right of a brace, then the editor will automatically
highlight all of the text between this brace and the corresponding one.

Syntax coloring

Syntax Coloring specifies how your source code is rendered in the editor view, with different
colors used for different elements of your source code. The settings used can be modified in:

* Window -> Preferences -> C/C++ -> Editor -> Syntax Coloring*

Note that general text editor settings such as the background color can be configured in:
Window -> Preferences -> General -> Text Editors

Fonts may be configured in:

Window -> Preferences -> General -> Appearance -> Colors and Fonts

Comment/uncomment block
The editor offers a number of ways of comment in or out one or more lines of text. These can

be accessed using the Source entry of the editor context-sensitive menu, or using the following
keyboard shortcuts...
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¢ Select the line(s) to comment, then hit Ctrl-/ to comment out using // at the start of the line, or
uncomment if the line is currently commented out.

¢ Select the line(s) to comment, then hit Ctrl-Shift-/ to block comment out (placing /* at the start
and */ at the end).

* To remove a block comment, hit Ctrl-Shift-\.

Format code

The editor can format your code to match the coding standards in use (Window -> Preferences
-> C/C++ -> Code Style). This can automatically deal with layout elements such as indentation
and where braces are placed. This can be carried out on the currently selected text using the
Source->Format entry of the editor context-sensitive menu, or using the keyboard shortcuts Ctrl-
Shift-F. If no text is selected, then the format will take place on the whole of the current file.

Correct Indentation

As you enter code in the editor, it will attempt to automatically indent your code appropriately,
based on the code standards in use, and also the layout of the preceding text. However in
some circumstances, for example after manually laying text out, you may end up with incorrect
indentation.

This can usually be corrected using the Source->Correct Indentation entry of the editor context-
sensitive menu, or using the keyboard shortcuts Ctrl-I.

Alternatively use the “Format code” option which will fix other layout issues in addition to
indentation.

Insert spaces for tabs in editor

You can configure the IDE so that when editing a file, pressing the TAB key inserts spaces instead
of tab characters. To do this go to

Window -> Preferences -> General -> Editors -> Text Editors

and tick the “Insert spaces for tabs” box.If you tick “Show white-space characters” you can see
whether a tab character or space characters are being inserted when you press the TAB key

Replacing tabs with spaces
To replace existing tabs with spaces throughout the file, open the Code Style preferences:

Window -> Preferences -> C/C++ -> Code Style

« Select a Code Style profile and then select Edit...
¢ Choose the Indentation tab

For the Tab policy, select Spaces only

Apply the changes.

* Note. If the Code Style has not been edited before, the Profile must be renamed before the
change can be applied.

¢ The new style will be applied when the source is next formatted using Source -> Format

Hardware Floating Point Support

Most ARM-based systems — including those based on Cortex-M0, MO+ and M3, have historically
not implemented any form of floating point in hardware. This means that any floating point
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operations contained in your code will be converted into calls to library functions that then
implement the required operations in software.

However many Cortex-M4 based MCUs do incorporate a single precision floating point hardware
unit. Note that the optional Cortex-M4 floating point unit implements single precision operations
(C/C++float) only. Thus if your code makes use of double precision floating point (C/C++ double),
then any such floating point operations contained in your code will still be converted into calls to
library functions that then implement the required operations in software.

Similarly, Cortex-M7 based MCUs may incorporate a single precision or double precision floating
point hardware unit.

Floating Point Variants

When a hardware floating point unit is implemented, ARM define that it may be used in one of
two modes.

SoftABI

¢ Single precision floating point operations are implemented in hardware and hence provide a
large performance increase over code that uses traditional floating point library calls, but when
calls are made between functions any floating point parameters are passed in ARM (integer)
registers or on the stack.

« SoftABIl is the ‘most compatible’ as it allows code that is not built with hardware floating point
usage enabled to be linked with code that is built using software floating point library calls.

HardABI

« Single precision floating point operations are implemented in hardware, and floating point
registers are used when passing floating point parameters to functions.

HardABI will provide the highest absolute floating point performance, but is the ‘least compatible’
as it means that all of the code base for a project (including all library code) must be built for
HardABI.

Floating point use — Preinstalled MCUs

When targeting preinstalled MCUs, MCUXpresso IDE generally assumes that when Cortex-M4
hardware floating point is being used, then the SoftABI will be used. Thus generally this is the
mode that example code (including for example LPCOpen chip and board libraries) are compiled
for. This is done as it ensures that components will tend to work out of the box with each other.

When you use a project wizard for a Cortex-M4 where a hardware floating point unit may be
implemented, there will be an option to enable the use of the hardware within the wizard’s options.
This will default to SoftABI — for compatibility reasons.

Selecting this option will make the appropriate changes to the compiler, assembler and linker
settings to cause SoftABI code to be generated. It will also typically enable code within the startup
code generated by the wizard that will turn the floating point unit on.

You can also select the use of HardABI in the wizards. Again this will cause appropriate tool
settings to be used. But if you use this, you must ensure that any library projects used by your
application project are also configured to use HardABI. If such projects already exist, then you can
manually modify the compiler/assembler/linker settings in Project Properties to select HardABI.

Warning : Creating a project that uses HardABI when linked library projects have not been
configured and built with this option will result in link time errors.
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Floating point use — SDK installed MCUs

When targeting SDK installed MCUs, MCUXpresso IDE generally assumes that when hardware
floating point is available, then the HardABI will be used. This will generally work without problem
as generally projects for such MCUs contain all required code (with no use of library projects).

However it is still possible to switch to using SoftABI using the “Advanced Properties settings”
page of the [New project" and “Import SDK examples” wizards.

Modifying floating point configuration for an existing project

If you wish to change the floating point ABI for an existing project (for example to change it from
using SoftABI to HardABI), then go to:

Quickstart -> Quick Settings -> Set Floating Point type

and choose the required option.

Alternatively you can configure the settings manually by going to:
Project -> Properties -> C/C++ Build -> Settings -> Tool Settings

and changing the setting in ALL of the following entries:

*« MCU C Compiler -> Architecture -> Floating point
« MCU Assembler -> Architecture & Headers -> Floating point
¢ MCU Linker -> Architecture -> Floating point

Note: For C++ projects, you will also need to modify the setting for the MCU C++ Compiler.
Warning: Remember to change the setting for all associated projects, otherwise linker errors
may result.

Do all Cortex-M4 MCUs provide floating point in hardware?

Not all Cortex-M4 based MCUs implement floating point in hardware, so please check the
documentation provided for your specific MCU to confirm.

In particular with some MCU families, some specific MCUs may not provide hardware floating
point, even though most of the members of the family do (for example the LPC407x_8x). Thus it
is a good idea to double check the documentation, even if the project wizard in the MCUXpresso
IDE for the family that you are targeting suggests that hardware floating point is available.

Why do | get a hard fault when my code executes a floating point
operation?

If you are getting a hard fault when your application tries to execute a floating point operation,
then you are almost certainly not enabling the floating point unit. This is normally done in the
LPCOpen or SDK initialisation code, or else in the startup file that MCUXpresso IDE generates.
But if there are configuration issues with your project, then you can run into problems.

For more information, please see the Cortex-M4 Technical Reference Manual, available on the
ARM website.

LinkServer Scripts

LinkServer debug connections offer additional functionality through the use of scripts. There are
two ‘flavours’ of Redlink scripts — Reset and Connect. Connect scripts are used when establishing
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a connection to the target; Reset scripts are used when reseting a target (to start it running, for

example).

LinkServer scripts are written in a simple version of the BASIC programming language. In this
variant of BASIC, 26 variables are available (%a thru %z). On entry to the script some variable

have assigned values:

% is the PC
% is the SP
% is the XPSR

On exit from the script %a is loaded into the PC and %b is loaded into the SP, thus providing a

way for the script to change the startup behavior of the application.
They offer functionality as shown below:

Generic BASIC like functions that only work inside scripts

GOTO ' Li neNunber"'
IF 'relation' THEN 'statenent’

REPEAT : Start of a repeat block

UNTIL 'relation' End with condition of repeat block
BREAKREPEATTO ' Li neNunber '
GOSUB ' Li neNunber '

RETURN

TIME : Returns a 10ms increnenting count fromthe host

Premature end of a repeat |oop

Generic BASIC like functions

PEEKS{[ THI S] |
PEEK16{[ TH S| |
PEEK32{[ TH S |

[' Probel ndex' 'Corelndex']} 'Address'
' Corelndex']} 'Address’

' Corelndex']} 'Address’

[" Probel ndex'
[" Probel ndex'

EXIT: Exit the server

LI ST: Lists the script

NEW Erases script from nenory
RENUMBER: Renunbers in increments of 10
LOAD ' FI LENAVE' :
SAVE ' FI LENAME' :

Loads a script fromcurrent directory
Saves a script to current directory

"LengthLimt in Bytes'

POKES{[ THI S] | ['Probelndex' 'Corelndex']} 'Address' 'Data'

POKE16{[ THI'S] | [' Probel ndex' 'Corelndex']} 'Address' 'Data'

POKE32{[ THI S] | [' Probel ndex' 'Corelndex']} 'Address' 'Data'

QPOKE32{[ THI S] | ['Probel ndex' 'Corelndex']} 'Address' 'Data'
QSTARTTRANSFERS{[ THI S] | [' Probel ndex' ' Corelndex']}

MEMBAVE{[ THI S] | ['Probelndex' 'Corelndex']} 'FileNane' 'Byte StartAddress'
MEMLOAD{[ THI S] | [' Probel ndex' 'Corelndex']} 'Byte StartAddress'
MEMDUMP{[ THI' S] | [' Probel ndex' 'Corelndex']} 'Byte StartAddress'

'Length in Bytes'

‘Length in Bytes'

Probe related functions

PROBELI ST :
PROBENUM : Returns the nunber of probes attached
PROBEOPENBY! NDEX ' Pr obel ndex'
PROBECLOSE ' ProbeHandl e’
PROBECLCOSEBY! NDEX ' Pr obel ndex'
PROBETI ME ' Pr obel ndex'

Returns a uni que probe handl e

Returns an error code

Returns time fromfirmvare in the probe
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PROBESTATUS : Returns an i

PROBEI SOPEN ' Pr obel ndex’
PROBEHASJTAG ' Pr obel ndex'
PROBEHASSWD ' Pr obel ndex’
PROBEHASSW ' Pr obel ndex’
PROBEHASETM ' Pr obel ndex’

PROBEVERSI ON ' Probel ndex' :

ndexed summary of the status of the probes connected to the system

Returns version informati on about probe firmare

PROBEDI AGNCSTI CS ' Pr obel ndex' Return counts of

responses from probe

Core/TAP related functions

CORELI ST ' Probel ndex' :
CORECONFI G[[THI'S] | [' Probelndex']}:
CORESCONFI GURED ' Pr obel ndex'

Returns |ist of TAPs/Cores found connected to specified probe

Configures the scanchain

COREREADI D ' Pr obel ndex’

' Cor el ndex’

Wire related functions

W RESWDCONNECT{ [ TH S] |
W REJTAGCONNECT{ [ THI S] |

[

W REHOLDRESET ' Pr obel ndex'
W RESTATUS ' Pr obel ndex’

W RESETSPEED ' Pr obel ndex'
W REGETSPEED ' Pr obel ndex'

[' Probel ndex']}:
W RETI MEDRESET ' Pr obel ndex’

Probel ndex']}: Returns the DPID

"Timeln_ns':
"State'

pulls reset and returns the end state of the wire
pulls reset and returns the end state of the wire
Returns the status of the wire connection on the probe specified
' Speedl nHz' : Requests a particular wre speed

Returns the current wire speed

W RESETI DLECYCLES ' Pr obel ndex' ' Cycles':
transactions

W REGETI DLECYCLES ' Pr obel ndex'

' Probel ndex'

W REGETPROTOCOL ' Pr obel ndex’

Requests a specific nunber of

Returns the current nunber of debug idle cycles W RElI SCONNECTED|

idl e cycles between debug

SELECTPROBECORE ' Probel ndex' ' Corel ndex’ sets up for use with foll owi ng commands
TH S : displays the current Probe, Core pair

Cortex-M related functions
CM NI TAPDP{[ THI S] | ['Probelndex' 'Corelndex']}: Initialize a CWk core ready for debug
connect i ons
CMARI TEDP{[ THI' S] | ['Probelndex' 'Corelndex']} 'REG 'DATA : returns zero on success
CMARI TEAP{[ THI S] | [' Probelndex' 'Corelndex']} 'REG 'DATA : returns zero on success

CVREADDP{[ THI S] |
CVREADAP{[ THI S] |
on AP reads)

[' Probel ndex' 'Corelndex']} 'REG :

[' Probel ndex' 'Corelndex']} 'REG :

CMAATCHSET{[ THI S| | [' Probel ndex'
CMAATCHCLEAR{ [ TH S] |

' Corelndex']} ' DWII ndex'
[" Probel ndex'

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers
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CMCLEARERRORS{[THI S] | [' Probel ndex' ' Corel ndex' ]}
CVHALT{[THI S] | ['Probel ndex' ' Corelndex']}

CMRUN{[THI S] | ['Probelndex' 'Corelndex']}

CVMREGS{[THI S] | [' Probel ndex' 'Corelndex']}

CMARI TEREG[[ THI S] | [' Probel ndex' 'Corelndex']} 'RegNunber'
CVREADREG[[ THI S] | [' Probel ndex' 'Corelndex']} 'RegNumber'
CMAATCHLI ST{[ THI'S] | [' Probel ndex' ' Corel ndex']}

' Corelndex']} ' DWII ndex'

CMBREAKLI ST{[THI S] | ['Probel ndex' ' Corelndex']} Li st the hardware breakpoints
CMBREAKSET{[ THI S] | ['Probel ndex' 'Corelndex']} 'Address' Set an FPB
CMBREAKCLEAR{[ THI S] | [' Probel ndex' 'Corelndex']} ['Address'] Cl ear an FPB
CMBYSRESETREQ{[THI' S] | [' Probel ndex' ' Corel ndex']} System reset request

' Val ue'

"Address' ['[RW|R W]
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CWECTRESETREQ([ THI S] | [' Probelndex' 'Corelndex']} : Core reset request
CVRESETVECTORCATCHSET{[ THI S] | ['Probel ndex' 'Corelndex']} : Enable reset vector catch
CVRESETVECTORCATCHCLEAR{[ THI S] | [' Probelndex' 'Corelndex']} : Disable reset vector catch

Scripts can be specified within a LinkServer launch configuration to be run before a connection
and/or before a reset.

Debugging code from RAM

MCUs will have well defined boot strategies from reset, typically they will boot from code in
internal flash.

On occasion it can be useful to run and debug code directly from RAM. Since an MCU will not
boot from RAM a scheme is needed to take control of the debuggers reset mechanism. This can
be achieved the use of a LinkServer reset script.

Within MCUXpresso IDE, certain precreated scripts are located at:

{install dir}/bin/Scripts

Contained in this directory is a script called kinetisRamReset.scp (see below).

10 REM Kinetis K64F Internal RAM (@ 0x20000000) reset script

20 REM Connect script is passed PC/SP fromthe vector table in the i mage by the debugger
30 REM For the sinple use case we pass them back to the debugger with the | ocation of the
45 REMreset context.

40 REM

50 REM Syntax here is that '~ commands a hex output, all integer variables are a%to z%
70 REM Find the probe index

80 p% = probefirstfound

90 REM Set the 'this' probe and core

100 sel ect probecore p% 0

110 REM NOTE!'! Vector table presuned RAM | ocation is address 0x20000000

120 REM The script passes the SP (%) and PC (%) back to the debugger as the reset context.
130 b% = peek32 this 0x20000000

140 a% = peek32 this 0x20000004

150 print "Vector table SP/PC is the reset context."

160 print "PC = "; ~a%
170 print "SP = "; ~b%
180 print "XPSR = "; ~c%
190 end

This reset script makes an assumption that the user intends to run code from RAM at 0x20000000
— this is the value of the SRAM_Upper RAM block on Kinetis parts.

Note: To build a project to link against RAM, you can simply delete any flash entries within the
projects memory configuration. If the MCUXpresso IDEs default linker settings are used then
project will link to the first RAM block in the list. For many Kinetis parts, this address will match the
expected address within the script. For some parts (for example KLxx) however, the first RAM
block may take a different value. This problem can be resolved by editing the script or modifying
the projects RAM addresses.

For users if LPC parts, the RAM addresses will be different but the principal remains the same.

Within the Scripts directory, you will find an RAM reset script for the LPC18LPC43 parts, this
script is identical to the one above apart from the assumed RAM address.
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Finally, to use the script, simply edit the projects launch configuration for the ‘Reset Script’ entry,
browse to the appropriate ‘RAMReset.scp’ script. For information about launch configurations
please see the section "Launch Configuration Files::#launchconfig

Note: When executing code from RAM, the projects Vector table will also be located at the
start of the RAM block. Cortex M MCUs can locate their vector table using an internal register
called VTOR (the vector table offset register). Typically this register will be set automatically by
a projects startup or init code. However, if execution fails when an interrupt occurs, check that
this register is set the the correct value.

The Console View

The Console View contains a number of different consoles providing textual information about the
operation of various parts of MCUXpresso IDE. It is located by default in the bottom right of the
Debug Perspective, in parallel with a number of other views — including the “Installed SDKs” view.

The actual consoles available within the Console view will depend upon what operations are
currently taking place — in particular a number of consoles will only become available once a
debug session is started.

The currently displayed console will provide a local toolbar, with icons to do things like copying
the contents of the console or clearing its contents.

To see the list of currently available consoles, and, if required, change to a different one..

1. Switch to the Console View

2. Using the toolbar within the Console View click on the drop-down arrow next to the Display
Selected Console icon (which looks like a small monitor)

3. Select the require console from the drop down list

[ Installed SDKs [] Properties & Console 22 |* Problems [] Memory 8 Instruction Trace G SWO Trace Config B2 Power Measurement Tg |
= IETEREEER: ERd= M
frdmk64f_demo_apps bubble =y cpT Global Build Console 3

[MCUXpresso Semihostin i
[E] 2 CDT Build Console [frdmk64f_demo_apps_bubble]

‘ # 3 FreeRTOS Task Aware Debugger Console version 1.0.2 (201702241004
4 frdmkf4f_demo_apps_bubble Debug [C/C++ (NXP Semiconducters) MCU Application] gdb traces
. 5 frdmk64f_demo_apps_bubble Debug [C/C++ (NXP Semiconductors) MCU Application] arm-none-eabi-gdb (7.12.0.20161204)
6 RedlinkServer
7 frdmko4f_demo_apps_bubble Debug messages
8 frdmki4f_demo_apps_bubble Debug [C/C++ (NXP Semiconductors) MCU Application] frdmbkG4f_demo_apps_bubble.axf

&
=
Console types
Consoles you will typically see include the following...
Build Console and Global Build Console
The Build Console (sometimes referred to as the Build Log) is used by the MCUXpresso IDE
build tools (compiler,linker, etc) to display output generated when building your project. In fact
MCUXpresso IDE has two build consoles — one of which records the output from building the
current project, and the second a global build console which will record the output from building

all projects.

By default, the number of lines stored in the Build Console is limited to 500 lines. You can increase
this to any reasonable number as follows:

1. Select the Windows->Preferences menu option
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2. Now choose C/C++ -> Build -> Console
3. Increase the "Limit Console out (humber of lines)" to a larger number, for instance 5000.

Note: This setting, like most within the MCUXpresso IDE is saved as part of your workspace.
Thus you will need to make this change each time you create a new workspace.

Other options that can be set in Preferences include whether the console is cleared before a
build, whether it should be opened when a build starts, and whether to bring the console to the
top when building.

Once your build has completed, then if you have any build errors displayed in the console, clicking
on them will, by default, cause the appropriate source file to be opened at the appropriate place
for you to fix the error.

FreeRTOS Task Aware Debugger Console

This console displays status about the FreeRTOS TAD views. For more details, please see the
MCUXpresso IDE FreeRTOS Debug Guide.

gdb traces and arm-none-eabi-gdb Consoles

These consoles give access to the GDB command line debugger, that sits underneath the
MCUXpresso IDE’s graphical debugging front end.

RedlinkServer Console

This console gives access to the server application that sits at the bottom of the debug stack
when using a debug probe connected via the MCUXpresso IDEs native “LinkServer” debugging
mechanism.

Debug messages Console

The Debug Messages Console (sometimes referred to as the Debug Log) is used by the debug
driver to display additional information that may be helpful in understanding connection issues
when debugging your target MCU.

Semihosting Console

This console, generally displayed with .axf, allows semihosted output from the application running
on the MCU target to be displayed, and potentially for input to be sent down to the target.

Copying the contents of a console

Occasionally, you may wish to copy out the contents of a console. For instance, the MCUXpresso
IDE support team may ask you to provide the details of your Build Console in a forum thread.
To do this:

1. Clean, then build your project.

. Select the appropriate Build Console as above:

. Select the contents (e.g. Ctrl-A)

. Copy to the clipboard (e.g. Ctrl-C).

. Paste from clipboard into forum thread (e.g. Ctrl-V). If there is a large amount of text in the
build console, it is advisable to paste it into a text file, which can be ZIPed if appropriate.

a b~ 0N

Note that some console will provide a button in their local toolbar to copy or save out their
contents.
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Relocating and duplicating the Console view

By default the Console View is positioned in parallel with a number of other views. This can
mean, if a console is being regularly updated with new output (for instance the view displaying
semihosted output from the application running on the target MCU), then by default this may
cause the console to keep jumping to the forground — hence hiding other views that you are using
(for instance one of the SWO Trace views)

To avoid this you may wish to relocate the Console. To do this ...

1. Click and hold down on the Console View

2. Continue to hold down, and drag the cursor to the location you want to Console view to be
displayed
3. Then release the mouse click, and the Console view will be placed at the required position

[ " @ Consale
} . - . Fol N -,
1F (hyingle » MMILE_UPPER DR Tl _dnrma_spps_brebisle Dubeag |C/C + + 40 damusardhucta
PR 3

kegls = 10y Evangle = iy

W (g whegle © MMEILE_LOWER_BOME) IF (g wangle o AMGLE_LOwWER_Boun

shegle = 0y fsingle = 8;

O o S — Reledse the mouse ¢lick; and the
.y L Console view will be placed at the:
Click and hold down on o Sroe Gl required.pesitipn  #mee ¢

the Console View Petemerc Soomir |3 | pobebcnd

5 Cuata Wakch ol

P

SR A

-
. ]

®

| btnbe_. [ Poopesi. D) Comcie | [£] Probbme ([] Memory b lnstrue_ 20 S0 Te_ w00 ower _

L] . B FR 2@~
tedrrichld_derme_apps fubbie Debug [£/0 0 » (NP Sermveensucters) MCU Apphestion)] fdmihld deme,_app bubbie.ad
» .

nye the cursor to the location you
= want to Console view to be
displayed

Another alternative is to spawn a duplicate instance of the Console view. This allows multiple
consoles to be visible at the same time. To do this use the Open Console button on the Console
view local toolbar

S8 B0

mo_apps_bub

Open Console

and then select "New Console View"

i &R EFE 2B~
1 C/C++ Build Conscle
By zcvs
3 Mew Console View

# 4 FreeRTOS Task Aware Debugger Conscle
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This will then display a second console view, which can be drag’n’dropped to a new location
within in the Perspective, as shown for the single Console view case described above.

[ bubble.c i3 2 = 0 & Console &2 = 0
253 b . 0 (] |&BEEE B~
;g; E (g_yAngle > ANGLE_UPPER_BOL frdmk@df_demo_apps_bubble Debug [C/C++ (MXP Semiconduc
- = -6y = -38 ~
356 g_yAngle = 1@@; x_ _

357 } x: -35 y : -34

358 '* Update angles to turn off | x: 26y _ -33

359 if (g_xAngle < ANGLE_LOWER_BOL x= -29y= -36

160 W= -38 y = -37

361 whnele = @: W= -28 y = -48

;ez } B NEIE ! i = S35y = -41 Il
] 1 r T T }

|} Install... ] Proper.. B Console &2 |2 Proble.. [] Memory & Instruc... ESWOT... ED Power ... = 0
-'E%;_ E|=‘Evi=<jv

frdmkb4f_demo_apps_bubble Debug messages
crmmep e e P R S T T
Awaiting telnet connection on port 3330 ... ar
GDB nonstop mode enabled

Opening flash driver FTFE_4K.cfx (already resident)

Writing 26688 bytes to address @x@@080888 in Flash

Erased/Wrote page @-6 with 26683 bytes in 324msec

Closing flash driver FTFE_4K.cfx

Flash Write Done

Flash Program Summary: 26683 bytes in @.32 seconds (88.44 KB/sec)

Stopped: Breakpoint #1 -

Having opened a second console view, select which console you want displayed in it, and then
use the “Pin Console” button to ensure that it does not switch to one of the other consoles when
output is displayed.

@8-~

apps
APES Pin Conscle

Using and troubleshooting LPC-Link2

LPC-Link2 hardware

LPC-Link2 is a powerful, low cost debug probe design from NXP Semiconductors based on the
LPC43xx MCU. It has been implemented into a number of different systems, including:

¢ The standalone LPC-Link2 debug probe
e The debug probe built into the range of LPCXpresso V2/V3 boards.

For more details, see http://www.nxp.com/lpcxpresso-boards

Softloaded vs Pre-programmed probe firmware

One thing that most LPC-Link2 implementation offer is the ability to either softload the debug
probe firmware (using USB DFU functionality) or to have the debug probe firmware pre-
programmed into flash.

Programming the firmware into flash has some advantages, including:

¢ Allows the use of the LPC-Link2 with toolchains that, unlike MCUXpresso IDE, do not support
sofloading of the probe firmware.
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« Better supports the use of LPC-Link2 as a small production run programmer

* Allows the LPC-Link2 to be used with SEGGER J-Link firmware as an alternative to the normal
CMSIS-DAP firmware. Note that J-Link firmware does have some restrictions in it use, and is
only currently compatible with LPC MCUs (and not Kinetis MCUs). For more details please
visit http://www.segger.com

¢ Avoids issues that the reenumeration of the LPC-Link2 can sometimes trigger as the firmware
softloads (particularly where virtual machines are in use).

The recommended way to program the firmware into the flash of LPC-Link2 is NXP’s LPCScrypt
flash programming tool. For more details, see http://www.nxp.com/Ipcscrypt

However when used with MCUXpresso IDE, softloading the probe firmware is the recommended
method of using LPC-Link2 in most circumstances.

This ensures that the firmware version matching the MCUXpresso IDE version can automatically
be loaded when the first debug session is started (so normally the latest version). It also allows
different probe firmware variants to be softloaded, depending on current user requirements.

For this to work, you need to make sure that the probe hardware is configured to allow DFU
booting. To do this:

¢ For standalone LPC-Link2: remove the link from header JP1 (nearest USB)
¢ For LPCXpresso V2/V3: add a link to the header "DFU link"

LPC-Link2 firmware variants

As well as providing debug probe functionality, NXP's CMSIS-DAP firmware for LPC-Link2 by
default also includes bridge channels to provide:

¢ Support for SWO Trace capture from the MCUXpresso IDE

¢ Support for Power Measurement from the MCUXpresso IDE (certain LPCXpresso V3 boards
only)

e Support fora UART VCOM port connected to the target processor (LPCXpresso V2/VV3 boards
only)

e Support for a LPCSIO bridge that provides communication to 12C and SPI slave devices
(LPCXpresso V3 boards only)

However two other variants of the CMSIS-DAP firmware are provided that remove some of these
bridge channels.

* “Non Bridged”: This version of firmware provides debug features only — removing the bridged
channels such as trace, power measurement and VCOM. By removing the requirement for
these channels, USB bandwidth is reduced, therefore this firmware may be preferable if
multiple debug probes are to be used concurrently. The non-bridged build will also provide an
increase in download and general debug performance.

¢ “VYCOM Only”: This version of firmware provides only debug and VCOM features. The removal
of the other bridges allows better VCOM performance (though generally the bridged firmware
provides more than good enough VCOM performance).

A particular workspace can be switched to softload a different firmware variant via Preferences
— MCUXpresso IDE — LinkServer Options — LPC-Link2 boot type.
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1) Prefercnces o o/ =l e S|

type filter text LinkServer Options IR
2 3 | -
enere [] Ask to boot LPC-Link 2
w ST+ .
. Help [¥] Boot LPC-Link 2

- Install/Update LPC-Link 2 boot type CIMSIS-DAP (default) -
4 MCUXpresso IDE
Debug Options (Adw

CMSIS-DAP (default)
CMSIS-DAP (Mon-bridged - Debug only
Debug Optiens (Mis Redlink wirespeed in Hz (0 = default)  CMSI5-DAP (VCOM serial bridge only)

Redlink server port (restart required])

Debug Probe Discov
Default Tool setting:
General

J-Link QOptions
LinkServer Options
LPC-Link Qpticns

Block IDE requests to kill redlink server
Shutdown redlink server
Kill redlink server on exit

m

Note: If a mix of bridged and unbridged debug probes is required, then it is recommended that
these probes are pre-programmed with the required debug firmware. This can easily be done
via LPCScrypt.

14.8.4 Manually booting LPC-Link2

The recommended way to use LPC-Link2 with the MCUXpresso IDE is to allow the GUI to boot
and softload a debug firmware image at the start of a debug session.

Normally, LPC-Link2 is booted automatically (when configured to operate in DFU mode),
however under certain circumstances — such as when troubleshooting issues, or using the
LinkServer command line flash utility, you may need to boot it manually.

LPC-Link2 USB Details

The standard utilities to explore USB devices on MCUXpresso IDE supported host platforms are:

¢ Windows — Device Manager
* MCUXpressolDE also provides a listusb utility in:
* {install_dir}\ide\bin\Scripts
¢ Linux — terminal command: Isusb
¢ Mac OS X — terminal command: system_profiler SPUSBDataType

Before boot, LPC-Link2 appears as a USB device with details:

Devi ce Vendor| D/ Product | D: 0x1FC9/ 0x000C (NXP Sem conduct or s)

and will appear in Windows -> Devices and Printers, as below:

LPC

After boot, LPC-Link2 will by default appear as a USB device with detalils:
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Devi ce Vendor| D/ Product | D: 0x1FC9/ 0x0090

and will appear in Windows -> Devices and Printers similar to below:

LPC-LIMNEZ
CMSIS-DAP
V5181

Note: Text details will vary depending on version number and which probe firmware variant is
booted.

Booting from the command line

MCUXpresso IDE provides a boot script for all supported platforms. To make use of this script
first of all connect the LPC-Link2 to your PC then enter the commands into a DOS command
prompt (or equivalent):

cd {install _dir}\ide\bin
boot _I i nk2

This will invoke the dfu-util utility to download the probe firmware into the RAM of the LPC-Link2’'s
LPC43xx MCU and then reenumerate the probe.

Booting from the GUI

It is also possible to manually boot LPC-Link2 from the MCUXpresso IDE GUI, which may be a
more convenient solution than using the command line. To do this, first of all connect the LPC-
Link2 to your PC, then locate the red Boot icon on the Toolbar:

50”5”«‘@'0'%

and then click OK in the dialog displayed :

s Debug probe selection B ®
Select the debug probes to be booted
LinkServer
[ selectal || Deselectan |
(?;' l 0K ] l Cancel ]
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LPC-Link2 windows drivers

The drivers for LPC-Link2 are installed as part of the main MCUXpresso IDE installation process.

* Note:* One thing to be aware of is that the first time you debug using a particular LPC-Link2
on a particular PC, the drivers will need to be loaded. This first time can take a variable period
of time depending upon your PC and operating system version. This may mean that the first
debug attempt fails, as the IDE may time out waiting for the booted LPC-Link2 to appear. In
such as case, a second debug attempt should complete successfully. Otherwise, try booting
the LPC-Link2 manually and checking the drivers load correctly.

If you need to reinstall the drivers, then the installer can be found at:

C\nxp\{install_dir}\Drivers\Ipc_driver_installer.exe

LPC-Link2 failing to enumerate

On some systems, after booting LPC-Link2 with CMSIS-DAP firmware, the booted debug probe
does not enumerate correctly and the MCUXpresso IDE (or other toolchain) is unable to see the
debug probe. This problem is normally caused by on old, obsolete, version of the VCOM driver
being found by Windows instead of the the correct driver. To see if this is the cause of a problem
on your computer, find the version number of the LPC-Link2 VCOM driver. The obsolete driver
version is 1.0.0.0.

To find the version number of the LPC-Link2 VCOM driver

If you are using a soft-booted LPC-Link2 debug probe, start by booting your LPC-Link2, as
described in Manually booting LPC-Link2 [131]. If your LPC-Link2 debug probe is booting from
an image preprogrammed into the flash, you can skip this step.

Once your LPC-Link2 has booted, find the device in Device Manager and look at the driver
version number.

¢ Open the Windows Device Manager

¢ Expand the “Ports (COM and LPT)” section

¢ Right-click on “LPC-Linkll UCom Port”, and select Properties

Click on the Driver tab of the Properties dialog
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M LPC-Linkll UCom Port (COM30) Properties @

File Action View Help

¢ ||| H el & ] 2 % %] | [Gons [ ot Setings] Dver [t

P 3 Batteries LPC-Linkell UCom Port ({COM30)
- 1M Computer 4
Dick drives

{

]:: Display adapters Driver Provider:  NXP
e DVD/CD-ROM drives Driver Date: /2172014
e Floppy disk drives Driver Version:  2.0.0.0
’ ‘,:H Floppy drive cuntmlle-rs Digital Signer: N¥P Semiconductors USA. Inc.
% Human Interface Devices
; IDE ATASATAPI controllers
“j Keybo;b:ds Driver Details To view details about the driver files.
W Mernory devices
§ E! Mice and other pointing devices Update Driver... To update the driver software for this device.
» B Monitors
b -EF Network adapters rio
475 Ports (COM & LPT)
. 7¥ Communications Port (COM1) Disable Disables the selected device.
"? Communications Port (COM2)
Y5 LPC-Linkll UCom Port (COM30)
. LF Printer Port (LPT1)
b D Processors

.I I I
[
[ ]

]
o

]
S
[17]

ff the device fails after updating the driver, roll
back to the previously installed driver.

To uninstall the driver (Advanced).

Uningtall

| 0K || Cancel

Note that this image shows the current correct version of the driver (2.0.0.0).
Removing the obsolete 1.0.0.0 LPC-Linkll UCOM driver

To remove the obsolete driver, perform the following actions:

. In Device Manager, right-click on the LPC-Linkll UCOM device and select Uninstall

. If there is an option to delete the driver software, make sure it is checked, and press OK
. Select the menu item Action->Scan for hardware changes

. In Windows Control Panel, select Add/Remove program or Uninstall a program option

. Find the LPC Driver Installer, right-click on choose Uninstall

. Let the uninstaller complete

. Switch back to the Device Manager and Scan for hardware changes again

. Ifthe LPC-Linkll UCOM driver version is still present, Uninstall it again (steps 1 through 3) and
repeat until the LPC-Linkll UCOM driver no longer appears

9. Now run the Ipc_driver_installer.exe found in the MCUXpresso IDE “Drivers” directory

00 ~NO Ol WOWN -

Note: A reboot is recommended after running the Ipc_driver_installer.exe installer.

Now manually reboot the probe again (if softloading) and check Windows — Devices and
Printers to see if the device now appears correctly as an LPC-Link2 CMSIS-DAP VX.XXX.

If this fails to correct the problem, there is one final thing to try:

¢ Open a Command Prompt as the Administrative user and run the following commands

cd % emp%
pnputil -e >devices. txt
not epad devi ces. t xt

« Search devices.txt for an entry similar to this, and note down the Published name (oemXX.inf)
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Publ i shed nane : oenB8. i nf

Driver package provider : NXP

Cl ass : Ports (COM & LPT)

Driver date and version : 09/ 12/ 2013 1.0.0.0

Si gner nane : NXP Semi conductors USA. Inc.

¢ Using the name notes above, run the following command (replacing XX with the number found
above)

pnputil -f -d oemXX inf

Troubleshooting LPC-Link2

If you have been able to use LPC-Link2 in a debug session but now see issues such as “No
compatible emulator available” or “Priority O connection to this core already taken” when trying
to perform a debug operation ...

¢ Ensure you have shut down any previous debug session
¢ You must close a debug session (press the Red ‘terminate’ button) before starting another
debug session
 ltis possible that the debug driver is still running in the background. Use the task manager or
equivalent to kill any tasks called:
« redlinkserv
e arm-none-eabi_gdb*
e crt_emu_*

If your host has never worked with LPC-Link2, then the following may help to identify the problem:

¢ Try manually booting your LPC-Link2 (as per Manually booting LPC-Link2, and ensure that
the drivers have installed correctly.
e Try a different USB cable!
e Try a different USB port. If your host has USB3 and USB2, then try a USB2 port
 there are know issues with motherboard USB3 firmware, ensure your host is using the
latest driver from the manufacturer. Note, this is not referencing the host OS driver but the
motherboard firmware of the USB port
« If using a USB hub, first try a direct connection to the host computer
« If using a USB hub, try using one with a separate power supply — rather than relying on the
supply over USB from your PC.
¢ Try completely removing and re-installing the host device driver. See also LPC-Link2 fails to
enumerate [133] above.
 If using Windows 8.1 or later, then sometimes the Windows USB power settings can cause
problems. For more details use your favourite search engine to search for “windows 8 usb
power settings” or similar.

Make fails with Virtual Alloc pointer is null error

Very rarely, building a project on Windows may result in an error similar to this:

O [main] us O init_cheap: Virtual Alloc pointer is null, Wn32 error 487
Al |l ocati onBase 0x0, BaseAddress 0x71110000, Regi onSize 0x350000, State 0x10000
\ meys\ bi n\ neke. exe: *** Couldn't reserve space for cygwin's heap, Wn32 error 0

This is a problem that affects a tiny minority of customers, and depends on what other applications
they are running at the same time. This is caused by a feature in the MSYS binaries that we use
to provide the the build environment for the MCUXpresso IDE on Windows.
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If this happens, you can replace the file \ide\msys\bin\msys-1.0.dll within your MCUXpresso
IDE install directory with the msys-1.0-alternate.dll file in the same directory (i.e. do a rename)

Note that this does not fix the problem, rather it moves DLL base address. Unfortunately, it is
possible the error may occur with this replacement DLL too, again depending on what other
applications are running. In which case you will need to revert to the original DLL again.

14.10 Creating bin and hex files
When building a project, the MCUXpresso IDE tools create an ARM executable format (AXF) file
—which is actually standard ELF/DWARF file. This file can be programmed directly down to your
target using the MCUXpresso IDE debug functionality, but it may also be converted into a variety
of formats suitable for use in other external tools.
14.10.1 Simple conversion within the IDE
The simplest way to create a one-off binary or hex file is to open up the Debug (or Release)
folder in Project Explorer right click on the .axf file, and "Binary Utilities->Create binary" (or
Create hex).
[ty Projec... 52 | &, Periph... ifif Regist.. & Symb.. = O [g bubble.c B2 % = 8 [Bc
= - fxos_handle_t fxosHandle = {8}; -
" fxos_data_t sensorData = {@};
= CMSIS i%e mastar config t i2cConfig = {t <Eerm
» (= drivers Mew b iRange = 8; [Mcw
» [ source ale = @;
» [2= startup Open urceClock = @;
» (= utilities Open With L4 [Clo:
- | %5 frdmk64f_demo_apps_bubble.axf - U1t = B
(] frdmkb4f_dema_apps_bubble Deb (=] Copy CrleC | dr size = @;
[Z) frdmke4f_derno_apps_bubble_Debl Paste Ctrl+V ce =_‘False;
[Z) frdmke4f_derno_apps_bubble_Debl 9 Delete Delete
T e e e - P clock, debug consols
. Move... ();
U Quin. BL *
Rename... F2  [KRUN();
aseBus();
. by Impott.. igurePins();
- MCUXpresso IDE (Free Editior gConsole();
IDE ] port...
= CLOCK_GetFreq(ACt
~ Start here Refresh F5  le = BOARD ACCEL I2C
Handle = &g MasterHisz
. Mew project... Run As 4
. e Debug A 3
.ImpcrtSDKexampIEL_]... e .ug = audRate Bps = 10008
® Import project(s) from file system... Profile As ¥ IhablestopHold = fal:
i i litchFilterWidth = ¢
‘5% Build 'frdmbkidf_demo_apps_bubble' [Debu Lewndh SV RpUTE T r n;bie.'-';stzf i true;
g,-‘f Clean 'frdmlbdf_demo_apps_bubble' [Deb| Smart update '
Utilities v lefaultConfig(&i2cCor
g Debug ‘frdmkbdf_demo_apps_bubble' [Deb - _—
Binary Utilities 4 Create hex
Tools 3 Create binary
% Edit frdmk64f_demo_apps_bubble’ project %ﬁ Run C/C++ Code Analysis €  LinkServer GUI Flash programmer
@ Quick Settings» > Team 4 Disassemble
JE Export project(s) to archive (zip) Compare With 3 Size
1 m Replace With 4 Strip debug symbols
[frdmk64f_demo_a..._apps_bubble.axf Properties Er— Process symdefs file
You can also change the options used to create a binary or hex file in this way on the " Windows-
>Preferences->MCUXpresso IDE ->Utilites" preference page.
14.10.2 From the command line

MCUXpresso IDE User Guide -

The above “Binary Utilities” option within the IDE GUI is simply invoking the command line
objcopy tool (arm-none-eabi-objcopy). Objcopy can convert into the following formats:
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14.10.3

14.10.4

¢ srec (Motorola S record format)
e binary

ihex (Intel hex)

o tekhex

For example, to convert example.axf into binary format, use the following command:
arm-none-eabi-objcopy -O binary example.axf example.bin

If you ctrl-click on the project name on the right hand side of the bottom bar of the IDE, this will
launch a command prompt in the project directory with appropriate tool paths set up. You can
also use the Project Explorer right-click “Utilities->Open command prompt here” option to do this.

All you need to do before running the objcopy command is change into the directory of the
required Build configuration.

Automatically converting the file during a build

Objcopy may be used to automatically convert an axf file during a build. To do this, create an
appropriate Post-build step

Binary files and checksums

When creating a binary file for most LPC MCUSs, you also need to ensure that you apply a
checksum to it — so that the LPC bootloader sees the image as being valid. Generally the linker
script will do this if the managed linker script mechanism is used. Otherwise the “checksum” utility
found in the \ide\bin subdirectory of your MCUXpresso IDE installation can be used.

14.11 Post-build (and Pre-build) steps
It is sometimes useful to be able to automatically post-process your linked application, typically
to run one or more of the GNU ‘binutils’ on the generated AXF file.
For example, any application project that you create using the Project wizard will have least one
such “post-build step” - typically to display the size of your application.
800 Post-build steps
Enter one command per line.
After editing, commands are concatenated with a ')’ separator.
A comment character (#) at the start of a line disables that command AND all following cemmands.
arm-none-eabi-size "S{BuildArtifactFileName}"
# arm-none-eabi-objcopy -v -O binary "S{BuildArtifactFileName}" "${BuildArtifactFileBaseNamel.bin"
# checksum -p ${TargetChip} -d "S{BuildArtifactFileBaseNamelbin”
| Cancel | [ OK ]
Note: Additional commands may also be listed (for example to create a binary and to run a
checksum command), but be commented out by use of a # character and hence not executed.
Any commands following a comment #command will be ignored.
Adding addition steps is very simple. In the below example we are going to carry out three post-
link steps:
« displaying the size of the application
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generate an interleaved C / assembler listing
create a hex version of the application image

To do this:

Open the Project properties. There are a number of ways of doing this. For example, make
sure the Project is highlighted in the Project Explorer view then open the menu “Project ->
Properties”.

In the left-hand list of the Properties window, open “C/C++ Build” and select “Settings”.
Select the “Build steps” tab

In the “Post-build steps - Command” field, click 'Edit..."

» Paste in the lines below and click 'OK’

arm none- eabi - si ze ${Bui |l dArtifactFileNane};
ar m none- eabi - obj dunp -S ${Buil dArtifactFileName} > ${Buil dArtifactFileBaseNane}.|ss;
ar m none- eabi - obj copy - O i hex ${Buil dArtifactFil eNane} ${BuildArtifactFi|eBaseNane}. hex;

Click apply
Repeat for your other Build Configurations (Debug/Release)

Next time you do a build, this set of post-build steps will now run, displaying the application size
in the console, creating you an interleaved C/assembler listing file called .Iss and a hex file called
hex.

Note: Pre-build steps can be added to a project in exactly the same way if required.

Temporarily removing post-build steps

If you want to temporarily remove a step from your post-build process, rather than deleting it
completely — move that entry to the end of the line and pre-fix it with a “#” (hash) character. This
acts as a comment, causing the rest of the post-build steps to be ignored.
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